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You have acquired a device (“DEVICE”) that includes software licensed by Tektronix Japan, Ltd. (“TJ”) from Microsoft

Licensing Inc. or its affiliates (“MS”).  Those installed software products of MS origin, as well as associated media, printed

materials, and “online” or electronic documentation (“SOFTWARE”) are protected by international intellectual property

laws and treaties.  The SOFTWARE is licensed, not sold.  All rights reserved.

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT (“EULA”), DO NOT USE THE DEVICE OR

COPY THE SOFTWARE.  INSTEAD, PROMPTLY CONTACT TJ FOR INSTRUCTIONS ON RETURN OF THE

UNUSED DEVICE(S) FOR A REFUND.  ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO

USE ON THE DEVICE, WILL CONSTITUTE YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF

ANY PREVIOUS CONSENT).

GRANT OF SOFTWARE LICENSE.  This EULA grants you the following license:

You may use the SOFTWARE only on the DEVICE.

NOT FAULT TOLERANT.

THE SOFTWARE IS NOT FAULT TOLERANT.  TJ HAS INDEPENDENTLY DETERMINED HOW TO USE THE

SOFTWARE IN THE DEVICE, AND MS HAS RELIED UPON TJ TO CONDUCT SUFFICIENT TESTING TO

DETERMINE THAT THE SOFTWARE IS SUITABLE FOR SUCH USE.

NO WARRANTIES FOR THE SOFTWARE.

THE SOFTWARE IS PROVIDED “AS IS” AND WITH ALL FAULTS.  THE ENTIRE RISK AS TO

SATISFACTORY QUALITY, PERFORMANCE, ACCURACY, AND EFFORT (INCLUDING LACK OF

NEGLIGENCE) IS WITH YOU.  ALSO, THERE IS NO WARRANTY AGAINST INTERFERENCE WITH

YOUR ENJOYMENT OF THE SOFTWARE OR AGAINST INFRINGEMENT.  IF YOU HAVE RECEIVED

ANY WARRANTIES REGARDING THE DEVICE OR THE SOFTWARE, THOSE WARRANTIES DO NOT

ORIGINATE FROM, AND ARE NOT BINDING ON, MS.

NOTE ON JAVA SUPPORT.

The SOFTWARE may contain support for programs written in Java.  Java technology is not fault tolerant and is not

designed, manufactured, or intended for use or resale as online control equipment in hazardous environments

requiring fail–safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication

systems, air traffic control, direct life support machines, or weapons systems, in which the failure of Java technology

could lead directly to death, personal injury, or severe physical or environmental damage.  Sun Microsystems, Inc. has

contractually obligated MS to make this disclaimer.

NO LIABILITY FOR CERTAIN DAMAGES.

EXCEPT AS PROHIBITED BY LAW, MS SHALL HAVE NO LIABILITY FOR ANY INDIRECT, SPECIAL,

CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING FROM OR IN CONNECTION WITH THE

USE OR PERFORMANCE OF THE SOFTWARE.  THIS LIMITATION SHALL APPLY EVEN IF ANY

REMEDY FAILS OF ITS ESSENTIAL PURPOSE.  IN NO EVENT SHALL MS BE LIABLE FOR ANY

AMOUNT IN EXCESS OF U.S. TWO HUNDRED FIFTY DOLLARS (U.S.$250.00).
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LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY.

You may not reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the extent that such

activity is expressly permitted by applicable law notwithstanding this limitation.

SOFTWARE TRANSFER ALLOWED BUT WITH RESTRICTIONS.

You may permanently transfer rights under this EULA only as part of a permanent sale or transfer of the Device, and

only if the recipient agrees to this EULA.  If the SOFTWARE is an upgrade, any transfer must also include all prior

versions of the SOFTWARE.

EXPORT RESTRICTIONS.

You acknowledge that SOFTWARE is of US–origin.  You agree to comply with all applicable international and

national laws that apply to the SOFTWARE, including the U.S. Export Administration Regulations, as well as

end–user, end–use and country destination restrictions issued by U.S. and other governments.  For additional

information on exporting the SOFTWARE, see http://www.microsoft.com/exporting/.

LIMITATION ON SOFTWARE PROGRAMS USED ON THE DEVICE.

The combination of software programs you use on the DEVICE shall address not more than two (2) general office

automation or consumer computing functions.  Such functions include, but are not limited to:  email, word

processing, spreadsheets, database, network browsing, scheduling, and personal finance.

STORAGE/NETWORK USE.

The SOFTWARE may not be installed, accessed, displayed, run, shared or used concurrently on or from different

computers, including a workstation, terminal or other digital electronic device (“Computing System”).

Notwithstanding the foregoing and except as otherwise provided below, any number of Computing Systems, may

access or otherwise utilize the file and print services and internet information services of the SOFTWARE, if

included.

You may use the SOFTWARE on a single DEVICE as interactive workstation software, but not as server software.

However, you may permit a maximum of ten (10) Computing Systems to connect to the DEVICE to access and use

services of the SOFTWARE, such as file and print services and internet information services.  The ten–connection

maximum includes any indirect connections made through other software or hardware which pools or aggregates

connections.
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Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and workmanship

for a period of one (1) year from the date of shipment. If a product proves defective during this warranty period, Tektronix,

at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in

exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the

warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for

packaging and shipping the defective product to the service center designated by Tektronix, with shipping charges prepaid.

Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the

Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any

other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate

maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting

from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair

damage resulting from improper use or connection to incompatible equipment; c) to repair any damage or malfunction

caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with other

products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR

IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO

REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO

THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE

LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE

OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH

DAMAGES.

www.valuetronics.com



www.valuetronics.com



MTX100 MPEG Recorder & Player User Manual �

�	
�
��������
���

Setting Up Windows 2000 Professional ix. . . . . . . . . . . . . . . . . . . . . . . . . 

General Safety Summary  xiii. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Preface xv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Terms xv. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Related Manual xvi. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Contacting Tektronix xvi. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

�
����� ��	��
�

Getting Started 1-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Product Description 1-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Accessories 1-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Options 1-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Initial Product Inspection 1-4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Installation 1-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Repackaging for Shipment 1-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Functional Check Procedure 1-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Windows Operations 1-10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

��
�	���� �	����

Operating Basics 2-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Functional Overview 2-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Optional Interface Cards 2-10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Basic Menu Operation 2-14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

About the Data Output Source 2-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Tutorials 2-19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Required Equipment 2-19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Outputting a Transport Stream 2-20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Recording a Transport Stream 2-22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

�
�
�
��


Reference 3-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Using the Menus 3-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Menus in the Play Screen 3-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Menus in the Record Screen 3-24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Toolbar Buttons 3-32. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Hierarchy Display 3-35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Overview of the Hierarchy Display 3-35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Hierarchy Display Icons 3-36. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Icon Text and Dialog Box 3-43. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Adding Jitter to PCRs 3-49. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Adding Jitter 3-49. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

www.valuetronics.com



Table of Contents

�� MTX100 MPEG Recorder & Player User Manual

Continuous Recording Feature 3-53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Overview 3-53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Basic Action of Continuous Recording 3-54. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Performing Continuous Recording 3-55. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Preset File 3-59. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Contents of the Preset File 3-59. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Saving a Preset File 3-59. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Loading a Preset File 3-60. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Connecting to a Network 3-63. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Connecting the MTX100 to your PC(s) 3-63. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Setting Ethernet Network Parameters 3-64. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Outputting an ISDB-T Transport Stream 3-69. . . . . . . . . . . . . . . . . . . . . . . 

Syntax 3-73. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
SCPI Commands and Queries 3-73. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

IEEE 488.2 Common Commands 3-77. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Remote Commands 3-79. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Common Commands 3-80. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

DISPLAY Commands 3-82. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

MASS MEMORY Commands 3-82. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

PLAY Commands 3-84. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

RECORD Commands 3-94. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SYSTEM Commands 3-98. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Optional Commands 3-101. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Default Settings 3-107. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Error Messages and Codes 3-111. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Command Errors 3-111. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Execution Errors 3-112. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Device Specific Errors 3-114. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Query Errors 3-115. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Network Interface Specifications 3-117. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Checking Remote Command Operation 3-117. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Using the IEEE1394 Interface (Option 05 Only) 3-119. . . . . . . . . . . . . . . . . 
Note for Connections 3-119. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Point-to-Point Connection 3-120. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Data Probing 3-122. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

ASI/IEEE1394 Conversion 3-123. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

About the Partial Transport Stream 3-126. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

����������

Appendix A: Specifications A-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Performance Conditions A-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Functional Specifications A-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Electrical Specifications A-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Mechanical (Physical) Characteristics A-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Environment Characteristics A-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Certifications and Compliances A-14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

www.valuetronics.com



Table of Contents

MTX100 MPEG Recorder & Player User Manual ���

Appendix B: Using the ReMux Application B-1. . . . . . . . . . . . . . . . . . . . . 
Starting and Exiting ReMux B-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Elements of the ReMux Window B-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Using the ReMux Menus B-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

ReMux Tutorials B-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Appendix C: Using the Scheduler Application (Option SC Only) C-1. . . 
Attaching the Software Protection Key C-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Starting and Exiting Scheduler C-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Elements of the Scheduler Application Window C-3. . . . . . . . . . . . . . . . . . . . . . . . . 

Using the Scheduler Menus C-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Status/Control Panel C-16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Scheduler Tutorials C-19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Installing Scheduler on a PC C-24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Starting and Exiting Scheduler on Your PC C-26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Appendix D: Control Signals for Option 02 D-1. . . . . . . . . . . . . . . . . . . . . 

Appendix E: Connecting SCSI Hard Disk(s) E-1. . . . . . . . . . . . . . . . . . . . 
Connecting Procedure E-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Setting Procedure E-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Appendix F: Defragment the Hard Disk Drive F-1. . . . . . . . . . . . . . . . . . 
Procedure F-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Appendix G: Using the Recovery Discs G-1. . . . . . . . . . . . . . . . . . . . . . . . . 
Reinstalling Windows 2000 G-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Reinstalling the MTX100 Application G-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Appendix H: Inspection and Cleaning H-1. . . . . . . . . . . . . . . . . . . . . . . . . 
Exterior Inspection H-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Exterior Cleaning H-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

��	���



�����

www.valuetronics.com



Table of Contents

�� MTX100 MPEG Recorder & Player User Manual

��	

��
������	

Figure 1-1: Rear-panel power connector 1-7. . . . . . . . . . . . . . . . . . . . . . . . 

Figure 1-2: Front-panel ON/STBY switch 1-7. . . . . . . . . . . . . . . . . . . . . . 

Figure 1-3: Select File dialog box 1-9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 1-4: Equipment connection for the functional check 1-10. . . . . . . . 

Figure 2-1: MTX100 front panel 2-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-2: MTX100 rear panel 2-4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-3: Elements of the Play screen 2-6. . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-4: Play status indicator 2-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-5: Status bar 2-9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-6: ASI interface 2-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-7: Universal parallel/serial interface 2-11. . . . . . . . . . . . . . . . . . . 

Figure 2-8: IEEE1394/ASI interface 2-12. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-9: SMPTE310M/ASI interface 2-13. . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-10: Front panel showing the menu controls 2-14. . . . . . . . . . . . . 

Figure 2-11: Display states of the menu commands 2-15. . . . . . . . . . . . . . . 

Figure 2-12: 10 key Pad 2-16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-15: Select File dialog box 2-20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-16: Hierarchy view of the transport stream file 2-21. . . . . . . . . . 

Figure 2-17: Play Status indicator 2-21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-18: Transport stream display from a Tektronix MTS300 

Series Real-Time Analyzer 2-22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-19: No Signal message 2-22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 2-20: Record Status indicator 2-23. . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-1: Select File dialog box 3-4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-2: Clock dialog box 3-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-3: Set Non-TS Sync dialog box 3-9. . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-4: PCR Initial Value dialog box 3-10. . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-5: Timer Play/Record dialog box 3-11. . . . . . . . . . . . . . . . . . . . . . 

Figure 3-6: Start/Stop Position dialog box 3-12. . . . . . . . . . . . . . . . . . . . . . 

Figure 3-7: Others dialog box 3-14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-8: IEEE1394 dialog box (Play screen) 3-20. . . . . . . . . . . . . . . . . . 

Figure 3-9: Communication dialog box 3-22. . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-10: Status dialog box 3-23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-11: Target dialog box 3-25. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

www.valuetronics.com



Table of Contents

MTX100 MPEG Recorder & Player User Manual �

Figure 3-12: Others dialog box 3-27. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-13: IEEE1394 dialog box (Record screen) 3-30. . . . . . . . . . . . . . . 

Figure 3-14: Toolbar and toolbar buttons 3-32. . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-15: Example of the hierarchy display 3-35. . . . . . . . . . . . . . . . . . 

Figure 3-16: PCR Inaccuracy dialog box 3-45. . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-17: PCR Inaccuracy dialog box 3-49. . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-18: Jitter function with a sine jitter pattern applied 3-51. . . . . . 

Figure 3-19: Continuous Recording check box 3-56. . . . . . . . . . . . . . . . . . 

Figure 3-20: File counter 3-56. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-21: Save As dialog box 3-60. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-22: Open dialog box 3-61. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-21: Pin connections for a crossover Ethernet cable 3-63. . . . . . . 

Figure 3-22: Network and Dial-up Connections window 3-64. . . . . . . . . . 

Figure 3-23: Local Area Connection Status dialog box 3-65. . . . . . . . . . . . 

Figure 3-24: Local Area Connection Properties dialog box 3-65. . . . . . . . 

Figure 3-25: Internet Protocol (TCP/IP) Properties dialog box 3-66. . . . . 

Figure 3-28: Hierarchy view of the ISDB-T transport stream file 3-70. . . 

Figure 3-29: ISDB-T Information dialog box 3-71. . . . . . . . . . . . . . . . . . . . 

Figure 3-28: Example of SCPI subsystem hierarchy tree 3-73. . . . . . . . . . 

Figure 3-29: Example of abbreviating a command 3-75. . . . . . . . . . . . . . . 

Figure 3-30: Example of chaining commands and queries 3-75. . . . . . . . . 

Figure 3-31: Example of omitting root and lower-level nodes 

in a chained message 3-76. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure 3-32: Connection example for point-to-point connection 3-120. . . . 

Figure 3-33: Connection example for data probing 3-122. . . . . . . . . . . . . . . 

Figure 3-34: Connection example for ASI IEEE1394 conversion 3-124. . . 

Figure 3-35: Connection example for IEEE1394 ASI conversion 3-125. . . 

Figure 3-36: Partial transport stream 3-126. . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure A-1: Timing diagram of the DVB-SPI and universal 

parallel/serial interfaces A-12. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure B-1: ReMux application window B-2. . . . . . . . . . . . . . . . . . . . . . . . 

Figure B-2: Select Remux Mode dialog box B-5. . . . . . . . . . . . . . . . . . . . . 

Figure B-3: OPTION dialog box B-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure B-4: Editing window for the Make S-TMCC TS mode B-9. . . . . . 

Figure B-5: Edit TS Information dialog box B-10. . . . . . . . . . . . . . . . . . . . . 

Figure B-6: Window displaying a transport stream icon B-11. . . . . . . . . . 

Figure B-7: Edit TMCC Information dialog box (S-TMCC) B-12. . . . . . . 

www.valuetronics.com



Table of Contents

�� MTX100 MPEG Recorder & Player User Manual

Figure B-8: Editing window for the ReMux to M-TMCC TS from 

S-TMCC TS mode B-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure B-9: Transport stream is multiplexed B-14. . . . . . . . . . . . . . . . . . . . 

Figure B-10: Edit TMCC Information dialog box (M-TMCC) B-15. . . . . 

Figure B-11: Add TMCC dialog box B-16. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure B-12: Editing window for the ReMux to M-TMCC TS mode B-18

Figure B-13: Editing window for the DeMux M-TMCC TS mode B-20. . . 

Figure B-14: DEMUX dialog box B-21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure C-1: Software protection key C-1. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure C-2: Scheduler application window (schedule play mode) C-3. . . 

Figure C-3: MTX/RTX Host Name dialog box C-7. . . . . . . . . . . . . . . . . . . 

Figure C-4: Scheduler Settings dialog box C-8. . . . . . . . . . . . . . . . . . . . . . 

Figure C-5: Play Properties dialog box C-11. . . . . . . . . . . . . . . . . . . . . . . . . 

Figure C-6: Save as dialog box C-14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure C-7: Record Properties dialog box C-15. . . . . . . . . . . . . . . . . . . . . . 

Figure C-8: Status/control panel (schedule play mode) C-16. . . . . . . . . . . . 

Figure C-9: Schedule Property dialog box C-17. . . . . . . . . . . . . . . . . . . . . . 

Figure D-1: Timing relationship of the signals on the UNIVERSAL 

IN/OUT connector D-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-1: Computer Management window E-2. . . . . . . . . . . . . . . . . . . . 

Figure E-2: Computer Management window after selecting Disk 

Management E-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-3: Create Partition Wizard dialog box E-4. . . . . . . . . . . . . . . . . 

Figure E-4: Dialog box showing completion of Create Partition 

Wizard E-4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-5: Computer Management window after the format 

is complete E-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-6: Computer Management window after selecting Disk 

Management E-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-7: Upgrade to Dynamic Disk dialog box E-7. . . . . . . . . . . . . . . . 

Figure E-8: Create Volume Wizard dialog box E-7. . . . . . . . . . . . . . . . . . 

Figure E-9: Select Volume Type dialog box E-8. . . . . . . . . . . . . . . . . . . . . 

Figure E-10: Select Disks dialog box E-8. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-11: Assign Drive Letter or Path dialog box. E-9. . . . . . . . . . . . . 

Figure E-12: Format Volume dialog box E-9. . . . . . . . . . . . . . . . . . . . . . . . 

Figure E-13: Dialog box showing completion of the Create Volume 

Wizard E-10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

www.valuetronics.com



Table of Contents

MTX100 MPEG Recorder & Player User Manual ���

Figure E-14: Computer Management window after the format 

is complete E-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Figure F-1: Disk Defragmenter window F-2. . . . . . . . . . . . . . . . . . . . . . . . 

Figure F-2: Defragmentation Complete dialog box F-2. . . . . . . . . . . . . . . 

��
�
	�
�����


Table 1-1: Standard and optional accessories 1-2. . . . . . . . . . . . . . . . . . . 

Table 1-2: Instrument options 1-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 1-3: Power cord options 1-3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 1-4: Environmental Operating Requirements 1-5. . . . . . . . . . . . . . 

Table 1-5: AC line power requirements 1-5. . . . . . . . . . . . . . . . . . . . . . . . 

Table 2-1: Tutorial recommended test equipment and accessories 2-19. . 

Table 3-1: File menu commands (Play screen) 3-3. . . . . . . . . . . . . . . . . . 

Table 3-2: View menu commands 3-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-3: Play menu commands 3-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-4: ASI I/F menu commands (Play screen)  3-18. . . . . . . . . . . . . . . 

Table 3-5: Univ I/F menu commands (Play screen)  3-19. . . . . . . . . . . . . . 

Table 3-6: ASI/1394 menu commands (Play screen)  3-19. . . . . . . . . . . . . 

Table 3-7: ASI/310M menu commands (Play screen)  3-21. . . . . . . . . . . . 

Table 3-8: Utility menu commands 3-21. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-9: File menu commands (Record screen) 3-24. . . . . . . . . . . . . . . . 

Table 3-10: Record menu commands 3-25. . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-11: ASI I/F menu command (Record screen)  3-28. . . . . . . . . . . . 

Table 3-12: Univ I/F menu commands (Record screen)  3-29. . . . . . . . . . . 

Table 3-13: ASI/1394 menu command (Record screen)  3-29. . . . . . . . . . . 

Table 3-14: ASI/310M menu command (Record screen)  3-32. . . . . . . . . . 

Table 3-15: Toolbar button descriptions 3-33. . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-20: Icons used for MPEG-2, ARIB, DVB, and ATSC 

formats 3-36. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-21: Icons specific to DVB format 3-39. . . . . . . . . . . . . . . . . . . . . . . 

Table 3-22: Icons specific to ARIB format 3-40. . . . . . . . . . . . . . . . . . . . . . 

Table 3-23: Icons specific to ATSC format 3-42. . . . . . . . . . . . . . . . . . . . . . 

Table 3-24: PCR Inaccuracy dialog box parameters 3-45. . . . . . . . . . . . . 

Table 3-25: Parameter types used in syntax descriptions 3-74. . . . . . . . . . 

www.valuetronics.com



Table of Contents

���� MTX100 MPEG Recorder & Player User Manual

Table 3-26: BNF symbols and meanings 3-77. . . . . . . . . . . . . . . . . . . . . . . 

Table 3-23: Default settings 3-107. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-28: Command errors 3-111. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-29: Execution errors 3-112. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-30: Device specific errors 3-114. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table 3-31: Query errors 3-115. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table A-1: Functional specifications A-1. . . . . . . . . . . . . . . . . . . . . . . . . . 

Table A-2: Mainframe A-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table A-3: ASI interface (Option 01) A-7. . . . . . . . . . . . . . . . . . . . . . . . . . 

Table A-4: Universal parallel/serial interface (Option 02) A-7. . . . . . . . 

Table A-5: IEEE1394/ASI interface (Option 05) A-10. . . . . . . . . . . . . . . . . 

Table A-6: SMPTE310M/ASI interface (Option 06) A-10. . . . . . . . . . . . . . 

Table A-7: Mechanical characteristics A-13. . . . . . . . . . . . . . . . . . . . . . . . . 

Table A-8: Environmental characteristics A-13. . . . . . . . . . . . . . . . . . . . . . 

Table A-9: Certifications and compliances A-14. . . . . . . . . . . . . . . . . . . . . 

Table B-1: Elements of the ReMux window B-3. . . . . . . . . . . . . . . . . . . . . 

Table B-2: Toolbar button descriptions B-4. . . . . . . . . . . . . . . . . . . . . . . . 

Table B-3: ReMux File menu commands B-5. . . . . . . . . . . . . . . . . . . . . . . 

Table B-4: Select Remux Mode dialog box parameters B-6. . . . . . . . . . . 

Table B-5: ReMux File menu commands B-6. . . . . . . . . . . . . . . . . . . . . . . 

Table B-6: ReMux menu commands B-6. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table B-7: OPTION dialog box parameters B-7. . . . . . . . . . . . . . . . . . . . 

Table B-8: ReMux Window menu commands B-7. . . . . . . . . . . . . . . . . . . 

Table B-9: ReMux View menu commands B-8. . . . . . . . . . . . . . . . . . . . . . 

Table C-1: Toolbar button descriptions C-4. . . . . . . . . . . . . . . . . . . . . . . . 

Table C-2: File menu commands C-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table C-3: View menu commands C-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table C-4: Schedule menu commands C-7. . . . . . . . . . . . . . . . . . . . . . . . . 

Table C-5: Stream menu commands C-10. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table D-1: Pin assignments of the UNIVERSAL IN/OUT connector D-1

www.valuetronics.com



MTX100 MPEG Recorder & Player User Manual ��

Before powering on the instrument, be sure to read the following instructions.

������
 �� ���
��� ���� ������������

Use the following procedure to set up the Windows 2000 Professional operating

system for the first time. After you power on the instrument and the setup wizard

is displayed, follow this procedure to setup the instrument.

This procedure is also used when you reboot the instrument by using Windows

2000 Professional Operating System Recovery Disc provided with the

instrument. Refer to Appendix G: Using the Recovery Discs for more information

on how to reinstall the Windows 2000 operating system.

����� ���	�
���

����. Before beginning this procedure, connect the keyboard and mouse

provided with the instrument to the front-panel USB connectors.

1. Press the ON/STBY switch on the front panel to power on the instrument.

The Windows 2000 Professional Setup dialog box appears.

2. Click Next.

The Licence Agreement dialog box appears.

3. Read the agreement. When you agree with the content, select I accept this

agreement, and then click Next.

The Regional Settings dialog box appears.

4. Check that the settings are correct for your locale. If necessary, click the first

Customize button to change the system or user locale settings, and click the

second Customize button to change the keyboard layout.
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5. Click Next.

The Personalize Your Software dialog box appears.

6. Type your name and organization. You must type in a name, but the

organization text box is optional.

7. Click Next.

The Your Product Key dialog box appears.

The Product Key, or Product ID number, is the bar code number on the

sticker that is located on the side of the instrument cabinet.

8. Type your Product Key, and then click Next.

The Computer Name and Administrator Password dialog box appears.

A suggested name for the instrument appears in the Computer name text

box that you can change or accept. The computer name is used to identify

the instrument on a network, and it must be unique to the network. It can be

up to 15 characters in length.

The Administrator password text box is used to enter the administrator

password. This password is pre-defined as MTX100 at the factory. There-

fore, you do not need to enter the password. Even if you enter the password

other than MTX100, it is disabled.

9. Click Next.

The Date and Time Settings dialog box appears.

10. Check that the settings are correct for your date, time, and time zone, and

then click Next.

The Network Settings dialog box appears. You may choose whether to use

typical or custom settings. Consult your network administrator if you need to

add custom settings at this point.

11. Click Next to accept the default typical settings.

The Workgroup or Computer Domain dialog box appears. You may add a

workgroup name, but it is not required. Consult your network administrator

if you need to add a computer domain.

12. Click Next.

The Completing the Windows 2000 Setup Wizard dialog box appears.
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13. Click Finish.

When you click Finish, the instrument restarts automatically. The Welcome

to the Network Identification Wizard dialog box appears.

14. Click Next.

The Users of This Computer dialog box appears.

You can change settings as indicated on the screen or enter a user password

for the name entered earlier in the setup. If you click the second option

button, you do not need to enter a password when you logon to the instru-

ment.

15. Click Next.

The Completing the Network Identification Wizard dialog box appears.

16. Click Finish.

When you click Finish, the application for operating the instrument starts

automatically.

In addition, the Getting Started with Windows 2000 dialog box appears on

the screen. You can click any of the items, or you can exit from this dialog

box. If you do not want to display this dialog box again, click the option

button to deselect the option.
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	�!�$�� ����&+ �'  �$+

Review the following safety precautions to avoid injury and prevent damage to

this product or any products connected to it. To avoid potential hazards, use this

product only as specified.

Only qualified personnel should perform service procedures.

�%� �$"#�$ �")�$ �"$�� Use only the power cord specified for this product and

certified for the country of use.

	$"'!� &�� �$"�'�&� This product is grounded through the grounding conductor

of the power cord. To avoid electric shock, the grounding conductor must be

connected to earth ground. Before making connections to the input or output

terminals of the product, ensure that the product is properly grounded.


�%�$(� ��� ��$ �!�� ��&�!�%� To avoid fire or shock hazard, observe all ratings

and markings on the product. Consult the product manual for further ratings

information before making connections to the product.

�" �"& 
#�$�&� ��&�"'& �"(�$%� Do not operate this product with covers or panels

removed.

�("�� �*#"%�� ��$�'�&$+� Do not touch exposed connections and components

when power is present.

�" �"& 
#�$�&� ��&� �'%#��&�� ����'$�%� If you suspect there is damage to this

product, have it inspected by qualified service personnel.

�" �"& 
#�$�&� �! ��&��� # �"!��&�"!%�

�" �"& 
#�$�&� �! �! �*#�"%�(� �& "%#��$��

���# �$"�'�& �'$����% ����! �!� �$+�

�$"(��� �$"#�$ ��!&���&�"!� Refer to the manual’s installation instructions for

details on installing the product so it has proper ventilation.

�" �")�$ �)�&��� The power supply cord is considered the disconnecting device;

disconect the main power by means of the power cord.

�" �("�� ��$� "$
��$%"!�� 
!�'$+
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����� 
� ��
� ������� These terms may appear in this manual:

�������� Warning statements identify conditions or practices that could result

in injury or loss of life.

��
	���� Caution statements identify conditions or practices that could result in

damage to this product or other property.

����� �� ��� ���
�	�� These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the

marking.

WARNING indicates an injury hazard not immediately accessible as you read the

marking.

CAUTION indicates a hazard to property including the product.

������� �� ��� ���
�	�� The following symbols may appear on the product:

������


���� �� 	�����

���������� ������
������� ��������

������� ��
 �����
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The user manual for the MTX100 MPEG Recorder & Player contains the

following sections:

Getting Started briefly describes the MTX100 MPEG Recorder & Player and

provides installation instructions, options listing, accessories listing, repacking

instructions, and power on and off instructions.

Operating Basics provides an overview of the front panel controls and rear panel

connections, operating principles, basic operating procedures, and numeric input

methods. This section also provides examples of basic data outputting and

recording.

Reference provides detailed information about the functions and use of the

MTX100 MPEG Recorder & Player’s main menus, and presents descriptions of

all programming commands and the syntax used in command descriptions. This

section also provides instructions for setting the network parameters for the

Ethernet port.

Appendices provides product specifications, instructions for operating the

ReMux and Scheduler applications, how to defrag the hard disk, instructions for

connecting SCSI hard disk(s), how to recovery the system, and instructions for

inspecting and cleaning the MTX100 MPEG Recorder & Player.

����	

This manual uses the following terms:

� Stream: Generic term for transport streams and data streams of Non TS

format (i.e.,data format other than transport stream format).

� S-TMCC (Single TMCC): Transport stream to which TMCC (Transmission

and Multiplexing Configuration Control) information is inserted into the 8

bytes in its Reed-Solomon code area (16 bytes). It is defined in the ISDB-S

(Integrated Services Digital Broadcasting-Satellite) system.

� M-TMCC (Multi TMCC): Transport stream to which TMCC information is

inserted into the sync byte area, and having super frame structure. It is

defined in the ISDB-S system.
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The following related documentation for the instrument is available:

� The MTX100 MPEG Recorder & Player Service Manual (Tektronix part

number 070-A835-XX) describes how to maintain and service the MTX100

and provides a complete module-level description of the operation of the

instrument. This manual is an optional accessory.
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This section provides the following information:

� Product description

� List of standard and optional accessories

� List of instrument options

� Initial product inspection procedure

� Installation instructions

� Instructions for repackaging the instrument for shipment

� Functional check procedure

� Windows operations

���	��� �
��������


The MTX100 MPEG Recorder & Player generates and captures MPEG-2

transport streams that are compliant with ATSC, DVB, and ARIB standards.

The MTX100 provides the following features:

� Data rate: 200 Mbps maximum; 1 Kbps minimum

� Hierarchy display of the stored or captured transport stream

� 188, 204, 208 bytes packet size, S-TMCC, M-TMCC, non transport stream,

and partial transport stream output formats

� Real-time updating of stream parameters; continuity_counter, PCR/PTS/

DTS, TOT/TDT/STT, NPT, and Reed Solomon (ISDB-T only)

� Continuous recording of captured streams

� PCR jitter insertion

� Triggered stream capture

� Full remote control using Ethernet interface

� Scheduler application for automated stream playout and record (Option SC

only)

� Optional ASI, universal parallel/serial, IEEE1394/ASI, and SMPTE310M/

ASI interfaces available
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The MTX100 includes the ReMux application software that provides the

capability to create a transport stream of super frame structure defined in the

ISDB-S systems from an MPEG2 transport stream. Refer to Appendix B: Using

ReMux Application for detailed information about the ReMux application.

����. When inputting/outputting a stream for a long time, the stream may be

intermitted because of a processing condition of the hard disk or the system

process of Windows 2000.

�����������

Table 1-1 lists the standard and optional accessories provided with the MTX100.
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Table 1-2 lists the instrument options that can be ordered with the MTX100.

Table 1-3 lists the available power cord options.
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Perform the following product inspection procedure when you receive your

instrument:

17. Inspect the MTX100 shipping carton for external damage, which indicates

possible damage to the instrument.

18. Remove the MTX100 from the shipping carton, and then check that the

instrument has not been damaged in transit. Prior to shipment, the instrument

is thoroughly inspected for mechanical defects. The exterior should not have

any scratches or impact marks.

����. Save the shipping carton and packaging materials for instrument

repackaging in case shipment becomes necessary.

19. Verify that the shipping carton contains the basic instrument, the standard

accessories listed in Table 1-1, and any optional accessories that you ordered.

Contact your local Tektronix Field Office or representative if there is a problem

with your instrument or if your shipment is incomplete.
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Before you install the instrument, refer to the General Safety Summary at the

front of this manual for power source, grounding, and other safety information.

Verify that the location of your installation has the proper operating environment.

See Table 1-4 for clearance requirements. For complete operating environment

information, refer to Appendix A: Specifications.

��
	���� Damage to the instrument can occur if this instrument is powered on

at temperatures outside the specified temperature range.

����� �&���	�$� �����"�� ��� �"��� ���#� ����"!�

��� ��"� �!"��! ���������"���!
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�!��'�#�� $# ' ��) ( �� ��� �" �
 #�

�!��'�#��  # '��' ��� �" �
 #�

��	�. If you are installing the instrument in a dedicated rack, refer to the

instruction sheet that comes with the rackmounting kit for proper installation

procedures.

When the MTX100 is mounted in a 19-inch rack, verify that there is at least one

unit of clearance above the MTX100.

Check that your location provides the proper electrical power requirements as

listed in Table 1-5.

����� �&����� ���� ��%�  ��#� ����"!�
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��
	���� The instrument does not have a power switch, but does have an

on/standby switch. When you connect the power cable to the AC line connector,

power is applied to the power supply standby circuit of the instrument. Read all

instructions before plugging the power cable into a power source.

Refer to Table 1-3 on page 1-3 to verify that you are using the proper power

cord for your location. Connect the power cord from the rear-panel power

connector to the power system.

��
	���� The instrument is shipped with a power cord appropriate for use with

your power systems (normal 115 V power system or 230 V power system). If the

instrument is to be used with a power system other than what the order specified,

the power cord must be replaced with one appropriate for the power source

used. Refer to Table 1-3 for a listing of available power cords.

After you have verified the operating environment, AC line, and power cord

requirements, plug the power cord into the power connector on the rear panel

(see Figure 1-1), and then plug the power cord into the local power source.

	���� ���  Press the ON/STBY switch (see Figure 1-2) to power on the

instrument. After you power on the instrument, verify that the fan on the rear

panel is operating. To verify that the fan is operating, place your hand behind the

right side of the instrument. The fan’s air flow should be felt.

��
	���� Do not operate the instrument if the cooling fan does not operate

when you turn the instrument on. Serious damage to your instrument can occur

from overheating if the cooling fan is not operating.

��	�. Allow the instrument to warm up for 20 minutes prior to calibrating the

clock. The instrument must be completely warmed up to operate at its optimum

precision.

	���� ���� 
�����������

�������
 	���� �� ���
����������
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When you ship this instrument, use the original packaging material if possible.

If the original packaging is unfit for use or is not available, repackage the

instrument using the following procedure:

1. Obtain a corrugated cardboard shipping carton having inside dimensions at

least six inches greater than the instrument dimensions and having a carton

test strength of at least 125 kg (275 pounds).

2. If the instrument is being shipped to a Tektronix Service Center for repair or

calibration, attach a tag to the instrument showing the following information:

� The owner of the instrument (with address).

� The name of a person at your firm who may be contacted if additional

information is needed.

� The complete instrument type and serial number.

� A description of the service required.

3. Wrap the instrument with polyethylene sheeting or equivalent to protect the

outside finish and prevent entry of packing materials into the instrument.

4. Cushion the instrument on all sides by tightly packing dunnage or urethane

foam between the carton and the instrument, allowing for three inches

(7.62 cm) of padding on each side (including top and bottom).

5. Seal the carton with shipping tape or with an industrial stapler.

6. Mark the address of the Tektronix Service Center and your return address on

the carton in one or more prominent locations.

���
����	� ���
� ���
�����

Perform the following procedure if you are operating the instrument for the first

time (to verify that the instrument shipped without damage) or you suspect that

the instrument is not working properly:

����. Before you perform this procedure, install the MTX100 using the

instructions listed in Installation starting on page 1-5 and read the instructions

for Setting Up Windows 2000 Professional.

1. Connect the MTX100 to a power source, and then turn the instrument on

using the ON/STBY switch.

2. Press the front-panel MENU button to display the File menu command list.
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3. Press the up (�) or down (�) arrow button to select Open from the list, and

then press the ENTER button to open the dialog box shown in Figure 1-3.

��
��� ���������
� ���� �����
 	��

4. Press the up (�) or down (�) arrow button to select the test64.TRP file, and

then press the ENTER button. The hierarchy view of the transport stream

file will be displayed on the screen.

����. You can select the test40.TRP file in step 4 of this procedure if you need to

decrease the bit rate of the transport stream due to performance restrictions in

your decoder.

5. Connect the interface cable provided with the instrument between the SPI

IN/OUT connector on the MTX100 rear panel to the SPI IN connector on

an MPEG decoder. See Figure 1-4.

6. Connect the decoder to a picture monitor.

7. Press the MTX100 PLAY button to start the transport stream output. When

transport stream output is started, the Play Status indicator appears on the

screen.

8. Check that the picture from the transport stream is displayed correctly on the

picture monitor.
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All of the functions of the MTX100 is performed as an application (MTX100

application) on Windows 2000 operating system. Therefore, if you connect the

keyboard and mouse provided with the instrument to the front-panel USB

connectors, you can operate the MTX100 system with the same environment as a

Windows PC.

When you have connected a keyboard and mouse to the instrument, you can use

them to make menu selections and parameter settings in the Play/Record screen.

These operations have the same manner as the other Windows applications.

To display Windows screen (Desktop), select Minimize or Exit from the File

menu in the Play screen or Record screen. For Minimize, the MTX100 applica-

tion window minimizes and Windows 2000 desktop appears. For Exit, the

MTX100 application exits and Windows 2000 desktop appears.

��� �"��� �� "��

��%����� � �� ���

	�!���%��� "�� �����$!
�� ��� �	�!�"���
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There are no menu commands managing file operations in the MTX100

application. Perform the file operations such as copy, delete, or upload/download

on Windows. Refer to Windows 2000 Online Help or other documentation about

file operations.

The MTX100 application is placed in the C:\Program Files\Tektronix\MpegPlay-

er folder. The sample transport stream files (test64.TRP and test40.TRP) are

placed on E: drive (Volume E).

This manual describes only the settings for connecting to an Ethernet network

and connecting a SCSI hard disk(s). Refer to Windows 2000 Online Help or

other documentation about other system settings.

�	
� ������	
�

������ ����	���
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This section explains the basics of operating the MTX100. The information is

divided into the following subsections:

� Functional Overview contains descriptions of the front-panel controls, the

rear-panel connectors, and elements of the display.

� Optional Interface Cards describes the connectors and its function of each of

the optional interface cards.

� Basic Menu Operation provides the basic concepts of how to operate the

MTX100 using the menus and front-panel buttons, and how to enter numeric

input into dialog boxes.

� Tutorials contains procedures that show you how to output and record a

transport stream.

	��������� ������� 

This subsection contains descriptions of the front-panel controls, LCD display,

and the rear-panel connectors.

Figure 2-1 shows the locations of the front panel controls. Descriptions of the

front-panel controls appear on the following pages.


�� ������!�  The LCD display uses its 640 x 480 pixel resolution to display

transport stream components and the menu. Refer to Display Elements on

page 2-5 for more information about the display.

��"�"���� 
� �� � �����  Use the ON/STBY power switch to power on or off the

instrument.

�������� If you power off the instrument using the ON/STBY power switch, the

current instrument settings are not saved (this operation corresponds to an

emergency shutdown in Windows 2000). To prevent data loss, use the Shutdown

command from the File menu  to power off the instrument.

	���� 
���� ��������
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��� 	 ����$ "#�  Use these connectors to connect the keyboard and mouse

provided with the instrument for Windows operations. You can also connect

other USB devices.

	
'��� 
"�&��  Use the CD-ROM drive to read data from a CD-ROM. You can

download the sample stream data or user stream data from a CD-ROM without

using a PC.

��%��
 ���"�

��	��� �!  ��

����# �!  ������ ������ ��� ��� ������
������ ��

���
 �!  �� ��� �!  �� 
	�� �!  �� 
��� �!  ��

�������������
�!  ���	�� ������$

�������
��#�� �#� ��

���%"� �'��������� �" �$ !����

���� �%$$ ��  Use this button to toggle the display of the menu command list on

or off.

�
�� �%$$ ��  Press this button to start stream output. When the Record screen is

displayed, use this button to switch to the Play screen. When this button is

pressed during stream output, the stream output pauses. Press the button again to

start the stream output.
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When an M-TMCC transport stream is selected, the MTX100 outputs the stream

from the start packet in the super frame to the maximum number of packets that

can be looped as an integral multiple of the number of super frames. When an

ISDB-T transport stream is selected, the MTX100 outputs the stream from the

start packet in the OFDM (Orthogonal Frequency Division Multiplexing) frame

to the maximum number of packets that can be looped as 2�N of the number of

OFDM frames. If any transport streams within the ISDB-T transport stream have

different modulation parameters, select Non TS from the Packet Size command

in the Play menu (refer to page 3-5).

The status indicator at the left side of the button lights when stream data is being

output. The indicator blinks when the stream output pauses.

�	� �������  Press this button to record the stream data being applied. When the

Play screen is displayed, use this button to switch to the Record screen.

The status indicator at the left side of the button blinks when a sync word is

being detected, or pretrigger portion of the stream data has been recorded.

���
 �������  This button performs the following functions:

� When this button is pressed while a stream data is being output, the data

output stops.

� When this button is pressed, two of the following things can happen. The

pretrigger portion is filled and the instrument waits to trigger. The posttrig-

ger portion is being recorded, the stream data waits until the button is

pressed and is stored in a file.

	�������	��	� ��������  These buttons perform the following functions:

� The ESC button is used to cancel the selected operation. When any menu

command list is displayed, it closes the command list temporarily.

� The TAB button is used to move through a dialog box.

� The ENTER button is used to execute the selected menu command or enable

all setting changes in a dialog box.

�	
	�� �������  Use the SELECT button to enable or disable any setting

changes in a dialog box. It is also used to open the 10 Key Pad where you can

enter numeric values for a text box.

When an ISDB-T file is selected in the Play screen or an ISDB-T signal is

captured in the Record screen, pressing this button causes the ISDB-T Informa-

tion dialog box to appear.
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����# 	"!!�� �  Use the arrow buttons to maneuver on the LCD display. For

example, you can use these buttons to move the Icon cursor or to move among

the menu selections.


�� ����  ������!���  This indicator lights when the hard disk drive or the

CD-ROM drive is in operation.

Figure 2-2 shows the locations of the MTX100 rear-panel connectors.

������ ���	&�

��� ������

��� � �������

��$�! ���� �� �����	� ��
��	
 ��	% ��"��� ��!� "��#

���"�� �$��������� ���� �����

��#���  Use this power connector to apply power to the instrument using the

supplied power cord.


�� ��  This 9-pin D-sub connector provides a serial interface for instrument

control. This connector can be configured to support the following interface by

selecting the internal jumper: RS-232C, RS-422, or RS-485. Refer to the

MTX100 MPEG Recorder & Player Service Manual (Tektronix part number

070-A835-XX) for detailed information.

���� ����� 
�����!�� 
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�
���  Use this connector to connect SCSI devices such as external hard disk

drives or a MO drives. For instructions on how to connect a SCSI hard disk see

page C-1.

������ 	���'��  Use this connector to connect the MTX100 to your local Ethernet

network.

����  Use this 9-pin D-sub connector to output the instrument display to a VGA

monitor, projector, or video printer (to make a screen hard copy).

��� �������  Use this 25-pin D-sub connector to input and output an SPI

(Synchronous Parallel Interface) signal. Refer to Appendix A: Specifications for

detailed information about the input voltage range for the signal.

���� ���  Use this BNC connector to input an external trigger signal to the

MTX100. Refer to Appendix A: Specifications for detailed information about the

input voltage range for the signal.


�����
 ���  Use this BNC connector to input an external reference signal or

clock signal to the MTX100. Refer to Appendix A: Specifications for detailed

information about the input voltage range for the signal.

����. Use a continuous signal for an external reference or clock signal.

��������  Use this 25-pin D-sub connector to connect a printer. This interface

supports IEEE 1284 parallel port standard.


�#� ��!%�  Use this card slot to install one of the optional interface cards. Refer

to Optional Interface Cards on page 2-10 for detailed information about the

interface cards.

There are two types of display screens to operate the MTX100; the Play screen

and the Record screen.

� Play screen is used to output the selected stream. When you power on the

instrument, this screen will display the last screen showing, previous to

powering down.

� Record screen is used to record the input stream. When you press the REC

button or select the Record command from the File menu while the Play

screen is displayed, the screen switches to the Record screen.

��$"��& ����� %$
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This subsection explains the name and its functions of the display elements that

consist of the Play or Record screen.

Figure 2-3 shows the location of display elements of the Play screen. The display

elements of the Record screen is the same as that of the Play screen.

�
�� 
	�

��	��� 
	�

�
�� ����	��� ����

���� ������

��
�	�����	�
�����	� �� ��


��	������ ���
	�

������ 
	�

����
	�

��	� ��	���
�����	���

�
�� �
���
 ����
����� ��	��� �����

	����� ������������� �� ��� ���� �
����


��� ����  The Menu bar displays the names of the menus that can be used in the

Play or Record screen. Press the MENU button to enable or disable the menus.

Refer to Using the Menus on page 3-3 for detailed information about the menus.
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��������  The toolbar provides shortcut buttons for many of the most often used

menu commands. Click a toolbar button to select the corresponding command.

You can toggle the toolbar display on and off using Toolbar command in the

View menu.

Refer to Toolbar Buttons on page 3-32 for detailed information about the

function of each toolbar button.


�������# �� ���#�  Each icon in the hierarchy display represents an element of the

stream. The hierarchy text contains a description of the associated icon.

Refer to Hierarchy Display on page 3-35 for detailed information about the

hierarchy icons.

���� 
"� ���  The Icon cursor appears as a red box around an icon in the hierarchy

to indicate the currently selected icon.

Use the up (�) or down (�) arrow button to move the Icon cursor between icons.

When the Icon cursor is at the top or bottom of the hierarchy display, the

hierarchy scrolls to show additional elements of the stream when applicable.

���#������� �!�!" ������!���  The Play Status indicator (see Figure 2-4) is

displayed while the selected stream is being output. It shows the output status of

the selected stream: the progress of the stream output, the output source, the

operational status, and the elapsed time.

The Record Status indicator is displayed while the input stream is being

recorded. It shows the record status of the input stream: the progress of the

stream record, the record target, and the elapsed time.

� � ��

���"�� �$�	����#  !�!" ������!��

The Play/Record Status indicator shows the following information:

1. Position Indicator. In the Play screen, this indicator shows the progress of

stream output using the duration gauge. In the Record screen, this indicator

shows the progress of stream record using the duration gauge.
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The duration gauge is updated every 1 second. If you output a stream with

repetition rate of around 3 seconds, the gauge may not be displayed

correctly.

2. Output Source/Record Target. In the Play screen, this indicator shows the

output source used to output the selected stream. In the Record screen, this

indicator shows the record target used to record the input stream.

Either of the following icons are displayed according to the selected output

source or record target:

���� ���� ����� ��
� ��� �
�
 
��� �� ���
 ��� ��� ������ ������ �� �����
 �
�����

���� ���� ����� ��
� ��� ��� �� ���
 ��� ��� ������ ������ �� �����
 �
�����

3. Operation Status. Shows the current operation status of the instrument.

In the Play screen, the following icons are used:

���� ���� ����� ��
� ��� �������
 ����
� �� ����� �������

���� ���� ����� ��
� ��� ����
� ������ �� ����� ������
�

���� ���� ����� ��
� ��� �������
 ����
� �� ����� ��

 ���� ��� �
�
 
��� �� ��� ����

In the Record screen, the following icons are used:

���� ���� ����� ��
� ��� �
�����
 ����
� �� ����� �����
�
�

���� ���� ����� ��
� ��� ����
� �����
 �� ����� ������
�

���� ���� ����� ��
� ��� ��	��� �
��� ��� 
 ������� ������

���� ���� ����� ��
� 
 ������� ����� �������

���� ���� ����� ��
� ��� �
�����
 ����
� �� ����� ��������
 �� ��� �
�
 
����

���� ���� ����� ��
� ��� �
�����
 ����
� �� ����� �
��
 ���� ��� ��� �� ��� �
�
 
����
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4. Elapsed Time. In the Play screen, this box displays the elapsed time of the

current stream data output.

In the Record screen, this box displays the elapsed time since the input

stream is recorded.


����� ���� The scroll bar appears when there is a hierarchy display to show your

relative position in the hierarchy of the stream.


����� ���� The Status bar (see Figure 2-5) contains several indicators that

display general information about the transport stream output or record status.

� � � � � �

������ ���
�
����� ���

The Status bar shows the following information:

1. Standard. In the Play screen, this indicator shows the standard used to

display the selected stream (MPEG2, ARIB, DVB, ATSC, S-TMCC,

M-TMCC, or Non TS). In the Record screen, this indicator shows the

standard used to display the input stream.

2. Packet Size. In the Play screen, this indicator displays the packet size in

bytes (188, 204, 208, Non TS, or Partial TS (Option 05 only)) of the stream

output. In the Record screen, this indicator displays the packet size in bytes

of the input stream.

3. Clock Source. This indicator displays the source of the reference clock

(internal or external) used for the stream output.

4. Bit Rate. In the Play screen, this indicator displays the bit-rate (in Mbps) of

the stream output. In the Record screen, this indicator displays the bit-rate

(in Mbps) of the input stream.

5. RAM free space. In the Play screen, this indicator shows the RAM free space

that can be used to output the selected stream. In the Record screen, this

indicator shows the RAM free space that can be used to record the input

stream.

6. Output Source/Record Target. In the Play screen, this indicator shows the

output source used to output the selected stream. In the Record screen, this

indicator shows the record target used to record the input stream.
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This indicator is the same as the output source/record target indicator of the

Play/Record Status indicator.

	����� ���������� 
����� ������  The remote connection status icons appear

when a TCP/IP connection for remote control is established. The right icon

shows the status of the TCP/IP connection (this icon is always displayed when

the TCP/IP connection is established), and the left icon shows the lock status of

the front-panel buttons and mouse input.

There are two display states:

���� ���"�  ��  �� ������ ������ ��� ��� ���� � ��� ��� �� �� ���������

���� ���"�  ��  �� ������ ������ ��� ��� ���� � ��� ��� �� �� �������� ���  ��
���� $����� �!  ��� ��� ��!�� ���! ��� ������ �#  �� �
�
�����	����
���� �

��������

To reset the lock status, send the :SYSTem:KLOCk:STATe OFF command or

press the ESC button on the front panel (if a keyboard is connected, press the Esc

key).

When the TCP/IP connection is closed, the remote status icons disappear.

�������� ��������� ���
�

The MTX100 is equipped with a card slot on the rear panel to install one of the

following optional interface cards:

� ASI interface (Option 01)

� Universal parallel/serial interface (Option 02)

� IEEE1394/ASI interface (Option 05)

� SMPTE310M/ASI interface (Option 06)

This subsection describes these interface options and their functions.
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Figure 2-6 shows the ASI interface. Refer to Appendix A: Specifications for

detailed specifications of the interface.

���&#� �(	����� � %�#����

��� ����  Use this BNC connector to output an ASI (Asynchronous Serial

Interface) signal.

��� ���  Use this BNC connector to input an ASI (Asynchronous Serial Interface)

signal. The left side of the connector has a loopthrough output.

Figure 2-7 shows the universal parallel/serial interface. Refer to Appendix A:

Specifications for detailed specifications of the interface.

���&#� �(
��� �'�#$�� "�#������$�#��� � %�#����

����
���� �������  Use this connector to input or output an ECL/TTL/LVDS

signal in a parallel or serial format.


�
�� ����  Use this BNC connector to output an event signal. This signal is the

same as the PSYNC signal of the parallel output.

��� � %�#���� ��"%�! ���

� �'�#$�� ��#��������#���
� %�#���� ��"%�! ���
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Figure 2-8 shows the IEEE1394/ASI interface. Refer to Appendix A: Specifica-

tions for detailed specifications of the interface.

���#!� �$��������	

���� ��"�!����

�����	

�  Use these 4-pin IEEE1394 connectors to connect an IEEE1394

device(s) such as a BS/CS tuner or a D-VHS recorder. Refer to Using the

IEEE1394 Interface (Option 05 Only) on page 3-119 for detailed information on

how to send or receive a transport stream using the IEEE1394 connector.

��� ����  Use this BNC connector to output an ASI (Asynchronous Serial

Interface) signal. This connector outputs a signal under the following conditions:

� While a stream is being output from the IEEE1394 connector.

� While a stream is being recorded using the IEEE1394 connector.

� While a stream is being recorded using the ASI IN connector.

��� ���  Use this BNC connector to input an ASI (Asynchronous Serial Interface)

signal.

�����	

���� ��"�!����
�� "��� ���

www.valuetronics.com



Operating Basics

MTX100 MPEG Recorder & Player User Manual �%�	

Figure 2-9 shows the SMPTE310M/ASI interface. Refer to Appendix A:

Specifications for detailed specifications of the interface.

���$"� �%��������	����
�� ��#�"����

����. The SMPTE310M interface supports the data rates of 19.392658 Mbps (8

VSB, 188 bytes packet size).

������ � ��� ��  Use these BNC connectors to output SMPTE310M or ASI

(Asynchronous Serial Interface) signals. You can select the output signal format

using the ASI/310M menu (refer to ASI/310M Menu on page 3-21). Two

connectors will output the same signal.

����. It is recommended that you connect a 75 � termination to the unused

output.

������  Use this BNC connector to input a SMPTE310M signal or an ASI

(Asynchronous Serial Interface) signal. You can select the input signal format

using the ASI/310M menu (refer to ASI/310M Menu on page 3-32). The left side

of the connector has a loopthrough output.

�����	����
�� ��#�"����
��!#� � �
�
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	���� ���� 
��������

This section describes the basics of using the MTX100’s menu and the methods

for entering numeric input in the various dialog boxes.

The menus are displayed in the menu bar at the top of the Play or Record screen.

You can operate these menus using the front panel MENU button, ESC button,

TAB button, ENTER button, and the arrow buttons (see Figure 2-10).

���� �����



�� �����
 ��
�� �����


����� �����
�

�	�������


������ ����������� ����� ������� ��� ���� ��������

��������� ���� 
��������  To access any menu command, press the MENU

button. When you press the MENU button, the File menu command list first

opens.

Use the up (�) or down (�) arrow button to move through the command list.

Press the ENTER button to execute the selected command.

Use the left (�) or right (�) arrow button to select the desired menu. Press the

ESC button to close the command list temporarily.

Press the MENU button again to close the menu command list.

www.valuetronics.com



Operating Basics

MTX100 MPEG Recorder & Player User Manual �$��

����. When you press the left arrow button while the File menu is displayed or

when you press the right arrow button while the Utility menu is displayed, the

command list for window operation of the MTX100 application is displayed.

	� ���# �!�!� �� !�� 
��" ������� � The menu commands can have the

following three display states as shown in Figure 2-11:

� A command followed by “�” indicates that a corresponding submenu will be

displayed after you press the ENTER button or the right (�) arrow button.

� A command followed by “...” indicates that a corresponding dialog box will

open after you press the ENTER button.

� If a command name is only displayed, the command will be executed after

you press the ENTER button.

� ������������	 �����	 ��� ���� ��
��������� �
�� �
�� ��

��� �� ��������

� ������������	 ���
��� ���� ��
���������

�
� ��������� ��

��� ���� �� ��������
�

��������


��"�� �$����	� ���#  !�!� �� !�� ���" ������� 

You can enter numeric values in displayed dialog boxes by using the 10 key Pad

or by using the arrow buttons.

�"����� ���"! � ��� !�� �� ��# ����  Perform the following procedure to input

numeric values by using the 10 Key Pad. Figure 2-12 shows the 10 Key Pad.

1. Open a dialog box including the text box in which you want to change a

parameter.

2. Press the TAB button repeatedly to select (highlight) the numeric parameter

you want to change in the open dialog box.

�"����� ���"!
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3. Press the SELECT button to open the 10 Key Pad (see Figure 2-12).

��
	�
� 
���� ���

��	�� �	�

��������	 �	�

����	� �	�

���	� �	�

	����� �!������ �� ���

4. Press the TAB button or the arrow buttons to move the dotted line box on

the number you want to input (When the key pad first opens, the box is

located on the ENT key).

5. Press the SELECT button. This displays the selected number in the numeric

input box.

6. Repeat steps 4 and 5 to input the desired parameter value.

7. Press the ENTER button (or select the ENT key and then press the

SELECT button). This enables the new value in the numeric input box and

closes the 10 Key Pad.

������� 
���� 
���� ��� ����� ��������  Perform the following procedure to

change a value by using the arrow buttons:

1. Open a dialog box including the text box that you want to change a

parameter.

2. Press the TAB button repeatedly to select the numeric parameter you want to

change in the open dialog box.

3. Press the left (�) arrow button to begin editing the parameter. This high-

lights the last digit.

4. Press the left (�) or right (�) arrow button to move the highlighted cursor to

the value you want to change.

5. Press the up (�) or down (�) arrow button to increase or decrease the value.
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6. Repeat steps 4 and 5 to enter all of the desired values. If you add an input

digit, press the left (�) arrow button.

7. After you change all of the values, press the ENTER button.

�
��� ��� ���� 	����� ������

When you output the selected stream data, you can select either the hard disk or

the RAM as an output source. This subsection describes the operation of the

MTX100 when each output source is selected.

When you select the RAM as an output source, the MTX100 performs the

following:

� When data output rate is less than or equal to 120 Mbps, the MTX100

outputs the first stream data while transferring the data from the hard disk to

the RAM and then continuously outputs the data from the RAM using

looping methods.

� When data output rate is more than 120 Mbps, the MTX100 continuously

outputs a stream data from the RAM using looping methods after the data is

completely transferred from the hard disk to the RAM.

If you select the RAM as an output source, you cannot output the data over the

RAM free space for the data output. This RAM free space is displayed on the

status bar. Refer to Status Bar on page 2-9, for more information about the

status bar.

If you select the hard disk (Disk) as an output source, the MTX100 always

outputs the selected stream data from the hard disk regardless of the data output

rate. When the reading speed of the hard disk cannot overtake the data output

rate, the error message “Error: Output Buffer Empty” appears.

Use the Source command in the Play menu to select the output source. Refer to

Play Menu on page 3-5 for more information about the Play menu.

You can see the currently selected output source in the status bar. Refer to Status

Bar on page 2-9, for more information about the status bar.


��

���� ����
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This section provides the following tutorials to familiarize you with the basic

functions of the MTX100:

� Outputting a transport stream

� Recording a transport stream

����. These tutorials do not cover all the features and functions of the MTX100.

The tutorials are intended to introduce you to the operations required to execute

the instrument’s basic functions.

Refer to the Reference section for detailed descriptions of the menus and

functions used in these procedures.

Before you perform these tutorials, make sure that the MTX100 is properly

installed. Refer to Installation on page 1-5.


������� ���������

Table 2-1 lists the equipment required to perform the tutorials. Accuracy of

alternate equipment should equal or exceed that of the example instruments and

accessories. Using inadequate equipment may result in inaccurate measurements.

��
�� ������������� ����������� ���� ��������� ��� ������������

���� 	�� 
����������� �������

���
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���������� � 
�������� 	�����

The hard disk drive of the MTX100 is shipped with files containing factory-sup-

plied samples of transport streams. This tutorial opens one of these sample files

and outputs the transport stream.

Perform the following steps to select and output a stored transport stream:

1. Press the front-panel PLAY button to display the Play screen.

2. Press the MENU button to open the File menu.

3. Press the up (�) or down (�) arrow button to select Open from the menu,

and then press the ENTER button to open the Select File dialog box shown

in Figure 2-13.

������ ������	���
������ ������ ���

4. Press the up (�) or down (�) arrow button to select the test64.TRP file, and

then press the ENTER button. This displays the hierarchy view of the

transport stream file shown in Figure 2-14.
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5. Connect the interface cable between the SPI IN/OUT connector on the

MTX100 rear panel to the SPI connector of the MPEG test system.

6. Press the MTX100 PLAY button to start the transport stream output.

When transport stream output is started, the Play Status indicator  

(see Figure 2-15) appears and the PLAY indicator at the left side of the

button lights.

������ ������	��� 
����� ��
������

7. Set up the MPEG test system to monitor the transport stream output from the

MTX100. Figure 2-16 shows the transport stream data displayed on a

Tektronix MTS300 Series Real-Time Analyzer.

8. Press the STOP button on the MTX100 to stop the transport stream output.

Observe that the Play Status indicator disappears.
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�� �� �$������������� ������ ������" ���� � ��������! ������ ������ 
���$����
	���"#��


�������� � ��������� ������

This tutorial captures a transport stream being applied into the SPI IN/OUT

connector and records it in the hard disk as a file.

Perform the following steps to capture a transport stream and record it in the

hard disk as a file:

1. Press the front-panel REC button to display the Record screen.

Since no signal is being applied at this time, No Signal message appears on

the top of the screen (see Figure 2-17).


�� �� �$������ ������ �������
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�������� Be sure to apply a signal to the SPI IN/OUT connector after an

interface cable is connected. If you connect the cable with a signal being output,

the MTX100 may not function correctly.

2. Connect the interface cable between the SPI IN/OUT connector on the

MTX100 rear panel to the SPI connector of the MPEG test system.

3. Output a transport stream from the MPEG test system.

When transport stream output is started, the hierarchy view of the transport

stream is displayed on the Record screen of the MTX100.

4. Press the MTX100 REC button.

When you press the button, the Record Status indicator (see Figure 2-18)

appears and the REC indicator at the left side of the button lights.

�����
 �������
���� 	�
��� �����
���

After the transport stream record is completed, the Record Status indicator

disappears, and the transport stream is saved automatically with the file name

which shows the current date (yy:mm:dd).
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The Reference section is divided into the following subsections:

� Using the Menus describes the function of each selection available in the

menus.

� Hierarchy Display describes the icons used by the MTX100 to represent

transport stream elements.

� Adding Jitter to PCRs provides instructions and procedures on how to add

jitter to PCRs.

� Continuous Recording Feature describes features and basic action of

Continuous Recording.

� Preset File provides information about the preset file and procedures on how

to save and load a preset file.

� Connecting to a Network provides procedures on how to connect the

MTX100 to your network.

� Outputting an ISDB-T Transport Stream describes the procedure to output an

ISDB-T transport stream from the MTX100.

� Syntax defines the command syntax and processing conventions.

� Remote Commands provides the remote commands set used in the MTX100.

� Default Settings lists the default settings of the remote commands.

� Error Messages and Codes lists the codes and messages used in the status

and event reporting system in the MTX100.

� Network Interface Specifications describes the MTX100 network interface

specifications.

� Using the IEEE1394 Interface (Option 05 Only) explains how to connect the

MTX100 Option 05 and an IEEE1394 devices(s), and how to set up the

MTX100 Option 05.
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This section describes the function of each selection available in the menus. This

section is divided into the following subsections:

� Menus in the Play Screen describes all of the menu commands and their

features available in the Play screen.

� Menus in the Record Screen describes all of the menu commands and their

features available in the Record screen.

� Toolbar Buttons describes the toolbar buttons and their functions.

Refer to Basic Menu Operation on page 2-14 for information about how to

operate the menus.


���� �� ��� ��� ������

This subsection describes the menus available in the Play screen.

The File menu in the Play screen contains commands for selecting a stream file

and for loading and saving a preset file. This menu also contains commands for

exiting the MTX100 application and for shutdown of the instrument. Table 3-1

describes the commands in the File menu.


���� �!���	��� ���� �������� ���� ��������

������� �����������

�+!) �+!)- � -.,!�( "%'! -.*,! %) .$! ��  ,%0! �0*'/(! ��� �$!) � "%'! %-
-!'!�.! � .$! ���	�� �$!�&- .$! +��&!. -%4! *" .$! "%'!� �$!) %. %- �
.,�)-+*,. -.,!�( "%'!� %.-  �.� %- */.+/. %) +��&!.-� �$!,!"*,!� %" �)
%)�*(+'!.! +��&!. %- %)�'/ ! �. .$! -.�,. *, !) +*%). *" .$! "%'!� .$!
+*,.%*) %- )*. */.+/.� �$! �0�%'��'! (%)%(/(  �.� -%4! %- 	�� ��3.!�

�$!) 3*/ -!'!�. .$%- �*((�) � .$! �!'!�. �%'!  %�'*# �*2 �++!�,-�
�!"!, .* �	�	�� ���	 ����
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����

����� ���� ������ 	�#�  When you select the Open command from the File menu,

the Select File dialog box appears as shown in Figure 3-1.

���!�� �%�������� ���� ������ ��#

Press the arrow buttons to select the desired file, and then press the ENTER

button to load the highlighted file.

Select Up One Level to move from the current directory to the directory one

level higher.

When you select the “...” button at the upper right side of the dialog box, the

Select File dialog box is displayed, and you can select the other file.

The View menu contains commands that control the display of the Toolbar and

Status bar. Table 3-2 describes the commands available in the View menu.

���" 
��!
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 330'&5  3,,0*6 7-* ).640&< 3+ 7-*  330'&5 32 &2) 3++ .2 7-* �0&< 6(5**2� � (-*(/
1&5/ 45*(*)*6 7-* (311&2) .2 7-* 1*28 :-*2 7-*  330'&5 .6 6*0*(7*)
+35 ).640&<�

�7&786 �&5  3,,0*6 7-* ).640&< 3+ 7-* �7&786 '&5 32 &2) 3++ .2 7-* �0&< 6(5**2� �
(-*(/ 1&5/ 45*(*)*6 7-* (311&2) .2 7-* 1*28 :-*2 7-* �7&786 '&5 .6
6*0*(7*) +35 ).640&<�

The Play menu contains commands for defining output parameters such as

packet size, output clock rate, or output source. Table 3-3 describes the com-

mands available in the Play menu.
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���
� 	����� ����  When you select the Clock command from the Play menu, the

Clock dialog box appears as shown in Figure 3-2.

��������
�	

����	�
�	


����� ��������
� ������ ���

� Clock Source: Sets which clock will be used as the reference for the stream

output. Press the TAB button repeatedly to select an item in the field, and

then press the left (�) or right (�) arrow button to select the desired clock

source. You can select from the following settings:

Internal uses the internal clock of the MTX100 as the clock reference.

Ext Ref allows you to input a signal on the CLK/REF IN connector for use

as the clock reference. When you select the button to the right of the ExtRef

box, the following External Reference dialog box appears.
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� 10 MHz: Selects a 10 MHz signal on the CLK/REF IN connector.

� 27 MHz: Selects a 27 MHz signal on the CLK/REF IN connector.

� IFFT: Selects a signal corresponding to the IFFT sample clock rate

(8.126984 MHz) on the CLK/REF IN connector.

Press the TAB button repeatedly to select an option button, and then

press the arrow buttons to select one of the options.

Ext P Clk (external parallel clock) allows you to input a clock signal on the

CLK/REF IN connector for use as the parallel clock.

Ext S Clk (external serial clock) allows you to input a clock signal on the

CLK/REF IN connector for use as the serial clock.

� Data Rate: Sets the clock rate for the transport stream output. You can enter

the clock rate using the following methods (the first method provides greater

clock-rate precision):

Enter values into the numerator and denominator text boxes (see Figure 3-2,

on page 3-7). The MTX100 will then calculate the clock rate based on the

ratio of the numerator and denominator values.

Enter a value into the clock rate text box. The MTX100 will then calculate

the numerator and denominator text boxes based on the clock rate.

When you use the Ext P Clk or Ext S Clk mode, set the clock rate to the

same value as the input clock signal. Also, when you use the Ext S Clk

mode, you cannot set the value more than 32 Mbps.

Press the TAB button repeatedly to select the value you want to change, and

then press the SELECT button to open the 10 Key Pad. Use the 10 Key Pad

to enter the desired value.

� Fixed ES Rate: Sets whether elementary stream rate is fixed or not. When it

is checked, the elementary stream rate becomes constant regardless of the

clock rate setting. If you fix the elementary stream rate, you cannot set the

output clock rate (Data Rate) more than the data rate set when the stream file

was downloaded.

Press the TAB button to select the check box, and then press the SELECT

button to toggle the check box on (checked) or off (not checked).

When the Fixed ES Rate check box is enabled, PCR/PTS/DTS Update

Method in the Select Update Item dialog box (see page3-17) is set to

Hardware automatically.

� Default Rate: Displays the default clock rate and packet size and then

changes the values. When you select this button, the following Default Clock

dialog box appears.
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Default Data Rate: Changes the default clock rate when the selected stream

file was downloaded.

Since the default clock rate is calculated based on the PCRs in the down-

loaded stream file, the value can be different than the original clock rate.

When the elementary stream rate is fixed (refer to the Fixed ES Rate

description), the instrument refers to the default clock rate. Therefore, if the

default clock rate is different than the original clock rate, you need to set the

value to the appropriate value. If you change the value, the clock rate value

in the Data Rate dialog box is also changed.

Packet Size: Changes the default packet size when the selected stream file is

downloaded. If you change the value, the Packet Size setting in the Play

menu will also change.

Press the ENTER button to enable all setting changes.


�� 	����
 
��� ������ ����  When you select the Non-TS from the Sync

command in the Play menu, the Set Non-TS Sync dialog box appears as shown

in Figure 3-3.

������ �����
�� 	����
 
��� ������ 
��
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� Psync Enable: Sets the status of the PSYNC signal output from the SPI

IN/OUT connector. Press the TAB button repeatedly to select this item, and

then press the SELECT button to toggle the check box on (checked) or off

(not checked).

� Interval: Sets the output period of the PSYNC signal in the range of 16 to

255 bytes. This value needs to be set equal to or greater than the Width value

in the Dvalid field. Press the TAB button repeatedly to select the box, and

press the up (�) or down (�) arrow button to set the value.

� Dvalid Enable: Sets the status of the DVALID signal output from the SPI

IN/OUT connector. Press the TAB button repeatedly to select this item, and

then press the SELECT button to toggle the check box on (checked) or off

(not checked).

� Width: Sets the data width of the DVALID signal in the range of 16 to 255

bytes. Press the TAB button repeatedly to select the box, and then press the

up (�) or down (�) arrow button to set the value.

Press the ENTER button to enable all setting changes.


	� ������� ����� 
����� ����  When you select the PCR Initial Value command

from the Play menu, the PCR Initial Value dialog box appears as shown in

Figure 3-4.

������ �����
	� ������� ����� ������ ���

� Base Value: Sets the initial value for the program_clock_reference_base

value. You can set the value from 0 to 8589934591. The bracketed number

represents the number of bits for the program_clock_reference_base field.

Press the TAB button repeatedly to select the text box, and then press the

SELECT button to open the 10 Key Pad. Use the 10 Key Pad to set the

desired value.
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� Extension Value: Sets the initial value for the program_clock_reference_ex-

tension value. You can set the value from 0 to 299. The bracketed number

represents the number of bits for the program_clock_reference_extension

field.

Press the TAB button repeatedly to select the text box, and then press the

SELECT button to open the 10 Key Pad. Use the 10 Key Pad to set the

desired value.


���� ����������� 	����� ����  When you select the Timer Play command from

the Play menu, the Timer Play/Record dialog box appears as shown in 

Figure 3-5.


����� �����
���� ����������� ������ ���

� Start at: Sets the date and time when the stream output or record starts.

Press the TAB button to select year, month, date, hour, minute, or second,

and then press the up (�) or down (�) arrow button to set the value.

If a mouse is connected to the MTX100, you can display a calendar for date

setting by clicking the � arrow button at the right side of the date display,

When you press the ENTER button after setting the date and time, a dialog

box showing the current date and time, and set date and time is displayed.

When the date and time arrives, the dialog box closes and stream output or

stream record starts automatically.

If you want to cancel the operation, press the ENTER, ESC, or SELECT

button. When the dialog box that prompt you to confirm the operation is

displayed, press the SELECT or ENTER button to execute the operation.
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�����
��� �������� 
����� 	���  When you select the Start/Stop command from

the Play menu, the Start/Stop dialog box appears as shown in Figure 3-6.

������

������ �����
�����
��� �������� ������ ���

� Start: Sets the start position of the stream by time (h:m:s) or the number of

packets (the number of super frames for a M-TMCC file, or the number of

bytes for a Non TS file). Use the Format list box to select the way to set the

position.

� Stop: Sets the stop position of the stream by time (h:m:s) or the number of

packets (the number of super frames for a M-TMCC file, or the number of

bytes for a Non TS file). Use the Format list box to select the way to set the

position.

� Initial: Sets the initial start position of the stream for loop output. You can

set the value by time (h:m:s) or the number of packets (the number of super

frames for a M-TMCC file, or the number of bytes for a Non TS file). Use

the Format list box to select the way to set the position.

� Play: Shows the actual time or number of packets (the number of super

frames for a M-TMCC file, or the number of bytes for a Non TS file) that is

calculated by the values of the Start and Stop text boxes.

� Format: Specifies the way to set the start, stop, and initial positions of the

stream. For a transport stream file, you can select Time or Packets. For a

M-TMCC file, you can select Time or SF (super frame). For a Non TS file,

you can select Time or Bytes.

www.valuetronics.com



Using the Menus

MTX100 MPEG Recorder & Player User Manual ����

For an ISDB-T file, the start packet is defined as the first-appearing packet

including an OFDM frame start flag after the specified start position. The

stop packet is defined as the packet at the front of the last-appearing packet

including an OFDM frame start flag before the specified stop position. At

this time, if the number of OFDM frames between the start packet and stop

packet is not an even number, the packet in the last OFDM frame becomes

the stop packet.

There are two ways to set the start, stop, and initial positions: using the slider

(see Figure 3-6) to set them or using the text boxes to enter values directly.

Using the slider:

1. For the start and stop positions:

a. Press the TAB button repeatedly to select the slider. When the slider is

selected, broken lines are showed around it.

b. Press the left (�) or right (�) arrow button to move the slider to the

place you want to set the start position.

c. Press the TAB button repeatedly to select the Stop option button, and

then press the SELECT button.

This moves the slider to the right end.

d. Press the TAB button repeatedly to select the slider. When the slider is

selected, broken lines are showed around it.

e. Press the left (�) or right (�) arrow button to move the slider to the

place you want to set the stop position.

f. Press the ENTER button to enable the values.

2. For the initial start position for loop output:

a. Press the TAB button repeatedly to select the Initial check box, and then

press the SELECT button.

A red arrow appears on the slider.

b. Press the TAB button repeatedly to select the red arrow. When the arrow

is selected, broken lines are showed around it.

c. Press the left (�) or right (�) arrow button to move the slider to the

place you want to set the initial start position.

d. Press the ENTER button to enable the value.
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Using the text boxes:

1. Press the TAB button repeatedly to select the Start text box. If you set a

time, select one of the text boxes for setting the hour, minute, or second.

2. Press the SELECT button. The 10 Key Pad appears.

3. Use the 10 Key Pad to enter the value.

4. If you set a time, repeat step 1 through step 3 to set the hour, minute, and

second.

5. Use the same procedure given in step 1 through step 4 to set the value in the

Stop text box.

6. Press the ENTER button to enable the values.

To reset all of the settings to the values when the dialog box is first displayed,

press the TAB button repeatedly to select the Reset button, and then press the

SELECT button.

������ 	����� ����  When you select the Other command from the Play menu, the

Others dialog box appears as shown in Figure 3-7.


����� ����������� ������ 
��

� Standard: Sets the standard used on the hierarchy-display screen. You can

select ARIB, ATSC, DVB, or MPEG2. For a transport stream (ARIB, ATSC,

DVB, or MPEG2), the standard is set to the previous setting as a default. For

an S-TMCC, M-TMCC, or ISDB-T transport stream, you need to select

ARIB for proper display.
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Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select one of the standards.

� Numeric: Sets the base value used to describe the component information in

the hierarchy display. You can select Decimal, Hexa, or Octal.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select one of the base values.

� SPI Output Enable: Sets whether the signal output from the SPI IN/OUT

connector is enabled or not. Use this function to set the SPI IN/OUT

connector to input only connector and UNIVERSAL IN/OUT connector to

set to output only connector when the universal parallel/serial interface

option is installed. 

Press the TAB button repeatedly to select the check box, and then press the

ENTER button to toggle the output on or off.

� TDT/TOT or STT: When you select this button, the following TDT/TOT

dialog box appears. The button name changes which standard is selected in

the Standard list box; TDT/TOT for ARIB or DVB, and STT for ATSC. Use

this dialog box to changes the initial date and time of the TDT (Time and

Data Table), TOT (Time Offset Table), or STT (System Time Table) in the

selected stream.

The button is disabled when MPEG2 is selected in the Standard list box.

Original: Uses the original (default) value that is already defined in the

selected stream.

OS (Windows2000) Time: Uses the clock/calendar of the operating system

(Windows 2000) to set the initial value. When you select this option, the date

and time of all the TDTs, TOTs, or STTs in the selected stream are locked to

the clock/calendar of the operating system.
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User Define: Uses the user-defined value to set the initial value. When you

select this option, the list boxes for setting the initial date and time of the

TDT, TOT, or STT are available.

Press the TAB button repeatedly to select an option button, and then press

the arrow buttons to select one of the options.

� ISDB/P-TS: When you select this button, the following ISDB/P-TS dialog

box appears.

Data Rate Auto Convert (Play Mode): Sets whether to set the clock rate

automatically when the ISDB–TSB file was loaded. Press the TAB button

repeatedly to select this item, and then press the SELECT button to toggle

the check box on (checked) or off (not checked). When it is checked, the

clock rate is automatically set to (2048/1701) x 27 MHz and the elementary

stream rate becomes constant regardless of the Fixed ES Rate setting.

Loop by ISDB-T Frame (Play Mode): Sets whether to output the ISDB-T

transport stream in OFDM frames when looped. Press the TAB button

repeatedly to select this item, and then press the SELECT button to toggle

the check box on (checked) or off (not checked). When it is not checked, the

ISDB-T transport stream is looped in packets.

Treat as Partial TS (Play Mode): Sets whether to output a stream file

consisting of a 192–byte packet as a partial transport stream. Press the TAB

button repeatedly to select this item, and then press the SELECT button to

toggle the check box on (checked) or off (not checked). When it is not

checked, the stream is output in Non TS format.
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� Update: When you select this button, the following Select Update Item

dialog box appears. Use this dialog box to select which parameters in a

stream are updated when looped.

Continuity Counter: Sets whether to update continuity_counter. Press the

TAB button repeatedly to select this item, and then press the SELECT

button to toggle the check box on or off.

PCR/PTS/DTS: Sets whether to update PCR (Program Clock Reference),

PTS (Presentation Time Stamp), and DTS (Decoding Time-Stamp). Press the

TAB button repeatedly to select this item, and then press the SELECT

button to toggle the check box on or off.

Update Method: Specifies the method to update PCR/PTS/DTS. You can

select Software or Hardware.

� Hardware: PCR/PTS/DTS are updated using the counter values of the

27 MHz clock on the output board. Since data output and PCRs are

completely locked, the continuity of PCRs is maintained at the loop

point even if playing long stream loops. However, timing errors occur in

PTS/DTS.

� Software: PCR/PTS/DTS are updated by adding the actual looping time

(defined by the start and stop positions) to the stream every time it is

looped. There are no timing errors in PTS/DTS, however, it is difficult to

maintain the continuity of PCRs at the loop point because the updating is

not synchronized with the 27 MHz clock on the output board. Since this

method is used to update NPT, if you enable the NPT option, Software is

selected automatically.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select either of two methods.
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TDT/TOT/STT: Sets whether to update TDT (Time & Data Table), TOT

(Time Offset Table), and STT (System Time Table). Press the TAB button

repeatedly to select this item, and then press the SELECT button to toggle

the check box on or off.

NPT : Sets whether to update NPT (Normal Play Time; STC_Reference

field in NPT Reference Descripter defined by ISO/IEC 18318-6). Press the

TAB button repeatedly to select this item, and then press the SELECT

button to toggle the check box on or off.

The NPT check box is only available when PCR/PTS/DTS is enabled and

Update Method is set to Software. When the check box is enabled, PCR/

PTS/DTS becomes enabled and Update Method is set to Software. In

addition, the Fixed ES Rate option in the Clock dialog box becomes

disabled.

Reed Solomon (ISDB-T only): Sets whether to update Reed-Solomon codes

in an ISDB-T transport stream. Press the TAB button repeatedly to select

this item, and then press the SELECT button to toggle the check box on or

off.

Press the ENTER button to enable all setting changes.

The ASI I/F menu is displayed when the ASI interface option is installed. This

menu contains commands for setting an ASI output format and output status.

Table 3-4 describes the commands available in the ASI I/F menu.
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The Univ I/F menu is displayed when the universal parallel/serial interface

option is installed. This menu contains commands for setting the output signal

level, output format, and polarity of the clock signal. Table 3-5 describes the

commands available in the Univ I/F menu.

���!� �-
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The ASI/1394 menu is displayed when the IEEE1394/ASI interface option is

installed. This menu contains commands for setting an output format of the ASI

signal and the operation mode for the IEEE1394 interface. Table 3-6 describes

the commands available in the ASI/1394 menu.
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�������	 ������ 
� �  When you select the PtoP Connect from the 1394 Mode

command in the ASI/1394 menu, the IEEE1394 dialog box appears as shown in

Figure 3-8.

������ �"
���������	 ������ �� ����! �������

� Instrument: Selects the IEEE1394 device for the point-to-point connection.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select the instrument.

� Connect or Disconnect: Connects or disconnects the selected IEEE1394

device.

����. If bus reset occurs by disconnecting an IEEE1394 cable when the

point-to-point connection is established, the connection is terminated.

� to Tuner: Sets whether the connection setting is made by the IEEE1394

device in connecting the MTX100 Option 05 and an IEEE1394 device.

Press the TAB button repeatedly to select the check box, and then press the

SELECT button to toggle the check box on (checked) or off (not checked).

Some IEEE1394 devices do not recognize the MTX100 Option 05 when you

make connection from the MTX100 Option 05. In this case, when you select

the check box, the IEEE1394 device takes initiative for the connection. You

need to select the check box when you connect a BS/CS tuner to the

MTX100 Option 05.

Press the ENTER button on the front panel to enable all the settings and to close

the dialog box.
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The ASI/310M menu is displayed when the SMPTE310M/ASI interface option

is installed. This menu contains commands for setting an output signal and ASI

output format. Table 3-7 describes the commands available in the ASI/310M

menu.
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The Utility menu contains commands for setting the parameters for remote

control with the Ethernet interface and for displaying the system information

such as software and hardware versions. Table 3-8 describes the commands

available in the Utility menu.
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�������
����� 	����� ����  When you select the Communication command from

the Utility menu, the Communication dialog box appears as shown in Figure 3-9.


����� ������������
����� ������ ���

� Port Number: Sets the port number needed to remotely control the

MTX100 over an Ethernet network. You can set the value from 1024 to

65535.

Press the TAB button repeatedly to select the box, and then press the up (�)

or down (�) arrow button to set the value.

� Terminator Tx: Sets the terminator used when the MTX100 sends

information to a controller. You can select LF (linefeed), CR (carriage

return), CRLF (carriage return and linefeed), or LFCR (linefeed and carriage

return).

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select one of the terminators.

� Terminator Rx: Sets the terminator used when the MTX100 receives

commands from a controller. You can select LF (linefeed) or CR (carriage

return).

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select one of the terminators.

Press the ENTER button to enable all setting changes.
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������ 	
���
 ����  When you select the Status command from the Utility menu,

the Status dialog box appears as shown in Figure 3-10.

This dialog box shows the version of the MTX100 application and hardware

version of the main and installed interface modules.

�

��� ������������ �
���
 ���
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����� ������

This subsection describes the menus available in the Record screen.

The File menu in the Record screen contains commands for setting the save

mode and for saving and loading a preset file. This menu also contains com-

mands for exiting the MTX100 application and for shutdown of the instrument.

Table 3-9 describes the commands in the File menu.
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The View menu contains commands that control the display of the Toolbar and

Status bar. The View menu in the Record screen is the same as that in the Play

screen. Refer to Table 3-2 on page 3-5 for the commands available in the View

menu.

The Record menu contains commands for setting the input interface, record size,

trigger position, and target source. Table 3-10 describes the commands in the

Record menu.
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������ ������ 	���  When you select the Target command from the Record menu,

the Target dialog box appears as shown in Figure 3-11.

������ � ���������� ������ ���
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� Record Size: Sets the recording time (h:m:s) or file size (MB) to record the

input stream. Use the Format list box to select the way to set the record size.

Press the TAB button repeatedly to select the text box (or one of the text

boxes for setting a time), and then press the SELECT button to open the 10

Key Pad. Use the 10 Key Pad to set the desired value.

The amount of free space available for the RAM or hard disk is displayed

below the data size text box. You cannot set the record size beyond this

value.

Use the Without Limit check box to record the input stream to the full free

space in the hard disk or RAM. When it is checked, the available recording

time and data size are automatically set. In addition, when the check box is

enabled, the Continuous Recording check box becomes disabled.

����. When you set the pretrigger portion, the same free space as the record

size is required.

There is a list box in the Record Size field to select which record target

(RAM or hard disk) is used to record the input stream. Press the TAB button

repeatedly to select the list box, and press the arrow buttons to toggle

between Disk or RAM.

� Trigger Position: Sets the trigger position used to record the input stream.

You can set the trigger position by a time (h:m:s) or file size (MB).

Press the TAB button repeatedly to select the slider, and then press the left

(�) or right (�) arrow button to move it to the desired position.

� Continuous Recording: Sets whether to enable Continuous Recording.

With Continuous Recording, you can record multiple stream files continu-

ously on the hard disk. Press the TAB button to select the check box, and

then press the SELECT button to toggle the check box on (checked) or off

(not checked).

When the check box is enabled, the spin box (at the right side of the check

box) becomes available. Use the spin box to set the number of files to stop

Continuous Recording. After the specified number of files are created,

stream capture stops automatically. You can set the value from 2 to 32767.

When this option is selected, the Without Limit check box becomes disabled.

Refer to Continuous Recording Feature beginning on page 3-53 for detailed

information about Continuous Recording.
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� Ignore D valid: Sets whether the MTX100 ignores the DVALID signal from

the selected interface when a stream data is acquired. When it is checked, the

MTX100 ignores the DVALID signal, and the stream data is acquired

according to the internal clock signal. This option is not available for the

ASI interface option.

Press the TAB button to select the check box, and then press the SELECT

button to toggle the check box on (checked) or off (not checked).

� Format: Specifies the way to set the record size and trigger position. You

can select Time or File Size.

Press the ENTER button to enable all the settings and to close the dialog box.

������ 	����� ����  When you select the Other command from the Record menu,

the Others dialog box appears as shown in Figure 3-12.


����� ������������ ������ 
��

� Standard: Sets the standard used to display the input stream. You can select

ARIB, ATSC, DVB, or MPEG2.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select one of the standards.

� Numeric: Sets the base value used to describe the component information in

the hierarchy display. You can select Decimal, Hexa, or Octal.

Press the TAB button repeatedly to select the list box, then press the arrow

buttons to select one of the base values.
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� Ext Record Start: Sets whether or not to start input stream record using a

trigger signal applied to the TRIG IN connector. You can select Off, Rise, or

Fall. When you set it to Rise, the input stream record is started at the rising

edge of the applied trigger signal. When you set it to Fall, the input stream

record is started at the falling edge of the applied trigger signal.

When you use the external trigger signal to record the input stream, if the

pretrigger portion is defined, the MTX100 acquires pretrigger data when a

valid trigger signal occurs and then waits for a trigger. When a valid trigger

signal occurs again, the MTX100 acquires posttrigger data and then creates a

stream file.

Press the TAB button repeatedly to select the list box, then press the arrow

buttons to select one of the external record modes.

� SPI Output Enable: This item cannot be accessed from the Record screen.

Refer to SPI Output Enable on page 3-15 for detailed information.

Press the ENTER button to enable all setting changes.

The ASI I/F menu is displayed when the ASI interface option is installed. This

menu contains command for setting the input status. Table 3-11 describes the

command available in the ASI I/F menu.
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The Univ I/F menu is displayed when the universal parallel/serial interface

option is installed. This menu contains commands for setting the input status

such as output signal level, output format, and polarity of the EVENT signal.

Table 3-12 describes the commands available in the Univ I/F menu.
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The ASI/1394 menu is displayed when the IEEE1394/ASI interface option is

installed. This menu contains commands for selecting the connector used to

capture a stream and setting the operation mode for the IEEE1394 interface.

Table 3-13 describes the commands available in the ASI/1394 menu.
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"(�  When you select PtoP Connect or Probe from the 1394

Mode command in the ASI/1394 menu, the IEEE1394 dialog box appears as

shown in Figure 3-13.
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� When PtoP Connect is selected:

� Instrument: Selects the IEEE1394 device for the point-to-point

connection.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select the instrument.

� Connect or Disconnect: Connects or disconnects the selected IEEE1394

device.

����. If bus reset occurs by disconnecting an IEEE1394 cable when the

point-to-point connection is established, the connection is terminated.

� to Tuner: Sets whether the connection setting is made by the IEEE1394

device in connecting the MTX100 Option 05 and an IEEE1394 device.

Press the TAB button repeatedly to select the check box, and then press

the SELECT button to toggle the check box on (checked) or off (not

checked).

Some IEEE1394 devices do not recognize the MTX100 Option 05 when

you make a connection from the MTX100 Option 05. In this case, when

you select this check box, the IEEE1394 device takes the initiative for

the connection. You need to select the check box when you connect a

BS/CS tuner to the MTX100 Option 05.

Press the ENTER button on the front panel to enable all the settings and to

close the dialog box.

� When Probe is selected:

� Source: Select the IEEE1394 device for the source.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select the instrument.

� Destination: Select the IEEE1394 device for the destination.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select the instrument.

Press the ENTER button on the front panel to enable all the settings and to

close the dialog box.

Refer to Using the IEEE1394 Interface (Option 05 only) on page 3-119 for

detailed information on how to connect the MTX100 Option 05 and an

IEEE1394 device(s), and how to set up the MTX100 Option 05 when using the

PtoP Connect and Probe modes.
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The ASI/310M menu is displayed when the SMPTE310M/ASI interface option

is installed. This menu contains a command for setting an input signal.

Table 3-14 describes the command available in the ASI/310M menu.
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)���
 ��
������
 $�� �� '�%� ��%� #�%� !� ���
��

The Utility menu contains commands for displaying the system information such

as software and hardware versions. The Utility menu in the Record screen is the

same as that of the Play screen. Refer to Table 3-8 on page 3-21 for detailed

information.

�""���$ 
'&&"!%

The toolbar (see Figure 3-14) provides shortcut buttons for many of the most

often used menu commands. Click a toolbar button to select the corresponding

command.

�!!���# �&%%! 

���'$� �*�	���""���$ �!� &""���$ �'&&"!%

To access the toolbar buttons, you need to connect a USB mouse to the USB

connector on the front panel.

�������� ��!' ��#&�"! �

�!�(�
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Table 3-15 shows the toolbar buttons and their functions.
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The MTX100 displays the selected transport stream using a hierarchy structure.

This section describes the hierarchy display and defines each icon you may

encounter in the display.


������� �� ��� 	�������� �������

The MTX100 uses icons displayed in a hierarchical structure to show the

interrelationship of transport stream components (see Figure 3-15). Additional

information about each stream component such as PID and Table ID numbers is

displayed next to each icon.

����
��	
�	

��	���
��	

������ ������������� �� ��� ��������� 
������

The “+” symbol displayed to the left of some icons indicates that the item

includes lower-level transport stream components that are not displayed. The

symbol changes to “–” when the lower level components are displayed. To

expand the hierarchy, select the desired upper-level icon and press the right

control button, and to collapse the selected upper-level icon press the left control

button.

When a transport stream contains more items than will display on the screen at

one time, a scroll bar appears at the right of the screen.
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The Icon cursor is used to select individual transport stream components as

represented by the icons. The Icon cursor is displayed as a red square (border)

surrounding a hierarchy icon (see Figure 3-15). Use the arrow buttons to move

the Icon cursor through the hierarchy. The hierarchy display scrolls (if applica-

ble) when the Icon cursor reaches the top or bottom of the displayed portion of

the hierarchy.

When the menus are enabled, the Icon cursor is disabled. Press the front-panel

MENU button to toggle control between the Icon cursor and the menus.

���#�#��' ��$"��' ��! $

Table 3-16 describes the icons you may encounter in the hierarchy display of the

MTX100 for transport streams using the MPEG-2, ARIB, DVB, and ATSC

formats.

Table 3-17 on page 3-39 describes icons that are specific to transport streams

using DVB format.

Table 3-18 on page 3-40 describes icons that are specific to transport streams

using ARIB  format.

Table 3-19 on page 3-42 describes icons that are specific to transport streams

using the ATSC format.

Refer to Icon Text and Dialog Box on page 3-43 for descriptions of the icon text

and dialog box associated with the hierarchy icon.
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To the right of each icon, the MTX100 displays text that describes each transport

stream component. In addition, for the PCR icon, you can display a dialog box to

change the parameters for the component.

This subsection describes the text information for each icon type and the dialog

box available for the PCR icon.

The following text information is displayed for the S-TMCC icon.

� “xxx.xx”: Shows the file name.

� TC8PSK/xx, BPSK/xx, or QPSK/xx: Shows the modulation system and the

number of contract slots (xx).

The following text information is displayed for the M-TMCC icon.

� “xxx.xx”: Shows the file name.

� SF: Shows the number of super frames.

The following text information is displayed for the Non Transport Stream (Non

TS) icon.

� “xxx.xx”: Shows the file name.

� FileSize: Shows the file size in byte.

The following text information is displayed for the Transport Stream (TS) icon.

� “xxx.xx”: Shows the file name of the transport stream.

� Packets: Shows the total number of packets in the transport stream.

When this icon is used with the S-TMCC or M-TMCC icon, the following text

information is displayed.

� TSID: Shows the ID number for the transport stream.

� TC8PSK/xx, BPSK/xx, or QPSK/xx: Shows the modulation system and the

number of contract slots (xx).
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The following text information is displayed for the Program Allocation Table

(PAT) icon.

� PID: Shows the PID value of the PAT.

� TblID: Shows the table_id value of the PAT.

� TSID: Shows the transport_stream_id value of the PAT.

� Prg: Shows the number of programs contained in the transport stream.

The following text information is displayed for the Transport Stream Description

Table (TSDT) icon.

� PID: Shows the PID value of the TSDT.

� TblID: Shows the table_id value of the TSDT.

The following text information is displayed for the Network Information Table

(NIT) icon.

� PID: Shows the PID value of the NIT.

� TblID: Shows the table_id value of the NIT.

The following text information is displayed for the Conditional Access Table

(CAT) icon.

� PID: Shows the PID value of the CAT.

� TblID: Shows the table_id value of the CAT.

The following text information is displayed for the Program Map Table (PMT)

icon.

� PID: Shows the PID value of the PMT.

� TblID: Shows the table_id value of the PMT.

� PrgNo: Shows the program number associated with the PMT.

The following text information is displayed for the Program Clock Reference

(PCR) icon.

� PID: Shows the PID value of the PCR.
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��� �����"���$ 
����� ��#� If you press the SELECT button when the PCR icon

is selected, the PCR Inaccuracy dialog box appears as shown in Figure 3-16.

This dialog box allows you to add jitter to the program_clock_reference_base

value and the program_clock_reference_extension value.

Refer to Adding Jitter to PCRs on page 3-49 for more information.

Table 3-20 describes the PCR Inaccuracy dialog box parameters.
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The following text information is displayed for the video elementary stream

(VIDEO) icon.

� PID: Shows the PID value of the video elementary stream.

� StrmTyp: Shows the type of the video elementary stream (0x01 or 0x02).

The following text information is displayed for the audio elementary stream

(AUDIO) icon.

� PID: Shows the PID value of the audio elementary stream.

� StrmTyp: Shows the type of the audio elementary stream (0X03 or 0X04).

The following text information is displayed for the AUDIO_AAC and

ADIO_AC3 (ATSC only) icons.

� PID: Shows the PID value of the audio elementary stream.

� StrmTyp: Shows the type of the audio elementary stream (0X0F or 0x81).

The following text information is displayed for the data stream (DATA) icon.

� PID: Shows the PID value of the data stream.

� StrmTyp: Shows the type of the data stream.

The following text information is displayed for the private section

(DATA_SECT) icon.

� PID: Shows the PID value of the private section.

� TblID: Shows the table_id value of the private section.

� StrmTyp: Shows the type of the private section.

The following text information is displayed for the digital storage media

command and control (DSM_CC) icon.

� PID: Shows the PID value of the data DSM-CC.

� StrmTyp: Shows the type of the DSM-CC.
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The following text information is displayed for the Entitlement Control Message

(ECM) icon.

� PID: Shows the PID value of the ECM.

� TblID: Shows the table_id value of the ECM.

The following text information is displayed for the Entitlement Management

Message (EMM) icon.

� PID: Shows the PID value of the EMM.

� TblID: Shows the table_id value of the EMM.

The following text information is displayed for the GHOST icon.

� PID: Shows the PID value of the GHOST.

The following text information is displayed for the Adaptation Field Error

(ADFERR) icon.

� PID: Shows the PID value of the ADFERR.

The following text information is displayed for the NULL icon.

� PID: Shows the PID value of the NULL.

The following text information is displayed for the GARBAGE icon.

� PID: Shows the PID value of the GARBAGE.

The following  text information is displayed for the Service Description Table

(SDT), Bouquet Association Table (BAT), Event Information Table (EIT),

Running Status Table (RST), Stuffing Table (ST), Discontinuity Information

Table (DIT), Selection Information Table (SIT), Local event Information Table

(LIT), Event Relation Table (ERT), Index Transmission Table (ITT), Partial

Content Announcement Table (PCAT), Software Download Trigger Table

(SDTT),  Download Control Table (DCT),  DownLoad Table (DLT), Broadcaster

Information Table (BIT), Network Board Information Table (NBIT), and Linked

Description Table (LDT) icons.

� PID: Shows the PID value of the SDT, BAT, EIT, RST, ST, DIT, SIT, LIT,

ERT, ITT, PCAT, SDTT, DCT, DLT, BIT, NBIT, or LDT.

� TblID: Shows the table_id value of the SDT, BAT, EIT, RST, ST, DIT, SIT,

LIT, ERT, ITT, PCAT, SDTT, DCT,  DLT, BIT, NBIT, or LDT.
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The following text information is displayed for the Time and Data Table (TDT)

and Time Offset Table (TOT) icons.

� PID: Shows the PID value of the TDT or TOT.

� TblID: Shows the table_id value of the TDT or TOT.

The following text information is displayed for the Master Guide Table (MGT)

and Program Identifier Table (PIT) icons.

� PID: Shows the PID value of the MGT or PIT.

� TblID: Shows the table_id value of the MGT or PIT.

The following text information is displayed for the Terrestrial Virtual Channel

Table (TVCT), Cable Virtual Channel Table (CVCT),  Rating Region Table

(RRT), Event Information Table (EIT), Channel Extended Text Table (CETT),

and Event Extended Text Table (EETT) icons.

� PID: Shows the PID value of the TVCT, CVCT, RRT, EIT, CETT, or EETT.

� TblID: Shows the table_id value of the TVCT, CVCT, RRT, EIT, CETT, or

EETT.

� TblType: Shows the table_type value of the TVCT, CVCT, RRT, EIT, CETT,

or EETT.

The following text information is displayed for the System Time Table (STT)

icon.

� PID: Shows the PID value of the STT.

� TblID: Shows the table_id value of the STT.

�	� ��� ��� ����
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The MTX100 provides the capability to add jitter to PCRs (Program Clock

References). Adding jitter to PCRs allows you to simulate transmission delay

variations and to test the robustness of decoders under various conditions.

The jitter function adds jitter to the program_clock_reference_base value and the

program_clock_reference_extension value in the adaptation field of transport

stream packets. You can use this function to modulate the data values of the

PCRs away from their correct values.

������ ������

Perform the following procedure to add jitter to PCRs:

1. Use the Icon cursor to select the PCR item in the hierarchy display. If the

Icon cursor is not available, press the MENU button to enable the Icon

cursor.

2. Press the SELECT button. This opens the PCR Inaccuracy dialog box

shown in Figure 3-17.


����� ������
	� ���������� ������ ���
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3. The PCR Inaccuracy dialog box lets you set how the parameters for how

jitter will be added to the PCR.

� Pattern: Selects the waveform type of the waveform used to add jitter.

You can select Sine, Square, Triangle, Pulse, Sawtooth, Random, or

Offset.

Press the TAB button repeatedly to select the list box, and then press the

arrow buttons to select the desired waveform.

� Period: Sets the period of the waveform used to add jitter. You can set

the value from 5 to 3000 packets in 1 packet steps.

Press the TAB button repeatedly to select the text box, and then press the

SELECT button to open the 10 Key Pad. Use the 10 Key Pad to enter

the desired value.

� Amplitude: Sets the amplitude of the waveform used to add jitter. You

can set the value from 0/27 MHz to 135000000/27 MHz (0 to 5 s).

Press the TAB button repeatedly to select the text box, and then press the

SELECT button to open the 10 Key Pad. Use the 10 Key Pad to enter

the desired value.

� Pulse Width: Sets the pulse width of the waveform used to add jitter.

You can set the value from 1 to (period–1) packet(s) in 1 packet steps.

This Pulse Width parameter is available only when the Pattern parameter

is set to Pulse.

Press the TAB button repeatedly to select the text box, and then press the

SELECT button to open the 10 Key Pad. Use the 10 Key Pad to enter

the desired value.

4. After you have set the parameters, press the ENTER button to enable the

jitter function.

Figure 3-18 shows the relationship among the parameters and how the PCR

values (program_clock_reference_base value and program_clock_reference_ex-

tension) change when Sine is selected as a jitter-pattern waveform. The PCR

values varies by the value of sine waveform defined by the amplitude and period.

The PCR period does not change.
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The Continuous Recording feature allows you to record multiple stream files

continuously on the hard disk.

This section describes features and basic action of Continuous Recording, and

how to perform it to record stream files.

�����
��

Continuous Recording has the following features:

� Record multiple stream files continuously on the hard disk

� Variable file size operation

� The time stamp information of the first trigger event in a file is recorded as

the updated date property of the file.

� Can be used in Disk or RAM recording mode.

www.valuetronics.com



Using the Continuous Recording Feature

���� MTX100 MPEG Recorder & Player User Manual

�	��
 �
���� �
 ���������� ��
������

This section describes how files are recorded by the location of the trigger events

in Continuous Recording.

The following explanation assumes that both pretrigger and posttrigger sizes are

set to 500 MB.

� In general, each trigger event occurs intermittently. In this case, each file has

one trigger event in the file, and the pretrigger and posttrigger areas have the

specified size.

File A

File B

Trigger event

Trigger event

ÇÇÇÇÇ
ÇÇÇÇÇ

500 MB 500 MB

ÇÇÇÇÇ
ÇÇÇÇÇ

500 MB 500 MB

ÇÇPretrigger area

Posttrigger area

� If a trigger event occurs while the pretrigger area is filled with data, the

pretrigger area becomes smaller than the specified size. However, the

posttrigger area keeps the specified size. In this case, the size of the File A is

smaller than the specified size.

File A

File B

Trigger event

Trigger event

ÇÇÇÇÇ
ÇÇÇÇÇ

300 MB 500 MB

ÇÇÇÇÇ
ÇÇÇÇÇ

500 MB 500 MB

ÇÇ
Pretrigger area

Posttrigger area
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� If the second trigger event occurs while the posttrigger area is filled with

data, the second trigger event is ignored.

File A

File B

Trigger events

Trigger event

ÇÇÇÇÇÇ
ÇÇÇÇÇÇ

500 MB 500 MB

ÇÇÇÇÇÇ
ÇÇÇÇÇÇ

500 MB 500 MB

ÇÇPretrigger area

Posttrigger area

����. If the trigger position is set to 0 (%), each file is created whenever a

trigger event occurs.

�	�
��
��� ���������� �	�������

Use the following procedure to perform Continuous Recording:

1. Press the front-panel REC button to display the Record screen.

2. Select Save command from the File menu to open the Save as dialog box.

3. In the dialog box, select the folder where stream files are to be saved.

4. Select Target from the Record menu to open the Target dialog box.

5. In the dialog box, enable the Continuous Recording check box

(see Figure 3-19).
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6. In the spin box at the right side of the check box, set the number of files to

stop Continuous Recording. After the specified number of files are created,

stream capture stops automatically.

7. In the Record Size field, set the file size to be recorded.

8. In the Trigger Position field, set the trigger position.

9. If you want to start recording by a trigger signal on the TRIG IN connector:

a. Select Other command from the Record menu to open the Others

dialog box.

b. Select Rise or Fall in the Ext Record Start field.

10. Press the front-panel REC button to start continuous recording.

While Continuous Recording is running, the total number of captured files

are displayed in the file counter on the record status indicator.

��
� �������

������ ����	����� �������
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When the specified number of files are created or you press the front-panel

STOP button, stream capture stops.

After the stream capture stops, recording of the captured streams starts. The

file counter value decreases every time recording of each file is complete.

The recording starts from the last captured file. If you press the STOP button

while the captured streams are recording, the recording process terminates to

the file currently being recorded.

����. The error message Drive Full appears when there is no space to record a

captured file with the specified file size on the hard disk.
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The MTX100 provides the capability to save the user-defined instrument settings

as a preset file and load the instrument settings saved as a preset file. This

section describes the contents of the instrument settings saved as a preset file and

how to save and load a preset file.

����
��� �� �

 ��
�
� ���


The preset file can be created both of the Play screen and Record screen. In the

Play screen, you can save settings for stream output. In the Record screen, you

can save settings for stream record.

� In the Play screen, all of the parameter settings available in the Play menu

are saved as a preset. If any of the interface options are installed, the output

parameter settings of the module are also saved.

� In the Record screen, all of the parameter settings available in the Record

menu are saved as a preset. If any of the interface options are installed, the

input parameter settings of the module are also saved.

�	���� 	 ��
�
� ���


Use this procedure to save the current instrument settings as a preset file.

Perform the following steps to save a preset file:

1. Set the instrument settings that you want to save.

2. Select Save Preset from File menu, and then press the ENTER button. The

Save As dialog box appears as shown in Figure 3-21.

www.valuetronics.com



Preset File

���� MTX100 MPEG Recorder & Player User Manual

	����� �������
�� �� ��
��� ���

In the File name text box, the following default file name is displayed

automatically:

� In the Play Screen, a two digits serial number is added to the selected file

name (for example, if the selected file name is Test_TS, the default file name

becomes Test_TS00).

� In the Record Screen, a Preset# (# shows two digits serial number).

When a keyboard is connected to the USB connector, you can enter the

desired file name.

3. Press the ENTER button. This saves the instrument settings as a preset file.


�
���� 
 ������ 	���

Use this procedure to load an instrument settings saved as a preset file.

Perform the following steps to load a preset file:

1. Select Load Preset from File menu, and then press the ENTER button. The 

Open dialog box appears as shown in Figure 3-22.
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2. Press the TAB button repeatedly to select the file displayed at the top of the

file list. When the file is selected, broken lines are showed around the file

name.

3. Press the up (�) or down (�) arrow button to select the preset file that you

want to load. The selected file name is displayed in the File Name text box.

4. Press the ENTER button. This loads the preset file into the instrument.

www.valuetronics.com



Preset File

���� MTX100 MPEG Recorder & Player User Manual

www.valuetronics.com



MTX100 MPEG Recorder & Player User Manual �%��


����� ���  � � �� #���

The MTX100 has a 100/10 BASE-T port on the rear panel that allows you to

upload and download stream files.

This section provides instructions for connecting the MTX100 to a single PC or

a network and setting the network parameters for the 100/10 BASE-T port.


����� ���  �� 
�����  � $�!� �
���

The MTX100 uses the rear-panel 100/10 BASE-T port (see Figure 2-2 on page

2-4) to communicate with a PC. Use one of the following two methods to

connect the MTX100 to your PC(s).

� If you are connecting the MTX100 directly to a single PC, use a crossover

Ethernet cable to connect between the 100/10 BASE-T port on the MTX100

and the Ethernet port on the PC. If you need to construct your own crossover

cable, Figure 3-23 shows the pin connections to change on a straight cable to

produce a crossover cable.

� If you are connecting the MTX100 to your local Ethernet network, use a

straight Ethernet cable to connect between the 100/10 BASE-T port on the

MTX100 and the Ethernet hub port of your local network. By connecting to

an Ethernet network, you can access the MTX100 using any PC on the

network.
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You can set the network parameters for the MTX100 using the Control Panel of

Windows 2000.

����. The following procedure assumes that you are familiar with the basics of

using the Windows 2000 operating system. If necessary, review the Windows

2000 documentation.

Perform the following procedure to set the network parameters for the MTX100.

1. Connect the keyboard and mouse provided with the instrument to the USB

connectors on the front panel. You can connect them to either of the

connectors.

2. Select Minimize or Exit from the File menu to close the Play (or Record)

screen. The Windows 2000 desktop appears.

3. Select Settings � Control Panel from the Start menu. The Control Panel

window appears.

4. Double-click the Network and Dial-up Connections icon in the window.

The Network and Dial-up Connections window appears as shown in

Figure 3-24.


����� � ����������� ��� ���� �� ����������� ������
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5. Double-click the Local Area Connection icon. The Local Area Connection

Status dialog box appears as shown in Figure 3-25.

	����� ������
��
� ���
 ���������� ��
��� ��
��� ���

6. Click the Properties button. The Local Area Connection Properties dialog

box appears as shown in Figure 3-26.

������� ��
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7. In the network component field, click Internet Protocol (TCP/IP).

8. Click the Properties button. The Internet Protocol (TCP/IP) Properties

dialog box appears as shown in Figure 3-27.


��%"� �)�	
���$�"��$ �" $ � � �������� �" !�"$��# ���� � � (

The settings in the dialog box depend on whether a DHCP (Dynamic Host

Configuration Protocol) server is in the network connected to the MTX100.

���� $�� ���� ��"&�" �# �� $�� ��$' "��

9. In the dialog box, select the Obtain an IP address automatically and

Obtain DNS server address automatically check boxes.

10. Click the OK button.

The MTX100 accesses the DHCP server and obtains the addresses automatically

when connected to the network.

Refer to the user documentation supplied with your server OS for detailed

information about DHCP server functions.
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����. Under some network environments, the MTX100 may not be able to

obtain the IP address automatically from a DHCP server. In this case, you need

to enter the appropriate address value in each submenu item.

��
� ��
 ���
 �
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� �� ��� �� ��
 	
������

When the DHCP server is not in the network, perform the following procedure to

set the network parameters.

1. If you connect the MTX100 directory to a single PC:

a. In the dialog box, select the Use the following IP address check box.

b. Set the IP address parameter to be the same IP address as the PC’s

address except for the last number. The last number must be different

than the last number in the PC’s IP address.

c. Set the Subnet mask parameter to be the same net mask (subnet mask)

used by the PC. Do not enter a number if the PC does not have a net

mask.

d. You do not need to enter a Default gateway if you are directly connected

to a single PC.

2. If you connect the MTX100 to your local Ethernet network:

a. In the dialog box, select the Use the following IP address check box.

b. Ask your local network administrator and set the appropriate addresses.

��	����� To prevent communication conflicts on your Ethernet network, ask

your local network administrator for the correct numbers to enter in the dialog

box if you connect the MTX100 to your local Ethernet network.

3. Verify the Ethernet connection by using a ping command from the PC.
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This section describes how to set up the MTX100 and how to connect the

MTX100 and a modulator when you output an ISDB-T (Integrated Services

Digital Broadcasting for Terrestrial) transport stream.

Perform the following procedure to output an ISDB-T transport stream from the

MTX100:

1. Press the PLAY button to display the Play screen.

2. Select the Other command from the Play menu to open the Others dialog

box.

3. In the dialog box, select ARIB in the Standard field.

����. Before the MTX100 can recognize an ISDB-T transport stream file, ARIB

must be selected in the Standard field.

4. Select the Open command from the File menu to open the Select File dialog

box.

5. In the dialog box, select the ISDB-T transport stream file that you want to

output.

The hierarchy view of the transport stream file is displayed on the screen as

shown is Figure 3-28.
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6. Select the ISDB-T transport stream icon and press the front-panel SELECT

button (or click the icon with the right mouse button) to open the ISDB-T

Information dialog box, shown in Figure 3-29.

����. The ISDB-T transport stream is different from the typical transport

stream, so the icon is not represented as a train.
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Use this dialog box to check the transmission parameters of the ISDB-T

transport stream.

���  �� 
����� � ��� ���� �� ��� ���

7. Use an interface cable to connect the SPI IN/OUT connector (or the output

connector on the installed optional card) on the MTX100 and an ISDB-T

modulator.

8. Press the PLAY button on the MTX100 to output the transport stream.

����. For an ISDB-T transport stream, the MTX100 outputs the stream from the

start packet in the OFDM frames to the maximum number of packets that can be

looped as 2�N of the number of OFDM frames. If any transport stream within

the ISDB-T transport stream have different modulation parameters, select Non

TS from the Packet Size command in the Play menu.

���  �� 
����� �� ��� ���

9. Select PI Clock from the Univ I/F menu. This menu item is only available

when an ISDB-T file is loaded.

10. In the displayed submenu, select the scale factor of the Packet Information

clock to the TS clock (4 MHz).
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11. Use an interface cable to connect the SPI IN/OUT connector on the

MTX100 Option 02 and the TSP input on the ISDB-T modulator.

12. Use an interface cable to connect the UNIVERSAL IN/OUT connector on

the MTX100 Option 02 and the PI input on the ISDB-T modulator.

13. In the Univ I/F menu on the MTX100 Option 02, make the following

settings:

Level LVDS. . . . . . . 

Format Parallel. . . . . 

Clock Rise. . . . . . 

14. Press the PLAY button on the MTX100 Option 02 to output the transport

stream.

����. For an ISDB-T transport stream, the MTX100 outputs the stream from the

start packet in the OFDM frames to the maximum number of packets that can be

looped as 2�N of the number of OFDM frames. If any transport stream within

the ISDB-T transport stream have different modulation parameters, select Non

TS from the Packet Size command in the Play menu.

At this time, the transport stream data is output from the SPI IN/OUT

connector and the control signals for the hierarchical multiplexing parame-

ters are output from the UNIVERSAL IN/OUT connector.

Refer to Appendix D: Control Signals for Option 02 for information about the

pin assignments of the UNIVERSAL IN/OUT connector and timing relationship

of the output signals on the connector.
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This section contains information on the Standard Commands for Programmable

Instruments (SCPI) and IEEE 488.2 Common Commands you can use to

program your MTX100. The information is organized in the following subsec-

tions:

��
	 ����
��� 
�� �������

SCPI is a standard created by a consortium that provides guidelines for remote

programming of instruments. These guidelines provide a consistent program-

ming environment for instrument control and data transfer. This environment

uses defined programming messages, instrument responses, and data format

across all SCPI instruments, regardless of manufacturer. The MTX100 uses a

command language based on the SCPI standard.

The SCPI language is based on a hierarchical or tree structure (see Figure 3-30)

that represents a subsystem. The top level of the tree is the root node; it is

followed by one or more lower-level nodes.

	���

�����



�����
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You can create commands and queries from these subsystem hierarchy trees.

Commands specify actions for the instrument to perform. Queries return

measurement data and information about parameter settings.

SCPI commands are created by stringing together the nodes of a subsystem

hierarchy and separating each node by a colon.

In Figure 3-30, RECord is the root node and TARGet, TYPE, SIZE, and TIME

are lower-level nodes. To create a SCPI command, start with the root node

RECord and move down the tree structure adding nodes until you reach the end

of a branch. Most commands and some queries have parameters; you must

include a value for these parameters. If you specify a parameter value that is out

of range, the parameter will be set to a default value.

���
���� ����
���
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For example, RECord:TARGet:TYPE DISK is a valid SCPI command created

from the hierarchy tree in Figure 3-30.

To create a query, start at the root node of a tree structure, move down to the end

of a branch, and add a question mark. RECord:TARGet:TYPE? is an example of

a valid SCPI query using the hierarchy tree in Figure 3-30.

Every parameter in the command and query descriptions is of a specified type.

The parameters are enclosed in brackets, such as <pattern>. The parameter type

is listed after the parameter and is enclosed in parentheses, for example,

(discrete). Some parameter types are defined specifically for the MTX100

command set and some are defined by ANSI/IEEE 488.2-1987 (see Table 3-21).
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+(:$'(&,/$.� �(:$'(&,/$. 07/%(45
�	��� �� �� �� �� �� ��

����� ��


��
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� 
�� �
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��� ��


�
�� ����
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����� �
��
��
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�(( ��
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� �� ��
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���� �- 4� !$($. � (".# �,�$.,�,3 �&)�% � -*)(- ��.���

� �( ��������� 
������
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 � !$( � $( ��������� 
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You can abbreviate most SCPI commands, queries, and parameters to an

accepted short form. This manual shows these short forms as a combination of

upper and lower case letters. The upper case letters indicate the accepted short

form of a command. As shown in Figure 3-31, you can create a short form by

using only the upper case letters. The accepted short form and the long form are

equivalent and request the same action of the instrument.

���� ���� �� 	
����	��

������� ������	���� �

�
�
��� 	��
��
� ����� ����

���
��
� ����� ����
�� 	 ����	�� 	��

�	�	�
�
�

�
	��������
��������

�
	��������� ���
��������� ������

���!�� �$�����#����� �� �����"�� ��� � �������

You can chain several commands or queries together into a single message. To

create a chained message, first create a command or query, add a semicolon (;),

and then add more commands or queries and semicolons until you are done. If

the command following a semicolon is a root node, precede it with a colon (:).

Figure 3-32 illustrates a chained message consisting of several commands and

queries. The single chained message should end in a command or query, not a

semicolon. Responses to any queries in your message are separated by semico-

lons.

��
	���������
!������
	���������
!������
	���������
����
	��������
������

����� ����	�� �
���� ����	�� �
���� ��
��

��
 �
�����
 ���� ���� ��	��
� �
��	�
 ����� 



�
�����
 ���� ����� ��
�� �
�����
 ���� �
���� ��
��

�����

����� ��
��

���!�� �$�����#����� �� �������� �������� ��� �!�����

	����"�� ��� 
��������
�!������ ��� 
����� ���


������� 
������� ���
�!�����
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If a command has the same root and lower-level nodes as the previous command,

you can omit these nodes. In Figure 3-33, the second command has the same

root node (REC) and lower level node (TARG) as the first command, so these

nodes can be omitted.

�	
��
��� ���� ��	 ���
���
�
� ��	
�

�
��� ������	 �		
�
���� ������	�
���
��
�� ��
 ���� ��	
��

��
����������
#������
���������������#�����
���������
�#��

��
����������
#������������#�����
�#��

�����
 ��������
���
 �� �������� ���� 
�� ���
���
�
� ���
� �� 
 ��
��
� �
��
�


Here are three general rules for using SCPI commands, queries, and parameters:

� You can use single (‘ ’) or double (“ ”) quotation marks for quoted strings,

but you cannot use both types of quotation marks for the same string.

correct: “This string uses quotation marks correctly.”

correct: ‘This string also uses quotation marks correctly.’

incorrect: “This string does not use quotation marks correctly.’

� You can use upper case, lower case, or a mixture of both cases for all

commands, queries, and parameters.

�
���	�����
�������
����������#��

is the same as

 ��� �����!�"���#"� ��"�" ���� ��

and

�
���	�"� ��"�" ���� ���������#��

����. Literal strings (quoted) are case sensitive. For example: file names.

�
�
�
� 	��
�
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� No embedded spaces are allowed between or within nodes.

correct: ������
������
�������
��������!��

incorrect: ������
 ������
 �������
 ���� ����!��

���� ����� 
 �� � 
 �����#

ANSI/IEEE Standard 488.2 defines the codes, formats, protocols, and usage of

common commands and queries used on the interface between the controller and

the instruments. The MTX100 complies with this standard.

The syntax for an IEEE 488.2 common command is an asterisk (*) followed by a

command and, optionally, a space and parameter value. The syntax for an 

IEEE 488.2 common query is an asterisk (*) followed by a query and a question

mark. All of the common commands and queries are listed in the last part of the

Syntax and Commands section. The following are examples of common

commands:

� ���� �	

� ����

The following are examples of common queries:

� �����

� �����

This manual may describe commands and queries using the Backus-Naur Form

(BNF) notation. Table 3-22 defines the standard BNF symbols:

����� �'����	�
 #&�� �# ��� �������#�

�&�� � �������

�#
 ������� �������



� 	� ������� 
�

� ��������� 
�

�# ������ ��� ������� �� ��������

�#� 
�����
�� �
� �� �������

�"�!� �������� ���������� �
 �� ����
���

�#� �������

��#�"�!$� �


 ����� ��� �%�"&
�$"%�$%"�

	���%#'��%" 
 "�
������$� �
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���


This section describes the remote command set used in the MTX100. The

commands for the MTX100 are divided into the following six groups:

� Common commands

� DISPLAY commands

� MASS MEMORY commands

� PLAY commands

� RECORD commands

� SYSTEM commands

This section also contains the optional commands used to control the optional

interface cards.

The MTX100 can be controlled remotely through the 100/10 BASE-T port on

the rear panel. Refer to Connecting to a Network on page 3-63 for detailed

information about how to connect and set up for remote operation.
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��

�� ��

��
�

The Common commands have a “*” prefix and address of all the instruments

that support IEEE 488.2.

����

�	�	���

�	���

���
�

���
�

�������

�����

����

���	���

�����

���


�����

����

����

Clears SESR (Standard Event Status Register), the SBR (Status Byte

Register), and Event Queue, which are used in the instrument status

and event reporting system.

�	�	

Sets the bits of the ESER (Event Status Enable Register) used in the

status and events reporting system.

�	�	�

Returns the contents of the ESER.

�	���

Returns the contents of SESR (Standard Event Status Register) used

in the status and events reporting system.

���
�

Returns the ID information of the instrument. The ID information

contains manufacturer, model, firmware version, hardware version,

and FPGA code version.

��

��
 ����

��

��
 ���	�������
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�	

�

Returns the current instrument settings.

����

Causes bit 0 in the SESR (Standard Event Status Register) to be set,

and the operation complete message to be issued, when all pending

operations are finished. This command is only available just after the

:PLAY:STARt or :RECord:STARt command is executed.

�����

Waits until all pending operations are finished and returns a “1 ”

ASCII character. This query is only available just after the

:PLAY:STARt or :RECord:STARt command is executed.

�����

Lists the installed interface option.

�
��

Resets the instrument to the factory default state. This command has

the same effect when the :SYSTem:PRESet and *CLS commands

are executed successively.

��
�

Sets the bits of the SRER (Service Request Enable Register).

��
��

Returns the contents of SRER.

�����

Returns the value of the SBR (Status Byte Register). Bit 6 of the

SBR is read as a MSS (Master Status Summary) bit.

��
�

Generates a trigger event.

�����

Performs the self test and returns its result. The MTX100 always

returns 1.

����

Wait-to-continue command. This command is not necessary since

the MTX100 handles commands sequentially.
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�	�

�� ��������

Use these commands to select a display format of the base value in the hierarchy

display.

�����!�)
���	�

�
����( �	����� "�!*�	� "�!*����!

�����!�)���	��
����( �	����� "�!*�	� "�!*����!

Sets the base value used to describe the component information in

the hierarchy display. The choices are HEXadecimal, DECimal, or

OCTal. The default value is HEXadecimal.

�����!�)���	��
����(�

Returns the current display format of the base value in the hierarchy

display.

���� ������ ��������

Use these commands to perform file related operations such as changing and

moving a directory, and loading and saving a preset.

���	�$&)
�����!$�� ��� &��($&)�%�(���
�������($&)

������� �� &��($&)�%�(��
������ �� &��($&)�%�(��

�
���
������ �%&�'�(�#�"��

�������($&) �� &��($&)�%�(��
������

������ �%&�'�(�#�"��

������� ����

������� �����������

������� ����
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���	�� #��������� ���� ��"� #���"���

Lists the files in the specified directory. The query response is as

follows:

<used _bytes>, <available_bytes>, “<file_name>, <directory_flag>,

<file_size>, <date>,<time>”...

���	�� #���
���"� #������� ���� ��"� #���"���

Changes the current directory for data files. The default value is E:.

���	�� #���
���"� #��������

Returns the current directory for data files.

���	�� #���
���"� #������ ��� ��"� #���"��

Changes the current directory for setting files.

���	�� #���
���"� #�������

Returns the current directory for setting files.

���	�� #��
�������� �� �!�"������

Loads the specified preset. This command accepts the name of a

previously saved preset. Current instrument settings are overwritten

by this command.

���	�� #���
���"� # ��� ��"� #���"��

Creates a subdirectory. The command is invalid if a directory with

the specified name already exists.

���	�� #���
�������� �� �!�"������

Saves the instrument settings with the specified preset name.

�
����� �	���
��

�
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���
 ��������

Use these commands to set parameters related to the stream output. These

include packet size, output clock rate, data output source, and PCR jitter

insertion.

	��
"
	
���2.&9 ��:���
	����-

	���&6.5
	�
�� 
06/)3,'%7&.6)�
	�
��

	�
��1 
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06/)3,'%7&.6)�
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06/)3,'%7&.6)��
06/)3,'%7&.6)�
	��
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�
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06/)3,'%7&.6)�#�
06/)3,'%7&.6)�$$$
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�:����
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�����*
�����
�����

������ �����"�*/��/����)
����
(,�# ���
/�%+$�(!��,�#+��

�	���!�
���	* ���
/�%+$�(!��,�#+��

����
'��"�*
�	
�!%� �%+$�(!��,�#+����%+$�(!��,�#+���

�%+$�(!��,�#+����%+$�(!��,�#+���
�%+$�(!��,�#+����%+$�(!��,�#+��

���	
 ����!%�#/��/��
�
���	�*� ��/���

���
�
��� ��/���
���� ��/���
���� ��/���

��
�
&� 
��	-�(�/����-�(�
��

	)&#&$&% ��/���
����
'��"�* ��/���

����������'#�. ��/���

Sets whether or not the selected stream is automatically output using

the last power-down settings when you turn the MTX100 on. You

can use 1 or 0 instead of ON or OFF. The default value is OFF.

����������'#�.�

Return the current auto play mode status.

����������"�	
��+#*����
 �%+$�(!��,�#+��

Sets the default clock rate that is automatically set when the selected

stream file is downloaded. Since the clock rate is calculated based on

the PCRs in the file, the value may be different from the original

clock rate. If this happen, you can set the appropriate value by this

command. You can set the rate from 0.001 MHz to 250.0 MHz. If

you change the value, the :PLAY:CLOCk:RATE command setting

will set to the same value. The default value is 56.61.

����������"�	
��+#*����
�

Returns the default clock rate that is automatically set when the

selected stream file was downloaded.

�����
	 �
��������
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������	��	��
���%�$���������
" �!% �#���&��%����!% �#���&��%��

Sets the default clock rate that is automatically set when the selected

stream file is downloaded using a fraction. Since the clock rate is

calculated based on the PCRs in the file, the value may be different

from the original clock rate. If this happen, you can set the appropri-

ate value by this command. The first argument represents a

numerator and the second represents a denominator. You can set both

values from 0 to 2000000000. If you change the value, the

:PLAY:CLOCk:RATE:RATIo command setting will set to the same

value. The default values are 629 for the numerator and 300 for the

denominator.

������	��	��
���%�$���������
"�

Returns the default clock rate that is automatically set when the

selected stream file is downloaded using a fraction.

������	��	������$���'�� ��(���

Sets whether or not elementary stream rate is fixed. When you set it

to ON, the elementary stream rate becomes constant regardless of the

clock rate setting. You can use 1 or 0 instead of ON or OFF.  The

default value is OFF.

������	��	��
�
���	����#$ ��(���

Sets whether or not the clock rate is automatically set when the data

file for ISDB–TSB is loaded. When you set it to ON, the clock rate is

automatically set to (2048/1701) x 27 MHz and the elementary

stream rate becomes constant regardless of the :PLAY:CLOCk:ES-

RAtefixed command setting. You can use 1 or 0 instead of ON or

OFF.  The default value is ON.

������	��	��
�
���	����#$�

Returns whether or not the clock rate is automatically set when the

data file for ISDB–TSB is loaded.

������	��	������$���'���

Returns the current elementary stream rate status.

������	��	������ �!% �#���&��%��

Sets the clock rate for the stream output. You can set the rate from

0.001 MHz to 250.0 MHz. The default value is 56.61.

������	��	�������

Returns the current clock rate for the stream output.
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����������"����������& �%)$�'!��*�#)�	��%)$�'!��*�#)�	

Sets the clock rate for the stream output using a fraction. The first

argument represents a numerator and the second represents a

denominator. You can set both values from 0 to 2000000000. The

default values are 629 for the numerator and 300 for the denomina-

tor.

����������"����������&


Returns the current clock rate for the stream output using a fraction.

����������"������� ����'%�#+������+������+����  (+�����'�##�#+
�����'!�#

Sets which clock to use as the reference for the stream output. The

choices are:

INTernal: uses the internal clock.

EXT10M: uses a 10 MHz signal on the CLK/REF IN connector.

EXT27M: uses a 27 MHz signal on the CLK/REF IN connector.

EXTIfft: uses an IFFT sample clock signal (8.126984 MHz) on the

CLK/REF IN connector.

EXTParallel: uses a clock signal on the CLK/REF IN connector as a

parallel clock.

EXTSerial: uses a clock signal on the CLK/REF IN connector as a

serial clock.

����������"�������


Returns the current reference clock for the stream output.

���������
����� � !#��%�$�	

Loads the specified stream file.

���������
�����


Returns the name of the file currently loaded.

���������� ��+���

Sets whether or not the selected stream is output using looping

method. When you set it to ON, the stream is continuously output.

The default value is ON.

����������


Returns the current output loop mode status.
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���
 ��������������
�' ��7���

Sets whether to output an ISDB-T transport stream in OFDM frames

when looped. When you set it to OFF, an ISDB-T transport stream is

looped in packets. You can use 1 or 0 instead of ON or OFF. The

default value is ON.

���
 ��������������
�'�

Returns whether to output an ISDB-T transport stream in OFDM

frames when looped.

���
 ��
��'2 ���7���7���7����1

Sets the packet size for the selected stream file. The choices are 188,

204, 208, or NONTs (Non TS). The default value is 188.

���
 ��
��'2�

Returns the current packet size setting for the selected stream file.

���
 ���������*$+ 
-3,'0*%#4$+3'��
-3,'0*%#4$+3'�

Sets the initial value of the program_clock_reference_base and

program_clock_reference_extension parameters. You can set the

program_clock_reference_base value from 0 to 8589934591 and set

the program_clock_reference_extension value from 0 to 299. The

default values are both 0.

���
 ���������*$+�

Returns the current initial value of the program_clock_refer-

ence_base and program_clock_reference_extension parameters.

���
 �������
�%30$%6 ����7���'7���$0'7���$-(+'7����'7�
�7
�
��.,7����'2!�
�����
$,/+*23&'�
!
/'0*.&�!�
/3+1'#5*&2)�"""	

Sets the PCR jitter insertion. Use the first argument to set the

waveform type used to add jitter. When NONE is selected, the jitter

insertion is disabled. Use the second to fifth arguments to set the

PID of the PCRs, the amplitude of the waveform, the period of the

waveform, and pulse width of the waveform. The pulse width is

available only when the waveform is set to PULSe. The ranges of

each argument are as follows:

  PID: 0 to 8191

  Amplitude: 0 to 135000000

  Period: 5 to 3000

  Pulse width: 1 to (period –1)
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���	��������	��*''��,�

Returns the current PCR jitter insertion settings.

���	���������	��!�")( ��-���

Sets whether to output a stream file consisting of a 192–byte packet

as a partial transport stream. When you set it to OFF, the stream is

output in Non TS format. You can use 1 or 0 instead of ON or OFF.

The default value is ON.

���	���������	��!�")(�

Returns whether to output a stream file consisting of a 192–byte

packet as a partial transport stream.

���	������� �	�-����

Sets the source for stream output. The choices are RAM (system

RAM) or DISK (hard disk). The default value is DISK.

���	������� �

Returns the current source setting for stream output.

���	������*)&*) ��-���

Sets whether the signal output from the SPI IN/OUT connector is

enabled or not. You can use 1 or 0 instead of ON or OFF. The

default value is ON.

���	������*)&*)�

Returns the current output status of the SPI IN/OUT connector.

���	������(!)!%$�����!�"�
�	
" ��-���

Sets whether to enable to set the initial start position of the selected

stream to be looped. You can use 1 or 0 instead of ON or OFF. The

default value is OFF.

���	������(!)!%$�����!�"�
�	
" �

Returns the current state of the initial start position setting.

���	������(!)!%$�����!�"�����!)!%$� �$*# '!��+�"* �

Sets the initial start position of the selected stream to be looped by

the number of packets (the number of super frames for M-TMCC

file, or the number of bytes for a Non-TS file). The setting range

depends on the :PLAY:SSPOsition[:POSition] command settings.

The default value is 0.
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��
������
 �!����	�	�������
��!�����

Returns the current initial start position of the selected stream by the

number of packets.

��
������
 �!����	�	������	�� � !�����

Sets the initial start position of the selected stream to be looped by

time (hh:mm:ss). The setting range depends on the :PLAY:SSPOsi-

tion:TIME command settings. The default value is 00:00:00.

��
������
 �!����	�	������	���

Returns the current initial start position of the selected stream by

time.

��
������
 �!������
��!���� ��"������#��"�����"������#��"��

Sets the loop start and stop positions of the selected stream to be

looped by the number of packets (the number of super frames for

M-TMCC file, or the number of bytes for a Non-TS file). Specify

the start position in the first argument and specify the stop position

in the second argument. You can set the positions from 0 to

(available maximum value of the selected stream file). The default

values are both 0.

��
������
 �!������
��!�����

Returns the current loop start and stop position settings of the

selected stream by the number of packets.

��
������
 �!�����	�� � !������� !�����

Sets the loop start and stop positions of the selected stream to be

looped by time (hh:mm:ss). Specify the start time in the first

argument and specify the stop time in the second argument. You can

set the time from 0 to (available maximum value of the selected

stream file). The default values are both 00:00:00.

��
������
 �!�����	���

Returns the current loop start and stop position settings of the

selected stream by time (hh:mm:ss).

��
������������

Returns the standard of the loaded stream file. The available

responses are MPEG, ARIB, ATSC, DVB, NONTs, MTMCc,

STMCc, or ISDBT. The MTMCc, STMCc, and ISDBT standards are

checked only when the :SYSTem:STANdard command is set to

ARIB.
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����������#

Starts outputing the selected stream. There are no arguments.

����������

Stops outputing the selected stream. There are no arguments.

��������
� �������#&�
&
�
�"

Sets the format of the PSYNC signal output from the SPI IN/OUT

connector. For TSPAcket, a single pulse signal is output at the start

point of each packet. For SF, a single pulse is output at the start

point of the SF appearing every 204x48x8 bytes. For NONTs, you

can set the output period and data width of the PSYNC signal using

the :PLAY:SYNC:PSYNc:INTerval command and

:PLAY:SYNC:PSYNc:WIDTh commands. SF is available only

when MTMCc is returned by the :PLAY:STANdard? query. The

default value is TSPAcket.

��������
��

Returns the current format setting of the PSYNC signal.

��������
�������������� 
�
	&� $��!���%��$��

Sets the status and data width of the DVALID signal when NONTs is

selected in the :PLAY:SYNC command. When you select NONE,

the DVALID signal is disabled. You can set the width from 16 bytes

to 255 bytes. This value cannot be set more than the value set by the

:PLAY:SYNC:PSYNC:INTerval command. The default value is 188.

��������
���������������

Returns the current status and data width of the DVALID signal.

��������
�����
���
��!%�� 
�
	&� $��!���%��$��

Sets the status and output period of the PSYNC signal when NONTs

is selected in the :PLAY:SYNC command. When you select NONE,

the PSYNC signal is disabled. You can set the interval from 16 bytes

to 255 bytes. This value needs to be set equal to or greater than the

value in the :PLAY:SYNC:DVALid:WIDTh command. The default

value is 188.

��������
�����
���
��!%���

Returns the current status and output period of the PSYNC signal.
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�������
�
!����#�	
�� � � $��"���%��$���� $��"���%��$���
� $��"���%��$���� $��"���%��$���
� $��"���%��$���� $��"���%��$��

Sets the initial values of the TDT, TOT, or STT when selected USER

in the :PLAY:TIMEpacket:MODE command. The arguments are

<year>, <month>, <date>, <hour>, <minute>, and <second>. You

can set the values from 1900,3,1,0,0,0 to 2038,4,22,23,59,59 for the

TDT and TOT and from 1980,1,6,0,0,0 to 2116,2,12,6,28,15 for the

STT. The default values are the current date and time.

�������
�
!����#�	
�� ��

Returns the current data and time settings of the TDT, TOT, or STT.

�������
�
!����#���	
 ��
�� ��&��&��
�

Selects the reference time used to set the initial value of the TDT,

TOT, or STT when the :PLAY:UPDAte command is set to ON. The

choices are ORIGinal, SYSTem, or USER. For ORIGinal, the

original (default) value defined in the selected stream is used. For

OS, the clock/calendar of the operating system is used. For USER,

you can set any value in the :PLAY:TIMEpacket:DEFine command.

The default value is ORIGinal.

�������
�
!����#���	
�

Returns the current reference time selection used to set the initial

value of the TDT, TOT, or STT.

��������	�#� ��&���

Sets whether to update parameters in a stream when looped.  You

can select which parameters are updated using the :PLAY:UP-

DAte:ITEM commands. You can use 1 or 0 instead of ON or OFF.

The default value is ON.

��������	�#��

Returns the current update mode status.

��������	�#��
�
���� ��&���

Sets whether to update continuity_counter values when the

:PLAY:UPDAte command is set to ON. You can use 1 or 0 instead

of ON or OFF. The default value is ON.

��������	�#��
�
�����

Returns whether to update continuity_counter values when the

:PLAY:UPDAte command is set to ON.
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����������!��
����
�� �
#���

Sets whether to update NPT values when the :PLAY:UPDAte

command is set to ON. You can use 1 or 0 instead of ON or OFF.

This command is only available when the :PLAY:UPDAte:PCR

command is set to ON and the :PLAY:UPDAte:ITEM:PCR:METH-

od command is set to SOFTware. The default value is OFF.

����������!��
����
���

Returns whether to update NPT values when the :PLAY:UPDAte

command is set to ON.

����������!��
������� �
#���

Sets whether to update PCR/PTS/DTS values when the :PLAY:UP-

DAte command is set to ON. You can use 1 or 0 instead of ON or

OFF. The default value is ON.

����������!��
��������

Returns whether to update PCR/PTS/DTS values when the

:PLAY:UPDAte command is set to ON.

����������!��
�����������	�� 	���"���#����"���

Sets the method to update PCR/PTS/DTS values. The choices are

HARDware or SOFTware. The default value is HARDware.

����������!��
�����������	���

Returns the update method for PCR/PTS/DTS values.

����������!��
�������� ������ �
#���

Sets whether to update Reed-Solomon symbols in an ISDB-T

transport stream when the :PLAY:UPDAte command is set to ON.

You can use 1 or 0 instead of ON or OFF. The default value is ON.

����������!��
�������� �������

Returns whether to update Reed-Solomon symbols in an ISDB-T

transport stream when the :PLAY:UPDAte command is set to ON.

����������!��
�����
�������! �
#���

Sets whether to update TDT/TOT/STT values when the :PLAY:UP-

DAte command is set to ON. You can use 1 or 0 instead of ON or

OFF. The default value is ON.
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�����
1%���
�����
."#)%1	

Returns whether to update TDT/TOT/STT values when the

:PLAY:UPDAte command is set to ON.

	���	� ��������

Use these commands to set parameters related to the data record. These include

input interface, record size, and trigger position.
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���
#$��	
�'�$����	�&

Starts input stream acquisition. When two or more record commands

are sent to the instrument successively, the instrument stops stream

acquisition and then starts stream acquisition for each command.

Therefore, when many commands are sent to the instrument, it takes

a long time to complete all settings. If you send the :RECord:AC-

Quire:STOP command before sending record commands and send

the :RECord:ACQuire:STARt command after sending record

commands, you can shorten the setting time.

���
#$��	
�'�$������

Stops input stream acquisition. Refer to the :RECord:AC-

Quire:STARt command description on how to use this command.

���
#$��
��
 ��	���

Returns the clock rate of the input stream in MHz.

���
#$������$"�! �
��(�	��(���

Sets whether to start input stream record using a trigger signal

applied to the TRIG IN connector. The choices are RISE, FALL, or

OFF. When you set it to RISE, the input stream record is started at

the rising edge of the applied trigger signal. When you set it to

FALL, the input stream record is started at the falling edge of the

applied trigger signal. The default value is OFF.

���
#$������$"�!�

Returns whether to start input stream record using a trigger signal

applied to the TRIG IN connector.

���
#$���	
��&�

Returns the packet size of the input stream. The available responses

are 188, 204, 208, or NONTs. When the :RECord:I1394I:PARTialts

command is set to ON, the response is 192.

���
#$�������� ��
(	�
(��
��$%�!((
����
(�����(��	���$�(����#"

Sets the interface used to capture a stream data. The choices are SPI,

ASI, UNIVersal, I1394I (IEEE1394), S310M (SMPTE310M),

STANdard (same as SPI), or OPTion (optional interface currently

installed). The default value is SPI.

�����
	 �
��������
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Returns the current interface used to capture a stream data.

��	�#$��������
�
	 ��� ��"�!��

Specifies the file name used when the input stream is saved.

��	�#$��������$��

Returns the current standard used to display the input stream. The

available responses are MPEG, ARIB, ATSC, DVB, NONTs,

MTMCc, STMCc, or ISDBT. The MTMCc, STMCc, and ISDBT

standard are checked only when the :SYSTem:STANdard command

is set to ARIB. When the RECord:I1394I PARTialts command is set

to ON, the response is P_TS.

��	�#$������%

Starts recording the input stream.

��	�#$������

Stops recording the input stream.

��	�#$��������
�
	�

Returns the current file name used when the input stream is saved.

��	�#$�����������	 �	��� �(��	�'$�%�

Sets the save mode when the input stream is saved. The choices are

NEWfile or OVERwrite. For NEWfile, a new file is created

whenever you save a stream file. The file name is the following:

The name specified by the :RECord:STORe:FILE command + # (1,

2, 3, 4...). For OVERwrite, the existing file is overwritten by the

new file with the name specified in the :RECord:STORe:FILE

command. The default value is OVERwrite.

��	�#$�����������	�

Returns the current save mode setting when the input stream is

saved.

��	�#$�������%�������$�����$��&� �� ��(�



Sets whether the instrument ignores the DVALID signal from the

selected interface when a stream data is acquired. When you set it to

ON, the instrument ignores the DVALID signal, and the stream data

is acquired according to the internal clock signal. You can use 1 or 0

instead of ON or OFF. The default value is OFF.
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����� �����
�"����
�� ��
�� ��$�����

Returns whether the instrument ignores the DVALID signal from the

selected interface when a stream data is acquired.

����� �����
�"����� ��#�� ���$��#��

Sets the file size to record the input stream in MB. You can set the

file size from 1 to free space of the system RAM or hard disk. This

setting changes the :RECord:TARGet:TIME command setting. The

default value is 50 MB.

����� �����
�"������

Returns the current file size setting to record the input stream.

����� �����
�"���
� �!" ����

Sets the recording time (hh:mm:ss) to record the input stream. The

minimum value of the setting range depends on the clock rate of the

input stream. The maximum value of the setting range depends on

the free space of the RAM or hard disk, or the clock rate of the input

stream. This setting changes the :RECord:TARGet:SIZE command

setting. The default value is 00:00:00.

����� �����
�"���
��

Returns the current recording time (hh:mm:ss) to record the input

stream.

����� �����
�"����
�� �������#�#! ��%�		

Turns Continuous Recording on or off. When you set it to ON, you

can record multiple stream files continuously on the hard disk. You

can use 1 or 0 instead of ON or OFF. The default value is OFF.

����� �����
�"����
�� �������#�#!�

Returns the current Continuous Recording state.

����� �����
�"����
�� �������#�#!���
�" ��#�� ���$��#��

Sets the number of files to stop Continuous Recording. You can set

the value from 2 to 32767. The default value is 32767.

����� �����
�"����
�� �������#�#!���
�"�

Returns the number of files to stop Continuous Recording.

����� �����
�"����
�� �����"��� ��#�� ���$��#��

Sets the trigger position used to record the input stream. You can set

the trigger position from 0% to 100%. The default value is 0%.
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�() �����!+���
�"!)����#+#('�

Returns the current trigger position setting.

��
�() �����!+����
 ���.	
��

Sets the record target used to record the input stream. The choices

are RAM or DISK (hard disk). The default value is DISK.

��
�() �����!+����
�

Returns the current record target used to record the input stream.

��
�() �����!+���
�"!)����
&#+ ��.���

Sets whether to record the input stream to the full free space in the

hard disk or RAM. You can use 1 or 0 instead of ON or OFF. The

default value is OFF.

��
�() �����!+���
�"!)����
&#+�

Returns whether to record the input stream to the full free space in

the hard disk or RAM.

�
�	�� ��������

Use these commands to set or query the system related functions.

�����!&
�����,'#��+!

�����!+
����� �',&!)#��-�%,!�
����
�� ��.��
����
�� ��.��.����.����

�
��()���
����
�����$������!� ��.���
���	
 ����.�
�() 
����#('*�
���
�!+
����� �) ��
�.��
�.����.	��
�����,*�
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������������#����"�����
�"����� ��#��!���$��#��

Sets the port number needed to remotely control the instrument over

an Ethernet network. You can set the value from 1024 to 65535.

When you change the value, the current network connection is

disconnected.

������������#����"�����
�"������

Returns the current port number setting.

������������#����"�����
�"������� ��%�	

Sets the terminator used when the MTX100 receives commands

from a controller. The choices are CR (carriage return) or LF

(linefeed). The default value is LF.

������������#����"�����
�"��������

Returns the terminator used when the MTX100 receives commands

from a controller.

������������#����"�����
�"������� ��%�	%���	%�	��

Sets the terminator used when the MTX100 sends information to a

controller. The choices are CR (carriage return) , LF (linefeed),

CRLF, or LFCR. The default value is CRLF.

������������#����"�����
�"��������

Returns the terminator used when the MTX100 sends information to

a controller.

����������� !��
�����

Returns an error message from the error/event queue. The response

format is as follows:

<error_code>,“<error_message>”

Refer to Error Messages and Codes on page 3-111 for detailed

information.

��������
������������ �
%�		

Locks or unlocks the front-panel buttons and mouse operation. You

can use 1 or 0 instead of ON or OFF. The default value is OFF.

��������
�������������

Returns the current status of lock function.

�
����� �	���
��

�
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������������ ���� ������

Sets the operation mode of the instrument. The choices are PLAY or

RECord. The default value is PLAY.

�������������

Returns the current operation mode of the instrument.

����������������

Returns the option number, hardware version, and code version of

the installed interface card.

��������������

Resets the instrument to the factory default settings.

�����������
���� ���	 ��
� ���� ���

Sets the standard used to display the input stream. The choices are

MPEG, ARIB, ATSC, or DVB. The default value is ARIB.

�����������
�����

Returns the current standard used to display the input stream.

���������������

Returns the current operation status of the instrument. The available

responses are:

0: the instrument stops any operations

1: the instrument is outputing a data

2: the instrument is acquiring a data

3: the instrument is recording a data
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������
� ����
���

This subsection describes the commands used to control the optional interface

cards. These commands are available only when the appropriate interface card is

installed into the MTX100.

��������
����
�� �����������

Sets the output format of the ASI signal. The choices are BYTE or

PACKet. For BYTE, valid data is output using a burst transmission

mode. For PACKet, valid data is output in each transport stream

packet. The default value is PACKet.

��������
����
���

Returns the current output format setting of the ASI signal.

��������
��	�������� ������

Sets the throughout mode; whether the signal applied to the ASI IN

connector is output from the ASI OUT connector when a stream is

not output. You can use 1 or 0 instead of ON or OFF. This setting

changes the :RECord:ASI:THROughout command setting. The

default value is ON.

��������
��	���������

Returns the current throughout mode status when a stream is not

output.

����������
��	�������� ������

Sets the throughout mode; whether the signal applied to the ASI IN

connector is output from the ASI OUT connector. You can use 1 or 0

instead of ON or OFF. This setting changes the

:PLAY:ASI:THROughout command setting. The default value is

ON.

����������
��	���������

Returns the current throughout mode status.

������ �� �	� ���
��
�
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Sets the output clock edge of the universal parallel/serial interface.

The choices are RISE (rising edge) or FALL (falling edge). The

default value is RISE.

��
�����	��������

���

Returns the current output clock edge setting of the universal

parallel/serial interface.

��
�����	��������
���� ���������������

Sets the output format of the universal parallel/serial interface. The

choices are PARallel or SERial. The default value is PARallel.

��
�����	��������
�����

Returns the current output format setting of the universal parallel/

serial interface.

��
�����	�������
���� ��
���
�
���

Sets the output level of the universal parallel/serial interface. The

choices are ECL, TTL, or LVDS. The default value is ECL.

��
�����	�������
�����

Returns the current output level setting of the universal parallel/

serial interface.

����������	��������

�� �	�����



Sets the input clock edge of the universal parallel/serial interface.

The choices are RISE (rising edge) or FALL (falling edge). This

setting changes the :PLAY:UNIVersal:CLOCk command setting.

The default value is RISE.

����������	��������

���

Returns the current input clock edge setting of the universal

parallel/serial interface.

����������	��������
���� ���������������

Sets the input format of the universal parallel/serial interface. The

choices are PARallel or SERial. This setting changes the

:PLAY:UNIVersal:FORMat command setting. If the :RECord:UNI-

Versal:TERMination command is set to OFF, you cannot set the

format to SERial. The default value is PARallel.

������ �� ���������
	��������
����� �������
�
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����������	��������
�����

Returns the current input format setting of the universal parallel/seri-

al interface.

����������	�������
���� ��
!��
!
���

Sets the input level of the universal parallel/serial interface. The

choices are ECL, TTL, or LVDS. This setting changes the

:PLAY:UNIVersal:LEVEL command setting. If the :RECord:UNI-

Versal:RECEive command is set to SINGleend, you cannot set the

level to LVDS. The default value is ECL.

����������	�������
���
�

Returns the current input level setting of the universal parallel/serial

interface.

����������	������������ 
�!
��

Sets whether or not the PSYNC signal is used for serial input. When

you set it to ON, the MSB is determined from the PSYNC signal.

When you set it to OFF, the MSB is determined from the bit pattern

of the sync byte. You can use 1 or 0 instead of ON or OFF. The

default value is ON.

����������	�������������

Returns whether or not the PSYNC signal is used for serial input.

����������	������������ � �	�������!�	����������

Sets the input type for the parallel interface mode. The choices are

SINGleend (single end) and DIFFerential. If the :RECord:UNIVer-

sal:LEVEl command is set to LVDS, or the :RECord:UNIVer-

sal:TERMination command is set to OFF, you cannot set the input

type to SINGleend. The default value is SINGleend.

����������	������������ ��

Returns the current input type setting for the parallel interface mode.

����������	������������������ 
�!
��

Turns on or off the internal termination of the universal parallel/seri-

al interface. You can use 1 or 0 instead of ON or OFF. If the

:RECord:UNIVersal:FORMat command is set to SERial, or the

:RECord:UNIVersal:RECEive command is set to SINGleend, you

cannot set the internal termination to OFF. The default value is ON.
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Returns the current internal termination setting of the universal

parallel/serial interface.

������������ �) �%*$ '"��+�#* 	���%*$ '"��+�#* 	�

Starts the connection between the MTX100 Option 05 and an

IEEE1394 device(s). Specify the node ID of the device(s) in the

argument(s). Refer to the :I1394I:NODE:Catalog command. When

the :I1394I:MODE command is set to PTOP, specify the destination

device. When the :I1394I:MODE command is set to PRObe, specify

the source and destination devices.

������������ �)


Returns the node ID of the IEEE1394 device(s) currently connected

to the MTX100 Option 05.

��������
���&%% �)

Disconnects the IEEE1394 device(s) connected to the MTX100

Option 05.

����������
� ����,���� 

Sets the connection mode when using the IEEE1394 interface. The

choices are PTOP (point to point connection) or PRObe (data

probing). The default value is PTOP.

����������
�


Returns the current connection mode when using the IEEE1394

interface.

����������
������#&!


Lists all the node connected to the IEEE1394 interface. The response

format is as follows:

“node ID, vender ID, serial number, vender name, device name”

����������
���



Returns the node information of the MTX100 Option 05. The

response format is as follows:

“node ID, vender ID, serial number, vender name, device name”

The node ID is always 0.

������ �� �


�����	
�
���������
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�
����
�����$"�

Returns the current connection status to an IEEE1394 device. The

available responses are:

0: an IEEE1394 device is not connected

1: an IEEE1394 device is connected

�
����
�������! ��%���

Sets whether the connection setting is made by the IEEE1394 device

in connecting the MTX100 Option 05 to an IEEE1394 device. You

can use 1 or 0 instead of ON or OFF. The default value is OFF.

�
����
�������!�

Returns whether the connection setting is made by the IEEE1394

device in connecting the MTX100 Option 05 to an IEEE1394

device.

��������
������# 	���%��
��#

Sets the output format of the ASI signal. The choices are BYTE or

PACKet. For BYTE, valid data is output using a burst transmission

mode. For PACKet, valid data is output in each transport stream

packet. The default value is PACKet.

��������
������#�

Returns the current output format setting of the ASI signal.

���
�!��
����
�
���# �!# ��
%
����


Sets the connector used to capture a stream. The choices are ASI or

I1394I (IEEE1394). The default value is I1394I.

���
�!��
����
�
���# �!#�

Returns the current input connector.

���
�!��
����
��������#" ��%���

Sets whether or not the input transport stream is recorded in the

partial transport stream format. You can use 1 or 0 instead of ON or

OFF. The default value is ON.

���
�!��
����
��������#"�

Returns whether or not the input transport stream is recorded in the

partial transport stream format.
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���������������� ���
���	
��

Sets the output format of the ASI signal. The choices are BYTE or

PACKet. For BYTE, valid data is output using a burst transmission

mode. For PACKet, valid data is output in each transport stream

packet. The default value is PACKet.

�����������������

Returns the current output format setting of the ASI signal.

���������������� ���������

Selects which signal to output from the OUTPUT connector. The

choices are ASI or S310M (SMPTE310M). The default value is

S310M.

�����������������

Returns the current output signal selection.

������������

Returns the current output data rate setting for the SMPTE310M

signal.

��
	�������������� ���������

Selects the input signal expected from the INPUT connector. The

choices are ASI or S310M (SMPTE310M). The default value is

S310M.

��
	���������������

Returns the current input signal selection.

������ ��


������
��
	 	��������
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Table 3-23 lists the default settings of the remote commands.

These default settings can be set by using the *RST command, except for

the:SYSTem:COMMunicate:SOCKet command settings.

����� �!����	��� �� ���������


����� 	��� �� ��������

	��
������������

��� �1);�#��$�����)8 ��%)+,*/2)1


������������

����&��"!�51); ���<���

����&�����0����)918���!� ��

	�����	

����&�����0����)918���!����!�4 

�����

����&�����0�� ��8,-/:,+ ���<���

����&�����0�� ��!����#,68 ��<�	�

����&�����0���!� ��

	�����	

����&�����0���!����!�4 �� �

����&�����0� �"�*, ��!,63)1

����&����� ��<�	�

����&������� ��!�����, ��<�	�

����&�����,8 	��

����&���������*96)*; ����

����&��������!/)1 �� �

����&� 	�
�����!/)187 ��<�	�

����&� �"�*, �� �

����&� ���98598 ��<�	�

����&�  ��7/8/43����!/)1�����1, ��<�	�

����&�  ��7/8/43����!/)1'��� /8/43( �

����&�  ��7/8/43����!/)1�!��� ����������

����&�  ��7/8/43'��� /8/43( �� �

����&�  ��7/8/43�!��� ���������������������

����&� &�� ! ��*0,8

����&� &����#��/+�$��!. ����
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����� �&��
�����%�$ #�$$���#��� �$��

�����" ����%�$ ��$$���#

����$��$�����$�)��� +59(0 ����

����$� ���4()/+7����.2+ �855+27;*(7(;(2*;7.1+

����$� ���4()/+7����� ����.2(0

����$�!���7+ ��;���

����$�� ����� ��;���

����$�� ����� ���;���

����$�� ������ ��;���

����$�� ��������� �3* ����:(5+

����$�� �������6303132 ��;���

����$�� ��� ���4()/+7 ��;���

�
������ �����#

����35*��# +52(0 ���;���

����35*���!�)+ ���

����35*�� ��+����� �"��:5.7+

����35*� ���+7�����5+*9(0.* ���;���

����35*� ���+7���%� 
�;&��'

����35*� ���+7� ��� ����������

����35*� ���+7� ���,+5���� .28386 ���;���

����35*� ���+7� ���,+5���� .28386����.7 �����

����35*� ���+7� ���,+5����.7.32 �;&�'

����35*� ���+7� $�� ����

����35*� ���+7�!���1.7 ���;���

����
��� �����#

��$� +1�����82.)(7+�����+7���� 	
�
�

��$� +1�����82.)(7+�����+7��# ��� ��

��$� +1�����82.)(7+�����+7� # ��� ����

��$� +1�����/&�� � +' ���;���

��$� +1����� ���$

��$� +1�� ��*(5* ����

�!$� ����� �����#

�����
 �� ��� �
�
���	


����$���������(7 ����+7

����$����� ���8,-387 ��;���
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����� ����
�������� ����������������


����� ������� ��������

���
')��	�������,!"',+ ��.���

������ �� ��� ����� ��������������� 
��������

���	������ )*�%�
��
$ ����

���	������ )*�%�
����+ �	��%% %

���	������ )*�%�����% �
�

���	������ )*�%���
�'�$ �

���
')������ )*�%�
��
$ ����

���
')������ )*�%�
����+ �	��%% %

���
')������ )*�%�����% �
�

���
')������ )*�%������ ��.���

���
')������ )*�%���
�#- ����%  &�

���
')������ )*�%�����#&�+#'& ��.���

������ �� 
�����
����
 
��������

������������ ����

������������& ) �

.���

���	��	���
����+ �	
� +

���
')�������������+(')+ ������

���
')����������	��#�%+* ��.���

������ �	 ������������
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����+ �	
� +
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This section lists the error messages and codes.

Error messages and codes can be obtained by using the quary :SYSTem:ER-

Ror[:NEXT]?. These are returned in the following format:

�	

�
����	����	

�
��	���
	��

������� ������

Command errors are returned when there is a syntax error in the command.


���� ������������� �������

����� 
��� ����� �������

���� ������� �����

���� ������� ���������

���� �"���! �����

���� ������� ���������

���� ���� �"�� �����

���� ��
 ��� ���� ��

���	 ��������� ��� ���� ��

���
 ������� ���������

���� ������� ������ �����

���� ������ ��������� �����

���� ������� �������� ��� ����

���� ��������� ������

���� ������ �����! ��� �� �����

���� ������� ���� �����

���� ������� ��������� �� �������

���� �!������ ��� �����

���� ��� ���" ������

���	 ������� ���� ��� ���� ��

���� �����! �����

���� ������� �����!

���� �����! ��� ����
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���� ����
�������� ��������������

����� ���� ����� �������

���� �!���$ �� ����#��

���� ������ �� �� � �����

���� ��"���� ������ �� �� �

���� ������ �� �� �  �� ����

���� ������ �� �� � �� ����#��

���� � ���� �� � �����

���� ��"���� � ���� �� �

���� � ���� �� � �� ����#��

��	� ����� �� � �����

��	� ��"���� ����� �� �

��	� ����� �� � �� ����#��

��
� ������� �$�������� �����

��
� ��"���� �$��������

��
� �$�������� �� � �� ����#��

���� ����� �����

���� ��"���� �! ���� ����� ������ ���

���� ��"����� ������ ����� ������ ���

���� ����� ������ �� �����

��������� ������

These error codes are returned when an error is detected while a command is

being executed.


���� ���	
���������� �������

����� ���� ����� �������

���� �$��! ��� �����

���� ��"���� #���� �� �����

���� ��  ���� ��� �!�  � 
��

����  ������ �����

����  ������ �������

���� ��� �������
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�
��� ����	���������� ��������
�����

����� ���� ����� ����
��

���� ��� �������

����  ������ ��������

���� ��� ��������

���� ������ �� �����

���� ��  ���� ������� 

���� �� � �! �� �����

����  �� �!�� �� �

���� ������� ������ �� "��!�

���� �! �� �����%

���	 ��� � �� ���� ���� �

���� �� � ����!� �� � ���

���� �� � �!�� �������

���� ����#��� �����

���� ����#��� �������

���� ���� � ����� �����

���� ������� ���� � �����

���� ������� �����

���� ����!� �����

���� ����� �!��

���� ����� ��% �!��

���	 ����
��� �� ��!��

���
 ����
��� �����

���� ����� ��� �� ��

��	� �$��! ��� �$�������� �����

��	� �� � ����� �� �$��������

��
� �$��! ��� ����� �����

��
� ����� �%� �$ �����

��
� ����� �$��! ��� �����

��
� ������� ����� �����

��
� �$��! ��� ����� ������ �� �����

��
� ����� ������ ���  �� ����

��
	 ����� ���!����� �����

��

 ����� �������� ��� �� ����#��

www.valuetronics.com



Error Messages and Codes

�$��� MTX100 MPEG Recorder & Player User Manual

����� �$�	���#��! ��� ����������� ��

����� ���� ����� �������

���� ����� ������ ��! ��"��

���� ������� �����

���� �����! ����!� �������

���� ������� ������� ����

���� ������� #������� ����

���� ������� �"����!�& �"�����

���	 �������  &�!�% �����

���
 ������� �"�!��� �����


�"��� �������� ������

These error codes are returned when an internal instrument error is detected. This

type of error may indicate a hardware problem.

����� �$�
��
�"��� �������� �������

����� ���� ����� �������

���� ��#���  ������� �����

����  & !�� �����

���� �����& �����

���� ��
 �����& �� !

���� �������!��� �����& �� !

����  �#������� �����& �� !

���	 ������"��!��� �����& �� !

����  ��� !� ! ������

��	� �"�"� �#�����$
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	���� ������

These error codes are returned in response to an unanswered query.


���� ������	���� �������

����� 
��� ����� �������

���� ����� �����

���� ����� 
���������


���� ����� ������
����


���� ����� 
��
��	��


���� ����� ������
����
 ����� 
�
��
�
�� ���
�
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�������������

The MTX100 supports remote control using the Ethernet interface. This section

describes the MTX100 network interface specifications.

The TCP/IP is used as the network protocol. The commands can be sent from the

application program through the socket interface of the TCP/IP. Also, the query

can be received through the interface.

Keep the following in mind while controlling the MTX100 remotely with the

Ethernet interface.

� The LF (linefeed) or CR (carriage return) code is needed at the end of a

message as a terminator. Use the Communication dialog box (see Figure 3-9

on page 3-22) or the :SYSTem:COMMunicate:SOCKet:RXTERM command

to set which terminator is used.

� The IEEE 488.1 standard (for instance Device Clear, Service Request, etc.)

is not supported.

� The Message Exchange Control Protocol in the IEEE 488.2 is not supported.

However, the common commands such as *ESE and the event handling

features are supported.

� The Indefinite format (the block start at #0) in the <ARBITRARY BLOCK

PROGRAM DATA> of the IEEE 488.2 is not supported.

�������� 	����� ������
 ���������

To check remote command operation of the MTX100 perform the following

procedure:

1. Connect the MTX100 to your PC using an Ethernet cable. Refer to Connect-

ing to a Network on page 3-63 for detailed information about how to connect

the MTX100 to your PC.

2. Click Windows Start button and select Run from the start menu.

3. In the dialog box, type telnet and then click OK.

The TELNET window appears.

4. Select Preferences from the Terminal pull-down menu.

5. In the Preferences dialog box, check the Local Echo check box and then

click OK.
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6. Select Remote System from the Connect pull-down menu.

The Connect dialog box appears.

7. In the Host Name field, enter the IP address of the MTX100.

8. In the Port field, enter the port number set by the Communication dialog

box or the :SYSTem:COMMunicate:SOCKet:PORT command (the default

value is 49152).

9. Click Connection.

10. Type *IDN? in the command line and press the Enter key.

11. Check that the ID information of the MTX100 appears on the PC.
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The IEEE1394 interface of the MTX100 Option 05 allows you to send and

receive a transport stream from an IEEE1394 devices, and to capture a transport

stream transmitting between two IEEE1394 devices using the following three

modes:

� Point-to-point connection

� Data probing

� ASI/IEEE1394 input/output conversion

This section explains how to connect the MTX100 Option 05 and an IEEE1394

device(s), and how to set up the MTX100 Option 05 when using these modes.

This section assumes that a key board and mouse are connected to the MTX100

Option 05.

Refer to Using the Menu beginning on page 3-3 for detailed information about

menus and dialog boxes related to the IEEE1394 interface settings.

����. The MTX100 Option 05 does not support the copy protection feature by

DTCP (Digital Transmission Control Protection). Therefore, you cannot record

or play copy-guarded data using the IEEE1394 interface.


��� ��� 
����������

When you connect the MTX100 Option 05 to an IEEE1394 device(s) such as a

BS/CS tuner or a D-VHS recorder, note the following:

��	����� To prevent possible damage to the MTX100 Option 05, do not use a

damaged IEEE1394 cable for connection.

� Connect an IEEE1394 cable to the MTX100 Option 05 after power on. 

If you power on the instrument with the IEEE1394 cable connected, it takes

about 10 to 30 seconds for the instrument to enable the menu operation.

� Power on the MTX100 Option 05 first, and then power on an IEEE1394

device(s).
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� The MTX100 Option 05 does not function as a repeater with the instrument

powered off. If you make the following connections when the MTX100

Option 05 is powered off, the connection between a BS/CS tuner and a

D-VHS recorder is not established.

	��
�  !��� ������ �� ��� �� �#�
�"��������

� If you disconnect the power cord from the IEEE1394 device with an

IEEE1394 cable connected, the device information displayed on the

MTX100 Option 05 may become incorrect.

�����"��"����� ����������

In the point-to-point connection, you can connect the MTX100 Option 05 to an

IEEE1394 device such as a BS/CS tuner or a D-VHS recorder, and send and

receive a transport stream from the device (see Figure 3-34).

������ �� ��� ��

�#�
� ��������

�������� �����


�� �� �"�������������� �!����� ��� �����"��"����� ����������

This subsection describes the setting procedure to use the point-to-point

connection of the MTX100 Option 05. In the following procedure, you will

connect the MTX100 Option 05 to a D-VHS recorder.

1. Use an IEEE1394 cable to connect the IEEE1394 connector on the MTX100

Option 05 and IEEE1394 connector on the D-VHS recorder.

2. In the device connection menu of the D-VHS recorder, select the MTX100

Option 05. Refer to the instruction manual attached with the D-VHS recorder

for the device connection menu.

3. Press the PLAY button on the MTX100 Option 05 to display the Play

screen.

4. Select PtoP Connect from 1394 Mode command in the ASI/1394 menu, or

click PtoP Connect button on the toolbar. The IEEE1394 dialog box

appears.

������� � ���������
������ �� ��� 	"���


�������
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5. Select the D-VHS recorder from the Instrument list box, and then click the

Connect button. If necessary, check the to Tuner check box.

If the connected IEEE1394 device can operate the other device remotely,

check the to Tuner check box since the connection setting may be made by

the IEEE1394 device (the MTX100 Option 05 cannot be operated remotely

from the device).

6. Click the OK button.

7. Select the Open command from the File menu to open the Select File dialog

box.

����. Some devices may require the SI information such as SIT or NIT when

decoding the TS file.

8. In the dialog box, select the transport stream file you want to output.

9. Press the PLAY button on the MTX100 Option 05 to output the transport

stream.

10. If you want to record the transport stream, press the Record button on the

D-VHS recorder.

1. Use an IEEE1394 cable to connect the IEEE1394 connector on the MTX100

Option 05 and the IEEE1394 connector on the D-VHS recorder.

2. In the device connection menu of the D-VHS recorder, select the MTX100

Option 05. Refer to the instruction manual attached with the D-VHS recorder

for the device connection menu.

3. Press the REC button on the MTX100 Option 05 to display the Record

screen.

4. Select ASI/1394 from the Source command in the Record menu.

5. Select 1394 from the Input Port command in the ASI/1394 menu.

6. Select PtoP Connect from 1394 Mode command in the ASI/1394 menu, or

click PtoP Connect button on the toolbar. The IEEE1394 dialog box

appears.

7. Select the D-VHS recorder from the Instrument list box, and then click the

Connect button.

8. Click the OK button.
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9. Press the Play button on the D-VHS recorder to start playing a transport

stream. The hierarchy view of the captured transport stream is displayed on

the screen of the MTX100 Option 05.

��������� ��� ��������� 
������

10. If the transport stream being captured is in the partial transport stream

format, select On from the Partial TS command in the ASI/1394 menu.

����. Be sure to set the Partial TS command to On when you record a partial

transport stream. If doing not so, the packet interval does not reproduce

correctly while outputing the file. Refer to About the Partial Transport Stream on

page 3-126 for detailed information about the partial transport stream.

11. Press the REC button on the MTX100 Option 05 to start recording the

transport stream.

	��� �������

In the data probing, when the connection between two IEEE1394 devices is

established, you can capture the transport stream transmitting between them

using the MTX100 Option 05.

������ �� ��� ��

�"�
� ��������
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This subsection describes the setting procedure to use the data probing of the

MTX100 Option 05. In the following procedure, you will connect the MTX100

Option 05 to a BS/CS tuner and connect a BS/CS tuner to a D-VHS recorder.

1. Use an IEEE1394 cable to connect the IEEE1394 connector on the MTX100

Option 05 and the IEEE1394 connector on the BS/CS tuner.

2. Use an IEEE1394 cable to connect the IEEE1394 connector on the BS/CS

tuner and IEEE1394 connector on the D-VHS recorder.
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3. In the device connection menu of the BS/CS tuner, select the D-VHS

recorder. Refer to the instruction manual attached with the BS/CS tuner for

the device connection menu.

4. Press the Play button on the D-VHS recorder, and then check that a picture is

played by the BS/CS tuner.

5. Press the REC button on the MTX100 Option 05 to display the Record

screen.

6. Select ASI/1394 from the Source command in the Record menu.

7. Select 1394 from the Input Port command in the ASI/1394 menu.

8. Select Probe from 1394 Mode command in the ASI/1394 menu, or click

Probe button on the toolbar. The IEEE1394 dialog box appears.

9. Select the D-VHS recorder from the Source list box.

10. Select the BS/CS tuner from the Destination list box.

11. Click the OK button.

12. The hierarchy view of the captured transport stream is displayed on the

screen of the MTX100 Option 05.

�����


���� 	���
�����

In the ASI/IEEE1394 conversion, you can output a transport stream applied to

the ASI IN connector from the IEEE1394 connector or output a transport stream

applied to the IEEE1394 connector from the ASI connector.

Perform the following procedure to output a transport stream applied to the ASI

connector from the IEEE1394 connector:

In the following procedure, you will apply a transport stream output from an

MPEG generator to the MTX100 Option 05, and apply the transport stream

output from the MTX100 Option 05 to a D-VHS recorder (see Figure 3-36).
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	���
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1. Use a 75 � BNC cable to connect ASI OUT connector on the MPEG

generator to the ASI IN connector on the MTX100 Option 05.

2. Use an IEEE1394 cable to connect the IEEE1394 connector on the MTX100

Option 05 to the IEEE1394 connector on the D-VHS recorder.

3. In the device connection menu of the D-VHS recorder, select the MTX100

Option 05. Refer to the instruction manual attached with the D-VHS recorder

for the device connection menu.

4. Press the REC button on the MTX100 Option 05 to display the Record

screen.

5. Select ASI from the Input Port command in the ASI/1394 menu.

6. Select PtoP Connect from 1394 Mode command in the ASI/1394 menu, or

click PtoP Connect button on the toolbar. The IEEE1394 dialog box

appears.

7. Select the D-VHS recorder from the Instrument list box, and then click the

Connect button. If necessary, check the to Tuner check box.

8. Click the OK button.

Perform the following procedure to output a transport stream applied to the

IEEE1394 connector from the ASI OUT connector:

In the following procedure, you will apply a transport stream output from a

BS/CS tuner to the MTX100 Option 05, and apply the transport stream output

from the MTX100 Option 05 to an MPEG analyzer (see Figure 3-37).
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1. Use an IEEE1394 cable to connect the IEEE1394 connector on the BS/CS

tuner to the IEEE1394 connector on the MTX100 Option 05.

2. Use a 75 � BNC cable to connect ASI OUT connector on the MTX100

Option 05 to the ASI IN connector on the MPEG analyzer.

3. In the device connection menu of the BS/CS tuner, select the MTX100

Option 05. Refer to the instruction manual attached with the BS/CS tuner for

the device connection menu.

4. Press the REC button on the MTX100 Option 05 to display the Record

screen.

5. Select ASI from the Input Port command in the ASI/1394 menu.

6. Select PtoP Connect from 1394 Mode command in the ASI/1394 menu, or

click PtoP Connect button on the toolbar. the IEEE1394 dialog box appears.

7. Select the BS/CS tuner from the Instrument list box, and then click the

Connect button.

8. Click the OK button.
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The partial transport stream is a bit stream used for data transmission in

IEEE1394 interface. Unlike the MPEG-2 transport stream, the partial transport

stream has a time code of 4 bytes after each transport stream packet of 188 bytes

(see Figure 3-38). The time code provides the interval between the sync byte of a

packet and the sync byte of the next packet in 27 MHz resolution.
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In the MTX100 Option 05, a captured transport stream can be recorded as a

partial transport stream by setting the Partial TS command in the ASI/1394 menu

to On.

The packet size of the recorded file in the partial transport stream format is fixed

in 192 bytes. When you open the file, the Partial TS letters are displayed in the

status bar.

The following are notes for recording or playing a partial transport stream:

� Be sure to record a partial transport stream using the partial transport stream

format. Doing not so, the packet interval is not reproduced when the

transport stream is played.

� The partial transport stream with any packet interval more than 600 ms

cannot be recorded correctly as a partial transport stream.

� A transport stream is not output from the SPI connector while a partial

transport stream is played.
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Tables A-1 through A-8 list the functional, electrical, mechanical, and environ-

mental characteristics of the MTX100. Table A-9 lists the national and interna-

tional standards to which the MTX100 complies.

All listed specifications are guaranteed unless labeled with “typical”. Typical

specifications are provided for your convenience but are not guaranteed.

���������
� ����������

The electrical characteristics listed on the following pages are valid under the

following conditions:

� The MTX100 must be in an environment where the temperature, altitude,

humidity, and vibration conditions are within the operating limits described

in Table A-8 on page A-13.

� The MTX100 must have a warm-up period of at least 20 minutes.

� The MTX100 must be operating at an ambient temperature between

+5� C to +40� C, unless otherwise noted.
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ReMux provides the capability to create a transport stream of super frame

structure defined in the ISDB-S system from an MPEG2 transport stream.

This appendix describes the functions of the ReMux application and how to

create a transport stream of super frame structure.

����. The ReMux application cannot handle files larger than 2 GB.

	������� ��
 ������� �����

To start the ReMux application, select Tektronix � MPEG � ReMux from the

Start –Programs menu on the Windows desktop.

If you create the shortcut icon of the Remux application on the Windows

desktop, you can start the ReMux application by double-clicking it. Refer to the

Windows help how to create a shortcut icon.

To exit (quit) the ReMux application, select Exit from the File menu command

list of the application.
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Figure B-1 shows the ReMux application window. Table B-1 provides a

description of the elements in the application window.
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The Menu bar displays the name of the six pull-down menus: File, Edit, View,

ReMux, Window, and Help. This section describes the function of each selection

in these menus.

The File menu contains commands for managing file operations and for exiting

the ReMux application. Table B-3 describes each of the File menu commands.
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����� ���� ���� 	����� �� �  The Select Remux Mode dialog box (see Figure

B-2 ) appears after you select the New command in the File menu. Select one of

the ReMux modes, then click the OK button. Table B-4 describes the Select

Remux Mode dialog box parameters.
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The Edit menu contains commands that control TMCC information display and

add/delete TMCC information and transport stream. Table B-5 describes each of

the Edit menu commands.
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The ReMux menu contains commands that execute the selected operation, select

a ReMux mode, and select option settings. Table B-6 describes each of the

ReMux menu commands.
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 	����� ��$�  The OPTION dialog box (see Figure B-3) appears after you

select the Option command in the ReMux menu. Table B-7 describes the Select

Remux Mode dialog box parameters.
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The Window menu contains commands that control the appearance of the editing

windows and open the new window. Table B-8 describes each of the Window

menu commands.
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The View menu contains commands that control the appearance of the ReMux

application window. Table B-9 describes each of the View menu commands.
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The Help menu About ReMux... command displays information including the

ReMux software version number and copyright information.


�	�� ���������

This subsection describes the basics of operating the ReMux application.

This mode allows you to create a transport stream of S-TMCC structure from a

transport stream.

This subsection describes the procedure to create a transport stream of S-TMCC

structure from a transport stream.

1. Select New from the File pull-down menu or click the New button on the

toolbar to open the Select Remux Mode dialog box shown in Figure B-2 on

page B-5.

2. Select Make S-TMCC TS in the dialog box, and then click the OK button

to open the editing window for the Make S-TMCC TS mode shown in 

Figure B-4.
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The information displayed at the right side of the TMCC icon has the following

meaning:
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3. Select Add from the Edit pull-down menu or clock the + (Add) button on

the toolbar to open the Open dialog box.

4. In the dialog box, select a transport stream file, and then click the Open

button to open the Edit TS Information dialog box shown in Figure B-5.
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In this dialog box, you can set the following parameters:

� File: Specifies the transport stream file to be converted to a transport stream

file of S-TMCC structure.

� Data Rate: Specifies the data rate of the transport stream. You cannot set the

value exceeding the data rate of the effective slots. If this value is less than

the data rate of the effective slot, in addition, conversion of the data rate is

done with the insertion of null packets.

� Contract Slots: Shows the number of contract slots. This value depends on

the number of slots set in the Modulation item.

� Modulation: Specifies the modulation system and the number of slots to be

assigned to HQ and LQ when performed hierarchical data transfer.

� HQ: Specifies the modulation system and the number of slots to be

assigned to HQ level.

� LQ: Specifies the modulation system and the number of slots to be

assigned to LQ level. This field is enabled only when the hierarchical

control descriptor exists in PMT.
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� TS ID: Specifies the transport stream ID. This value is used to change the ID

value in TMCC, and the ID value in PAT is not changed.

� Initial Delay: Specifies the number of delay packets (i.e., null packets) to be

inserted at the start of re-multiplex. You can set the value in the range of 0 to

65535.

5. After you change the parameters, click the OK button to confirm the changes

and close the dialog box.

This displays a transport stream icon under the TMCC icon (See 

Figure B-6).
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The information displayed at the right side of the transport stream icon has the

following meaning:
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6. Double-click the TMCC icon to open the Edit TMCC Information dialog

box to edit the TMCC information for the transport stream (See Figure B-7).

���"�� 	$������! ��

 
������!��� ������ ��# ��$��

�

In this dialog box, you can set the following parameters:

� Transmitter/Receiver Control Information: Sets the transmission/receiv-

ing control information.

� Switch On Control Signal: Sets the start control signal to on (1) or 

off (0).

� Reserve: Sets the reserve bit.

7. After you change the parameters, click the OK button to confirm the changes

and close the dialog box.


���!��� � ���� ���! �!���� �� �$��

 �!�"�!"���

8. Select Execute in the ReMux pull-down menu or click the � (Execute)

button to open the Save As... dialog box.

9. In the dialog box, specify a file name, and then click the Save button.
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This mode allows you to create a transport stream of M-TMCC structure from a

transport stream of S-TMCC structure.

This subsection describes the procedure to create a transport stream of M-TMCC

structure from a transport stream of S-TMCC structure.

1. Select New from the File pull-down menu or click the New button on the

toolbar to open the Select Remux Mode dialog box shown in Figure B-2 on

page B-5.

2. Select ReMux to M-TMCC TS from S-TMCC TS in the dialog box, and

then click the OK button to open the editing window for the ReMux to

M-TMCC TS from S-TMCC TS mode shown in Figure B-8.
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3. Select Add from the Edit pull-down menu or click the + (Add) button on the

toolbar to open the Open dialog box.

4. In the dialog box, select a transport stream file having S-TMCC structure,

and then click the Open button to open the Edit TS Information dialog box

shown in Figure B-5 on page B-10.

����. If you select a transport stream file having no S-TMCC structure, an error

message appears.

����! �� �"���� �

���� 
"���� �
 ����
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5. In the dialog box, set the parameters, and then click the OK button. This

displays a transport stream icon in the window.

	����������� ��������� 
�������

In the ReMux to M-TMCC TS from S-TMCC TS mode, you can multiplex

transport streams of S-TMCC structure until the total number of slots reach 48.

6. Select Add from the Edit pull-down menu or click the + (Add) button on the

toolbar to open the Open dialog box.

7. In the dialog box, select a transport stream file having S-TMCC structure,

and then click the Open button to open the Edit TS Information dialog box

shown in Figure B-5 on page B-10.

8. In the dialog box, set the parameters, and then click the OK button.

This multiplexes the newly selected transport stream and the transport stream

icon is added in the window (See Figure B-9).

������ �������������� ������ �� ����������


9. If you want to multiplex more transport streams, repeat steps 6 through 8.
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10. Double-click the TMCC icon to open the Edit TMCC Information dialog

box for editing the TMCC information for the transport stream (See 

Figure B-10).

���!�� 	#������� ��
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�

In this dialog box, you can set the following parameters:

� Order of Change: Sets the TMCC change instruction. You can set the value

in the range of 0 to 31.

� Transmitter/Receiver Control Information: Sets the transmission/receiv-

ing control information.

� Switch On Control Signal: Sets the control signal on (1) or off (0).

� Up-Link Control: Controls the up-link switching.

� Extended Information: Sets the extended information. When you set the

Flag (extension flag) item to 1, the Field item becomes active.

11. After you change the parameters, click the OK button to confirm the changes

and close the dialog box.
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12. Select Execute in the ReMux pull-down menu or click the � (Execute)

button to open the Save As... dialog box.

13. In the dialog box, specify a file name, and then click the Save button.

If the number of slots of the transport stream of M-TMCC structure you are

going to create is less than 48, a dummy transport stream(s) is(are) inserted

so that the number of slots reach 48. The transport stream thus inserted has

the ID value set in the OPTION dialog box (See Figure B-3 on page B-7)

and TS8PSK is used as the modulation system.

� ������"��� ��������� 
������ �� �#���� 
�� �� �� !��� 	�������� ����
������������

In the ReMux to M-TMCC TS from S-TMCC TS mode, you can multiplex a

transport stream of M-TMCC structure with a transport stream of M-TMCC

structure having different TMCC information.

14. Click the TMCC icon of the M-TMCC stream created in step 13.

15. Select the Add command from the Edit pull-down menu or click the +

(Add) button on the toolbar to open the Add TMCC dialog box as shown in

Figure B-11.


�� �� �#������� ���� ������ ��"

In this dialog box, you can specify the transport stream to which the new TMCC

information is inserted if more than one transport stream is multiplexed.

The following illustration shows the positional relationship of TMCC informa-

tion and the transport stream to be inserted to the transport streams already

multiplexed.
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This illustration shows the positional relationship when inserted TMCC

information and the transport stream 3 after the transport stream 1 while two

transport streams have been multiplexed. The new TMCC information is

inserted two frames before the location in which the new transport stream is

inserted.

16. In the Add TMCC dialog box, select a transport stream number, and then

click the OK button to open the Edit TMCC Information dialog box for

editing the TMCC information (See Figure B-10).

17. After you change the parameters, click the OK button to confirm the changes

and close the dialog box.

This opens a new editing window with a TMCC icon displayed. In this case,

note the increase of the value indicating change instruction at the right side

of the TMCC icon. In addition, the First and Previous buttons on the

toolbar change their color to green indicating that a TMCC exists before this

TMCC.

18. Repeat steps 3 through 5 to select a transport stream file.

19. Repeat steps 6 through 8 to multiplex the transport stream file.

20. If you want to further multiplex a transport stream(s) of M-TMCC structure

having different TMCC information, repeat steps 14 through 19.
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21. Select Execute in the ReMux pull-down menu or click the � (Execute)

button to open the Save As... dialog box.

22. In the dialog box, specify a file name, and then click the Save button.

If the number of slots of the transport stream of M-TMCC structure you are

going to create is less than 48, a dummy transport stream(s) is(are) inserted

so that the number of slots reach 48. The transport stream thus inserted has

the ID value set in the OPTION dialog box (See Figure B-3 on page B-7)

and TS8PSK is used as the modulation system.

This mode allows you to create a transport stream of M-TMCC structure from a

transport stream. In this mode, two Remux functions are simultaneously

executed: the Make S-TMCC TS and the ReMux to M-TMCC TS from

S-TMCC TS mode.

This subsection describes the procedure to create a transport stream of M-TMCC

structure from a transport stream.

1. Select New from the File pull-down menu or click the New button on the

toolbar to open the Select Remux Mode dialog box shown in Figure B-2 on

page B-5.

2. Select ReMux to M-TMCC in the dialog box, and then click the OK button

to open the edit window for the ReMux to M-TMCC TS mode shown in

Figure B-12.


����� �!����	������ ������ ��� ��� ���� �� �!���� �
 ����

���� �� �!���� �

����
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3. Select Add from the Edit pull-down menu or clock the + (Add) button on

the toolbar to open the Open dialog box.

4. In the dialog box, select a transport stream file, and then click the Open

button to open the Edit TS Information dialog box shown in Figure B-5 on

page B-10.

5. In the dialog box, set the parameters, and then click the OK button. This will

display a transport stream icon in the window.

�������� ��� 
�������� ��������

6. Perform steps 6 through 9 on page B-14 to multiplex the transport streams.

������� ��� 
��� 
���������� ��� �!
����

7. Perform step 10 on page B-15 to edit the TMCC information for M-TMCC.

�������� ��� 
�������� ������� �� �!
��� ��������� ���� ��������� 
���

�����������

8. Perform steps 14 through 20 on pages B-16 and B-17 to multiplex the

transport stream of M-TMCC structure having different TMCC information.

�������� � 
�������� ������ �� �!
��� �����������

9. Perform steps 21 and 22 on page B-18 to create a transport stream of

M-TMCC structure.
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This mode allows you to de-multiplex (separate) the original transport stream

from a transport stream of M-TMCC structure. The resulting de-multiplexed

transport stream, is bit-rate converted to a packet form of 204 bytes.

This subsection describes the procedure to de-multiplex the original transport

stream from a transport stream of M-TMCC structure.

1. Select DeMux from the ReMux pull-down menu or click the DeMux

M-TMCC TS button on the toolbar to open the Open dialog box.

2. In the dialog box, select a transport stream file of M-TMCC structure, and

then click the Open button to open the editing window for the DeMux

M-TMCC TS mode shown in Figure B-13.

������ ������
������ ������ ��� ��� 	���� ������ �
 ����

����. If you select a transport stream file having no M-TMCC structure, an

error message appears.

3. Select Execute in the ReMux pull-down menu or click the � (Execute)

button to open the DEMUX dialog box shown in Figure B-14.

	���� ������ �
 ����
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In this dialog box, you can set the following parameters:

� Save to: Specifies the directory to which the de-multiplexed transport stream

is to be saved.

� TS: Selects the transport stream(s) to be de-multiplexed. Click the check box

at the front of the file name to select the file to be de-multiplexed. When you

click the ... button at the right side of the file name, the Save As... dialog box

appears, and you can specify a file name and save the file.

4. After you select the directory and transport stream(s), click the OK button.

The transport stream(s) is (are) de-multiplexed and saved to the directory.
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Scheduler is a software application that provides scheduling capability for the
MTX100. The application enables you to create a schedule list of streams for
subsequent play or record.

This appendix describes the functions of the Scheduler application and how to
create a schedule list, and play and record streams within the list.

Scheduler can be installed on a PC using the product CD-ROM. When installing
the application on a remote, networked PC, you can create a schedule list on the
remote PC and play or record streams. Refer to Installing Scheduler on a PC on
page C-24 for the installation procedure.

������	�� ��� �������� �������	��  ��

You need to attach the software protection key to the rear-panel PRINTER port
of the MTX100 before using the Scheduler application.

1. If there is a cable attached to the PRINTER port, disconnect the cable.

2. Attach the software protection key (see Figure C-1) to the PRINTER port
and tighten the retention screws.

!	���� ������������� �������	�� "��

3. If you removed a cable in step 1, reconnect it directly to the software
protection key. The key should not interfere with parallel communications.

����. To run the Scheduler application, the software protection key must be

installed on the PRINTER port. Do not remove or misplace the key.
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To start the Scheduler application on the MTX100, select File > Scheduler in
the Play or Record screen.

� In the Play screen: Starts Scheduler on the schedule play mode. This mode
allows you to create a schedule list and play streams.

� In the Record screen: Starts Scheduler on the schedule record mode. This
mode allows you to create a schedule list and record streams.

����. The Scheduler menu command appears only when the software protection

key is installed on the PRINTER port of the MTX100.

To exit (quit) the Scheduler application, select File > Exit or click the Close

button in the upper-right corner of the application window.
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Figure C-2 shows the Scheduler application window. The window contains a title
bar, a menu bar, a toolbar, a status/control panel, a schedule list, and a status bar.

����� ���

	�
� ���

�������


����� ���


������� ����


��������
���� ��
��

!	���� ��#����������� ����	���	�� �	���� ��������� ���� &����

The title bar displays the file name of the currently selected schedule list and the
name of the application. It also contains the standard window-sizing boxes for
Windows.

The menu bar displays the names of the pull-down menus. Refer to Using the

Scheduler Menus on page C-6 for detailed information about the functions
available in the menus.

(	��� )��

*��� )��
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The Toolbar provides shortcut buttons for many of the most often used menu
commands. Click a toolbar button to select the corresponding command. You can
toggle the toolbar display on and off using the Toolbar commands in the View
pull-down menu. Table C-1 describes the function of each toolbar button.
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The status/control panel appears when you select the Execute command from the
Schedule menu or click the Execute button on the toolbar. This panel allows you
to set properties for the whole schedule list, and start/stop stream playout or
record. Refer to Status/Control Panel on page C-16 for detailed information.

(���,��

������2������� �����
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Lists the streams currently included in the schedule. The schedule list is
composed of the following items:

� Schedule icon: The following icons are displayed in front of the file name:

���� ���
 ����� ���� ��� ����� ���� ��� ���
 �����%��� %�� ��� �������

���� ���
 ����� ���� � ���&&���� ����� ��� ���
 �����%��� %�� ��� �������

���� ���
 ����� ���� 
� ����� ���� �� ���&&���� ����� ��� ���
 �����%��� %�� ��� �������

These icons change depending on the Start Time option setting in the Play
Properties or Record Properties dialog box. Refer to Play Properties Dialog

Box on page C-11 and Record Properties Dialog Box on page C-15.

� Filename: Shows the file name of the stream.

� Packets: Shows the number of packets contained in the stream (For a Non
TS stream, it shows the number of bytes). This item does not appear on the
schedule record mode.

� Start time: Shows the start date/time for the stream.

� End time: Shows the end date/time for the stream.

� Duration: Shows the duration time of the stream.

Streams can be selected by clicking on the stream name. Only one stream can be
selected at a time.

When you start playing or recording streams, the background of the schedule list
changes to gray, and the stream currently being played or recorded is highlighted.

The status bar displays the short explanation of the currently selected command
and information related to the operation. You can toggle the status bar display on
and off using the Status Bar command in the View pull-down menu.

�������� 4	��

������ )��
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The Menu bar displays the names of the five pull-down menus. This section
describes the function of each selection in these menus.

The File menu contains commands for managing file operations and for exiting
the Scheduler application. Table C-2 describes each of the File menu commands.
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The View menu contains commands that control the appearance of the applica-
tion window. Table C-3 describes each of the View menu commands.
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The Schedule menu contains commands that control the remote connection to the
MTX100 and changes between the play mode and record mode. Table C-4
describes each of the Schedule menu commands.
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*(821(8 9��� .�&� 0	���� )�
: When you select the Connect command from the
Schedule menu, the MTX/RTX Host Name dialog box appears as shown in 
Figure C-3.

!	���� ��%��*(821(8 9��� .�&� �	���� ,�


� Host Name: Selects the host name of the MTX100 to which Scheduler is
connected.

�������� *���
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: When you select the Settings command from the
Schedule menu, the Scheduler Settings dialog box appears as shown in 
Figure C-4.

!	���� ��+����������� ����	��� �	���� ,�


There are three tabs in the Schedule Settings dialog box: New Schedule, Add
Stream, and Miscellaneous.

.�� �������� ��,

� Continuous Time Stamping: Specifies which parameters in the transport
stream should be modified when looping a transport stream to simulate
continuous playout. After selecting the Enabled check box, select the
appropriate parameter(s) you intend to modify. The parameters are updated
by the system hardware (27 MHz clock).

� Playout Packet Size: When you select the Auto playout packet size check
box, the default packet size displayed is derived from the first stream added
to the schedule list. However, if the first stream in the schedule list is a Non
TS stream, the packet size of subsequent streams is set to 188 bytes.

If you clear the Auto playout packet size check box, the Set button
becomes available. When you click the Set button, the Set Custom Clock
dialog box appears. In this dialog box, you can set the appropriate packet
size.
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� Default Data Rate: Sets the default bit rate.

� Packet Size: Sets the default packet size. You can select 188, 204, and
208.

� Playout Data Rate: Sets the playout bit rate for the overall schedule.

� Use automatic playout data rate: Uses the bit rate derived from the
first stream in the schedule list.

� Manually specify a playout data rate: Uses a clock source and bit rate
that you specify. When you select this option, the Clk Source list box
and the Set button become available. Use the Clk Source list box to
select a clock source for the stream playout. You can select Internal,
ExtRef 10M, ExtRef 27 M, ExtRef IFFT, Ext P Clk, or Ext S Clk. Refer
to Clock Dialog Box on page 3-7 for detailed information about each
clock source. When you click the Set button, the Set Custom Clock
dialog box appears. In this dialog box, you can set the appropriate bit
rate.

� Seamless Play: Sets whether or not the streams in the schedule list are
continuously played with no discontinuities. Normally, stream output stops
at every file, changing points if each stream has different bit rate. When it is
checked, all the streams are played using the same bit rate set by the Playout
Bitrate options.

����. You cannot play a Non TS or M-TMCC stream(s) using the Seamless Play

mode.

If you play streams that have different packet size using the Seamless Play mode,

click the Enabled check box in the Continuous Time Stamping field to deselect

the check box.

If you play streams that have different bit rate using the Seamless Play mode, the

Fixed ES Rate setting in the MTX100 does not work properly.
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� Playout Properties: Sets the default playout properties (bit rate and packet
size) to be used when a stream is added to a schedule list.

� from Schedule: Uses the settings in the dialog box.

� from Source: Uses the default bit rate and packet size derived from the
original stream.

� Custom: Uses the custom bit rate and packet size set in the tab. When
you select this option, the Set Custom Clock dialog box appears.

*	����������� ��,

� Loop Mode: Sets whether or not the schedule is run in loop mode. When it
is checked, the current schedule is restarted when it reaches the end of the
last stream.

� Local lock out: Sets whether the front-panel lockout function is enabled or
not. When it is checked, all front-panel buttons are disabled.

� Port: Sets the port number of the MTX100 to which Scheduler is connected.
The default value is 49152.

The Stream menu contains commands to add, delete, and move a stream in the
schedule list. It also contains the command to view and set the stream properties
of the currently selected stream. Table C-5 describes each of the Stream menu
commands.
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���� �������	�� 0	���� )�
: If Scheduler is set to the schedule play mode, when
you select the Properties command from the Stream menu, the Play Properties
dialog box appears as shown in Figure C-5. This dialog box allows you to
display the properties for the selected stream, and set the start/stop position and
the start time of the stream. This dialog box can be displayed by selecting
Properties from the right-click menu or by double-clicking the stream name.

!	���� ��3������ �������	�� �	���� ,�


� File: Show the name and location of the stream.

� Content: Shows the content of the stream.
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� File Size: Shows the file size of the stream in bytes.

� Standard: Shows the standard of the stream (MPEG2, ARIB, DVB,
ATSC, S-TMCC, M-TMCC, ISDB-T, or NON TS).

� Data Rate: Shows the bit rate derived from the PCRs in the stream.

� Duration: Shows the duration of the stream.

� Packet Size: Shows the packet size of the stream. For a Non TS file, a
dash is displayed.

� Total Packets: Shows the total number of the packets in the stream. For
a Non TS file, a dash is displayed.

� Start/Stop Position: Sets the start and stop positions of the stream. When
you click the Set button, the Start/Stop Position dialog box allows you to set
the start/stop position.

� Start: Sets the start position of the stream by the number of packets (the
number of super frames for a M-TMCC file, or the number of bytes for a
Non TS file).

� Stop: Sets the stop position of the stream by the number of packets (the
number of super frames for a M-TMCC file, or the number of bytes for a
Non TS file).

� Play: Shows the actual number of packets (the number of super frames
for a M-TMCC file, or the number of bytes for a Non TS file) that is
calculated by the values of the Start and Stop text boxes.
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� Format: Shows the setting unit of the start and stop positions of the
stream. It shows Packets for a transport stream file, SF (super frame) for
a M-TMCC file, and Bytes for a Non TS file.

For an ISDB-T file, the start packet is defined as the first-appearing packet
including an OFDM frame start flag after the specified start position. The
stop packet is defined as the packet at the front of the last-appearing packet
including an OFDM frame start flag before the specified stop position. At
this time, if the number of OFDM frames between the start packet and stop
packet is not an even number, the packet in the last OFDM frame becomes
the stop packet.

First, specify the format for the setting in the Format list box at the bottom
of the dialog box. Next, click the Start or Stop option button, and then set
the number of packets or time using the slider. You can directly enter the
desired values in the text boxes.

� Start Time: Specifies the time at which the stream will start to play within a
schedule. If the Seamless Play option is selected in the Schedule Settings
dialog box, this field is disabled.

NONE: The stream is integrated into the schedule and obeys the overall
timing of the schedule. It will follow on from the previous stream without a
break in the playout bit stream.

Trigger Rise: The stream playout starts on the rising edge (low to high
transition) of the trigger signal applied to the TRIG IN connector. When you
select this option, spin boxes to set date and time become available.

Trigger Fall: The stream playout starts on the falling edge (high to low
transition) of the trigger signal applied to the TRIG IN connector. When you
select this option, spin boxes to set date and time become available.

����. If the trigger does not occur within a specified time, the subsequent

stream will be played out.

TIME: The stream playout starts at an absolute starting time. When you
select this option, spin boxes to set date and time become available.

� Playout Properties: Sets the playout bit rate and packet size of the stream. If
the Seamless Play option is selected in the Schedule Settings dialog box, this
field is disabled.

from Schedule: Uses the values from the Schedule Settings dialog box (see
Figure C-4).

from Source: Uses the original bit rate and packet size of the stream.
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Custom: Uses the bit rate and packet size specified in the Play Properties
dialog box. When you select this option, the Set button becomes available.
Click the Set button, and then set the appropriate bit rate and packet size in
the resulting Set Custom Clock dialog box.

��/� �� 0	���� )�
: If Scheduler is set to the schedule record mode, when you
select the Add command from the Stream menu, the Save as dialog box appears
as shown in Figure C-6.

!	���� ��5����/� �� �	���� ,�


Use this dialog box to do the following:

1. Select the appropriate drive and directory for the stream file you are going to
record.

2. Specify a file name for the stream. You can use the default file name
automatically displayed in the File name text box. The following characters
must not be used in a file name: \  /  :  ,  ;  *  ?  ”  <  >  |

3. Click the Save button to add the stream file to a schedule list.

When you click the Save button, the Record Properties dialog box appears.
Refer to Record Properties Dialog Box on page C-15 for more information.
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1����� �������	�� 0	���� )�
: If Scheduler is set to the schedule record mode,
when you select the Add command from the Stream menu and click the Save
button on the Save as dialog box, the Record Properties dialog box appears as
shown in Figure C-7. This dialog box allows you to set the start time, recording
time, and stop time for the stream to be recorded. This dialog box can be
displayed by selecting Properties from either the right-click menu or Stream
menu or by double-clicking the stream name.

!	���� ��7��1����� �������	�� �	���� ,�


� File: Shows the directory path and file name for the stream to be recorded.

� Start Time: Specifies the time at which a stream will start to record. The
choices are:

� NONE: The stream is integrated into the schedule and obeys the overall
timing of the schedule. It will follow on from the previous stream
without a break.

� Trigger Rise: The stream record starts on the rising edge (low to high
transition) of the trigger signal applied to the TRIG IN connector. When
you select this option, spin boxes to set date and time become available.

� Trigger Fall: The stream record starts on the falling edge (high to low
transition) of the trigger signal applied to the TRIG IN connector. When
you select this option, spin boxes to set date and time become available.

����. If the trigger does not occur within a specified time, the subsequent

stream will be recorded.

� TIME: The stream record starts at an absolute starting time. When you
select this option, spin boxes to set date and time become available.
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� Recording Time: Specifies the recording time for the stream.

� Stop Time: Specifies the time at which a stream will stop recording. When
you click the down arrow (�) at the right side of the date spin box, 
a calendar allows you to set a date.

The Help menu About Scheduler command displays information including the
Scheduler software version number and copyright information.

������2������� �����

The status/control panel (see Figure C-8) appears when you select the Execute
command from the Schedule menu or click the Execute button on the toolbar.
This panel allows you to set properties for the whole schedule list, and start and
stop the stream playing and recording.

�

# % +

!	���� ��;��������2������� ����� ��������� ���� &����

9��� *���
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1. Control buttons. Controls the schedule playing and recording, and the
application window display.
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2. Stream information. Shows the file name, bit rate, and packet size of the
stream currently being played or recorded.

3. Playout or record status. Shows the following time information:

Current: Shows the current date and time.

Elapsed: Shows the elapsed time from the start of the stream currently being
played or recorded.

4. Property button. Displays the Schedule Property dialog box shown in
Figure C-9.

!	���� ��<���������� �������� �	���� ,�
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� Activate Schedule: Set the way in which the schedule activates. The setting
in this field affect the Start Time setting of a stream at the top of the schedule
list.

� Immediate: In the schedule play mode, the schedule playing starts as
soon as you click the Play button on the status/control panel. In the
schedule record mode, the schedule recording starts as soon as you click
the Record button on the status/control panel.

� Trigger Rise: The schedule playing or recording starts by the rising edge
(low to high transition) of the trigger signal applied to the TRIG IN
connector. When you select this option, spin boxes to set date and time
become available.

� Trigger Fall: The schedule playing or recording starts by the falling
edge (high to low transition) of the trigger signal applied to the TRIG IN
connector. When you select this option, spin boxes to set date and time
become available.

����. If the trigger does not occur within a specified time, the subsequent

stream will be played out or recorded.

� TIME: The schedule playing or recording starts by an absolute starting
time. When you select this option, spin boxes to set date and time
become available.

� Start Options: Sets the actual time when the schedule starts.

� Top of Schedule: The schedule playing or recording starts with the first
stream in the schedule list.

� Skip to Selection: The schedule playing or recording starts at the
currently highlighted stream. If no stream is highlighted, the schedule
will start at the top of the schedule list. This option is only available
when you select Immediate in the Active Schedule field.

� Resyncronize Start: The start time of the first stream is adjusted to
equal to the current time (the first stream must have an absolute Start
Time specified). This option is only available when you select Immedi-
ate in the Active Schedule field.

� Stop Time: Sets the way in which the schedule stops playing or recording.

� NONE: The schedule plays or records through according to the start and
stop times of the individual streams.

� Schedule: The schedule playing or recording stops at the specified date
and time but not until the current (schedule) pass is completed. When
you select this option, spin boxes to set date and time become available.
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� Stream: The schedule playing or recording stops at the specified date
and time but not until the current stream is completed. When you select
this option, spin boxes to set date and time become available.

� Absolute: The schedule playing or recording stops immediately at the
specified date and time. When you select this option, spin boxes to set
date and time become available.

��������� (����	���

This section describes the basics of operating the Scheduler application. 
The application has the following two operating modes:

� Schedule play mode

� Schedule record mode

The schedule play mode allows you to create a schedule list defined playout
properties of streams and playout up to 256 streams continuously. You can set
the start and stop positions, absolute start time, bit rate, and packet size as
playout properties for each stream.

In the schedule play mode, you can play five kinds of stream files:

� Transport stream (188/204/208) file

� S-TMCC file

� M-TMCC file

� ISDB-T file

� Non TS file

Perform the following procedure to create a schedule list and play streams:

�����	�� � �������� 4	��

1. Select Schedule > Play or click the Play button on the toolbar to set
Scheduler to the schedule play mode.

2. Select Schedule > Settings to open the Scheduler Settings dialog box (see
Figure C-4 on page C-8).

3. In the New Schedule tab, set parameters to be updated, playout packet size,
and playout bit rate. You can also set whether or not the streams in the
schedule list are continuously played with no discontinuities.

4. Click the Add Stream tab.

�������� ���� *���
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5. In the Add Stream tab, set playout properties used when a stream is added
in the schedule.

6. Click the Miscellaneous tab.

7. In the Miscellaneous tab, set the loop mode, the local lock out status, and
the port number. The port number needs to be the same port number as the
MTX100.

8. Click the OK button to confirm the changes and close the dialog box.

9. Select Stream > Add or click the Add button on the toolbar to open the
Open dialog box.

10. In the Open dialog box, select a file to be added to the schedule list and
click the Open button.

11. Repeat steps 9 and 10 until all the stream files you want to play are added to
the schedule list. You can add up to 256 files in a single schedule.

12. Select Schedule > Execute or click the Execute button on the toolbar to
open the status/control panel.

13. Click the Property button on the panel to open the Schedule Property

dialog box (see Figure C-9 on page C-17).

14. In the Schedule Property dialog box, set conditions to activate, start, and
stop the schedule.

15. If you want to set properties for an individual stream, use the following
methods to open the Play Properties dialog box (see Figure C-5 on 
page C-11):

� Highlight the stream name you want to set (by clicking on the name on
the schedule list), and then select Properties from the Stream menu.

� Double-click the stream name you want to set.

� Right-click the stream name you want to set, and select Properties from
the pop-up menu.

16. In the Play Properties dialog box, set the start/stop positions, start time, and
playout properties for the stream.

�������� ������� (	&	��

Schedule playout timing is determined by the Active Schedule setting in the
Schedule Property dialog box and the Start Time setting in the Play Properties
dialog box.
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� When you add a stream to a new schedule list with no Active Schedule
date/time set, the Start Time is set to the current date/time. The start times of
streams subsequently added to the schedule list are cumulative.

� If you set an Active Schedule date/time (for example, 2004/12/16 12:00:00)
in the Schedule Property dialog box, this is applied to all streams.

� If you set a Start Time (for example, 2004/12/15 15:00:00) in the Play
Properties dialog box for an individual stream, the start date/time of all
subsequent streams are changed. This does not affect the prior streams.

����. If there is an inconsistent time setting between the Schedule Property and

Play Properties dialog boxes or between two streams, an error message appears.
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17. Perform one of the two following methods to save the schedule list:

� Select Save from the File menu to either save a new schedule list or
resave an existing schedule list.

� Select Save As from the File menu to save a schedule list under a
different name.

����	�� �����&�

18. Click the Play button (�) on the status/control panel to start the schedule.

The schedule record mode allows you to create a schedule list for stream files to
be recorded and record an input stream continuously on the hard disk drive of the
MTX100. You can set record properties for each stream, and record up to 256
stream files.

Perform the following procedure to create a schedule list and record streams.

�����	�� � �������� 4	��

1. Select Schedule > Record or click the Record button on the toolbar to set
the schedule record mode.

2. Select Stream > Add or click the Add button on the toolbar to open the
Save as dialog box (see Figure C-6 on page C-14).

3. In the Save as dialog box, specify the appropriate drive, directory, and file
name for the stream file to be recorded. You can use the default file name
automatically displayed in the file name text box.

4. Click the Save button to open the Record Properties dialog box (see 
Figure C-7 on page C-15).

5. In the Record Properties dialog box, set the start time and stop time (or
recording time) for the stream.

6. Repeat steps 2 through 5 for all the files that you want to record.

7. Select Schedule > Execute or click the Execute button on the toolbar to
open the status/control panel.

8. Click the Property button on the panel to open the Schedule Property

dialog box (see Figure C-9 on page C-17).

9. In the Schedule Property dialog box, set conditions to activate, start, and
stop the schedule.

�������� 1����� *���
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Schedule record timing is determined by the Active Schedule setting in the
Schedule Property dialog box and the Start Time setting in the Record Properties
dialog box. The timing is set using the same method as described in Schedule
Playout Timing. Refer to Schedule Playout Timing on page C-20.

1�����	�� �����&�

10. Click the Record button (�) on the status/control panel to start the schedule.

����. You cannot change a property in the schedule while a schedule is running.

If you try to run a schedule with past time assigned, an error message appears.

If this happens, change the Start Time setting of the corresponding stream(s).

If you output streams having different bit rates continuously, to output each

stream in a specific bit rate, the instrument requires the times to accumulate a

certain amount of data in FIFO and output the last data from FIFO. Therefore,

the actual start and end times of streams are slightly different from the displayed

Start and End times in a schedule list.

Any discontinuity may be caused by streams that have different playout
properties.

If you output streams from the SMPTE 310 interface (Option 06), set the bit rate

to 19.392658 Mbps and set the packet size to 188 bytes.

In the schedule record mode, the Without Limit feature of the MTX100 is

automatically set to on.
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This section describes how to install the Scheduler application on your PC. The
application is included in the MTX100 & RTX100 Application Software Recovery

CD-ROM (Tektronix part number: 062-A279-XX).

Before installing the Scheduler application, check that your PC meets the
following minimum requirements:

� Windows 2000/XP operating system

� CD-ROM drive (for software installation)

The following instructions install the Scheduler application on your PC and
create a desktop shortcut icon on the PC to run Scheduler.

Perform the following procedure to install Scheduler:

1. Log on to Windows (2000 or XP) as Administrator.

2. Insert the MTX100 & RTX100 Application Software Recovery CD into a
CD-ROM drive on your PC.

3. Double-click the My Computer icon.

4. Double-click the CD-ROM drive icon.

5. Double-click the PC_Scheduler folder.

�������	 To prevent data loss, it is strongly recommended that you exit any

open applications on your PC before you run the Scheduler setup.exe file.

6. Double-click the setup.exe icon in the list. The Scheduler installation
program displays a series of setup windows as listed below. Click the Next>

button to accept the default parameters, or change the parameters in the setup
windows to suit your needs. Click the Back button in a setup window to
return to the previous setup window.

a. Welcome window. Read the displayed information, and then click the
Next button to proceed with the installation.

b. Choose Destination Location window. The default directory location for
the application is displayed. If you want to install Scheduler in a custom
location, click the Browse... button, and then select or create a custom
directory location.

�� �����& 1�>�	��&���

-��������	�� -�������	���
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c. Select Program Folder window. The default name for the program folder
is displayed. If you want to change the name, type in a new name, or
select a name from the Existing Folders list. Click the Next> button to
proceed.

d. Start Copying Files window. Review the displayed information, and then
click the Next> button to start the installation.

e. Setup Complete window. If the installation is successful, you will see a
message that setup has finished installing the Scheduler application onto
your PC. If you want to run Scheduler immediately, select Yes, Launch

the program file, and then click the Finish button. To exit the installa-
tion program without running Scheduler, click the Finish button.

7. Remove the MTX100 & RTX100 Application Software Recovery CD
from your PC and then store the CD in a safe location.

�����	�� � 0��"��� �������� -���: Perform the following procedure to create an
icon on your PC desktop that you can use to run the Scheduler application.

1. On your PC display, move the mouse cursor to any unoccupied desktop area,
and then click the right mouse button to open the desktop menu.

2. From the desktop menu, select New, and then select Shortcut to open the
Create Shortcut dialog box.

3. Click the Browse... button in the Create Shortcut dialog box.

4. Use the Browse dialog box to locate the Scheduler directory.

a. If you installed the Scheduler application using the default directory
location and the default folder name in the installation procedure, select
the following directory folders in order: Program Files, Tektronix, and
Scheduler.

b. If you installed the Scheduler application to a custom location or gave
the application folder a custom name, you will need to select your
custom directory path.

c. You should now be at a location in the PC directory structure where the
browse list box shows the Scheduler.exe file.

5. Select the Scheduler.exe file (Scheduler.exe will be displayed in the file
name box), and then click the Open button. The directory path to the
Scheduler.exe file will now be displayed in the Command Line box of the
Create Shortcut dialog box.

6. Click the Next> button in the Create Shortcut dialog box. The default name
of the shortcut icon is now displayed in the dialog box. You can edit the icon
name to suit your needs or accept the default name.
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7. Click the Finish button to finish creating the desktop shortcut icon. The
scheduler.exe shortcut icon will now appear on the PC desktop. You can start
the Scheduler application by double-clicking the Scheduler.exe (or your
custom name) shortcut icon.

�����	�� ��� $
	�	�� ��������� �� ?��� ��

When you complete the installation procedure, you can use any of the following
methods to start the Scheduler application:

����. To run the Scheduler application on your PC, the software protection key

must be installed on the PRINTER port of the MTX100.

� Double–click the Scheduler.exe shortcut icon on the PC desktop that you
created during the installation procedure.

� Select Scheduler from the Start � Programs menu.

When starting Scheduler, the MTX/RTX Host Name dialog box appears as
shown below. In this dialog box, you can select an MTX100 to be controlled by
Scheduler. After you select the MTX100, click the OK button.

����. Do not play or record streams for about one minute after you power on

the MTX100.

To exit (quit) the Scheduler application, select Exit from File menu command
list or click the close box on the title bar.
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For the MTX100 Option 02, the control signals for the hierarchical multiplexing

parameters are output from the UNIVERSAL IN/OUT connector when

outputting an ISDB-T transport stream.

This appendix describes the pin assignments of the UNIVERSAL IN/OUT

connector when the control signals are output and shows the timing relationship

of these signals.

Table D-1 lists the pin assignments of the UNIVERSAL IN/OUT connector.
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Figure D-1 shows the timing relationship of the signals on the UNIVERSAL

IN/OUT connector.
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This appendix provides instructions for connecting SCSI hard disk(s) to the

MTX100 and for setting up Windows 2000 to use the SCSI hard disk(s).

���������� ���������

Perform the following procedure to connect a SCSI hard disk(s) to the MTX100:

1. Power off the MTX100.

2. Connect the SCSI connector (see Figure 2-2 on page 2-4) on the MTX100

rear panel and the connector on the hard disk using a SCSI cable.

3. Install a SCSI terminator to an unused connector on the hard disk. When two

or more hard disks are connected in a daisy chain, the terminator must be

installed in the last hard disk. You do not need to do this for a hard disk with

an auto termination feature. Refer to the documentation provided with the

hard disk for more information.

4. Power on the hard disk(s), then power on the MTX100.

������� ���������

This subsection describes how to set up Windows 2000 to use the hard disk(s)

connected to the MTX100. The information is divided into the following two

subsections:

� For One Hard Disk

� For Two or More Hard Disks

Perform the following procedure to set up Windows 2000 when one hard disk is

connected to the MTX100. This procedure assumes the hard disk is not

formatted.

1. Connect the keyboard and mouse provided with the instrument to the USB

connectors on the front panel.

2. Close the Play screen (or Record screen) to display the Windows desktop.

3. Right-click the My Computer icon, then select Manage in the open menu.

The Computer Management window appears as shown in 

Figure E-1.


�� 
�� ���� ����
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4. Click Disk Management in the tree view to the left of the window.

����. To access Disk Management, you must be a member of the Administrators

group. If you cannot access Disk Management, you must be logged on as an

administrator or a member of the Administrator group.

This displays the volume list at the top right of the window and graphical

view at the bottom right of the window (see Figure E-2). The connected hard

disk is displayed at the bottom right of the window as Disk 1.
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����. If the disk was connected to the other system, the Disk 1 status is

“Foreign” not “Online”. In this case, you can online the disk by selecting the

Import Foreign Disks command from the Actions menu.

5. Click the Unallocated portion at the bottom right of the window, and then

select All Tasks � Create Partition from the Action menu. The Create

Partition Wizard dialog box appears as shown in Figure E-3.
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6. Click the Next button.

7. Follow the instructions provided during the creation of the partition. This

procedure assumes that you use default settings in all dialog boxes.

After all settings are completed, the dialog box showing completion of the

Create Partition Wizard appears as shown in Figure E-4.

������ � ��������� ��� ������� 
��������� �� ������ 	�������� 
�����
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8. Click the Finish button to close the Create Partition Wizard dialog box.

When you click the Finish button, it starts formatting Disk 1.

After the format is complete, the hard disk appears in the volume list. The

Computer Management window resembles Figure E-5.

������ ������������� 	��������� ���
�� ����� ��� ������ �� ��������

In Windows 2000, when two or more hard disks are connected to a computer,

you can assign the same volume to them. This configuration is referred to as

striped volume. If you create striped volumes, data writing process is distributed

among the disks. Writing speed for the stream record can be improved, when you

create striped volumes for the hard disks connected to the MTX100.

This subsection provides instructions for creating striped volumes for two hard

disks. The following procedure assumes that the hard disks are not formatted.

1. Connect the keyboard and mouse provided with the instrument to the USB

connectors on the front panel.

2. Close the Play screen (or Record screen) to display the Windows desktop.

3. Right-click the My Computer icon, and then select Manage in the open

menu. The Computer Management window appears (see Figure E-1 on

page E-2).

4. Click Disk Management in the tree view at the right of the window.

��� 
�� �� 	��� ���

�����
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����. To access Disk Management, you must be a member of the Administrators

group. If you cannot access Disk Management, you must be logged on as an

administrator or a member of the Administrator group.

This displays the volume list at the top right of the window and graphical

view at the bottom right of the window (see Figure E-6). The connected hard

disks are displayed at the bottom right of the window as Disk 1 and Disk 2.

�����
 �����������
� 	
�
�
�
�� ������ 
��
� �
�
����� ���� 	
�
�
�
��

����. If the disks were connected to the other system, Disk 1 and Disk 2 status

is “Foreign” not “Online”. In this case, you can online the disks by selecting the

Import Foreign Disks command from the Actions menu.

��
����� �� ���
��� ������  Disk 1 and Disk 2 are basic disks at this time. You

need to change these disks to dynamic disks for creating striped volumes. In

dynamic disks, you can create and delete volumes without restarting the system.

5. Click Disk 1, then select All Tasks � Upgrade to Dynamic Disk from the

Action menu. The Upgrade to Dynamic Disk dialog box appears as shown

in Figure E-7.
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6. Select Disk 2, and then click the OK button.

This changes Disk 1 and Disk 2 to Dynamic disk.

�������� � 
������ �������  Perform the following procedure to create a striped

volume for Disk 1 and Disk 2.

7. Click Disk 1, and then select All Tasks � Create Volume from the Action

menu. The Create Volume Wizard dialog box appears as shown in

Figure E-8.

	����� �"��������� ������ 
�!��� ������ ���

8. Click the Next button. The Select Volume Type dialog box appears as

shown in Figure E-9.
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9. Select Striped volume, and then click the Next button. The Select Disks

dialog box appears as shown in Figure E-10.

	����� ������
����� ����� ��
��� ���

10. Select Disk 2 in the All available dynamic disks field, and then click the

Add button. This adds Disk 2 in the Selected dynamic disks field.

11. Click the Next button. The Assign Drive Letter or Path dialog box appears

as shown in Figure E-11.
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12. In normal use, you do not need to change the settings in the dialog box.

Click the Next button. The Format Volume dialog box appears as shown in 

Figure E-12.


����� 	�����
����� 
����� ������ ���

In the dialog box, you can set the format type. This procedure uses the

default settings.
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13. Click the Next button. The dialog box showing completion of the Create

Volume Wizard appears as shown in Figure E-13.

	����� �!���������� 
�� ������� ���������� �� ��� ������ 
����� �� ���

14. Click the Finish button to close the Create Volume Wizard dialog box.

When you click the Finish button, it starts formatting Disk 1 and Disk 2.

After the format is complete, Disk 1 and Disk 2 change to dynamic disks and

can be used as striped volumes. The Computer Management window

resembles Figure E-14.
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The MTX100 displays the following messages when fragmentation occurs and

data output or data record rate is slower than the specified characteristics.

� FIFO is underflow. (when data is being output.)

� FIFO is overflow. (when data is being acquired.)

If this condition happens, you need to optimize the hard disk drive by perform-

ing the Disk Defragmenter of Windows 2000. This appendix provides instruc-

tions on how to defragment the hard disk drive.

���
�����

Perform the following procedure to defragment the hard disk drive:

1. Connect the keyboard and mouse provided with the instrument to the USB

port on the front panel.

2. Select Exit from File menu in the Play or Record screen to exit the MTX100

application. This appears on the Windows 2000 desktop.

3. Select Programs � Accessories � System Tools � Disk Defragmenter

from the Start menu. The Disk Defragmenter window appears as shown in

Figure F-1.
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4. Click Volume(E:).

5. Click the Defragment button to start the defragmentation. When the

defragmentation is completed, the Defragmentation Complete dialog box

appears as shown in Figure F-2.

��
��� ����������
��������� �������� 
����
 	��

6. Click the Close button.

7. Click the Close button at the upper right of the screen to close the Disk

Defragmenter window.
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In the event the MTX100 does not boot, you can reboot the MTX100 by using

the recovery discs provided with the instrument. Use the procedures in this

appendix to reinstall the Windows 2000 operating system and the MTX100

application software.

��	������	�� �	����� ����

Perform the following procedure to reinstall the Windows 2000 operating

system:

1. Insert the Windows 2000 Professional Operating System Recovery Disc

into the CD-ROM drive.

2. Turn off, then turn on the instrument. The MTX100 runs from the disc, and a

window for installing the operating system is displayed.

3. Follow the installing instructions on the screen.

4. When A:\> appears at the upper left corner of the screen, simultaneously

press the Control + Alt + Delete keys to restart the instrument, then

immediately press the eject button of the CD-ROM drive.

5. When the Your Product Key dialog box appears, enter the Product Key

numbers on the product key label located on the instrument cabinet.

6. After you enter the Product Key, the dialog boxes appear for setting

Windows 2000. Follow the installation instructions on the screen.

7. When the Administrator Password text box appears, enter MPEG2 for the

password.

When all settings for Windows 2000 are completed, the Windows desktop

appears.
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Perform the following procedure to reinstall the MTX100 application software:

1. Insert the MTX100 & RTX100 Application Software Recovery Disc into

the CD-ROM drive.

2. Double-click the D: drive icon (Substitute your CD-ROM drive letter if it is

different than D).

3. Double-click the Application_Software folder.

4. Double-click the setup.exe icon. This installs the MTX100 application

software.

Perform the following procedure to reinstall the parallel driver:

1. Double-click the Driver folder in the MTX100 & RTX100 Application

Software Recovery Disc.

2. Double-click the SSD5411-32bit.exe icon.

3. Click Next in the resulting window. The License Agreement window

appears.

4. Select I accept the terms in the license agreement, and then click Next.

The Destination Folder window appears.

5. Click Next. The Setup Type window appears.

6. Select Complete and click Next. The Ready to Install Program window

appears.

7. Click Install to proceed with installation.

8. When the InstallShield Wizard Completed window appears, click Finish

to complete the installation.

"������	�� ��� #�������
��	��� $%��	�� &' %���(
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Inspect and clean the instrument as often as your operating conditions require.

The collection of dirt can cause instrument overheating and operational failure.

Dirt acts as an insulating blanket, preventing efficient heat dissipation. Dirt also

provides an electrical conduction path that can cause an instrument failure,

especially under high-humidity conditions.

��
	���� Avoid the use of chemical cleaning agents that might damage the

plastics used in this instrument. Use only deionized water when cleaning the

front-panel controls. Use a 75% ethyl alcohol solution as a cleaner and rinse

with deionized water.

Avoid the use of high-pressure compressed air when cleaning dust from the

interior of this instrument. High-pressure air can cause Electro Static Discharge

(ESD). Instead, use low-pressure compressed air (about 9 psi).

�������� �����
����

Inspect the outside of the instrument for damage, wear, and missing parts. You

should thoroughly check instruments that appear to have been dropped or

otherwise abused to verify correct operation and performance. Have a qualified

service technician immediately repair defects that could cause personal injury or

lead to further damage to the instrument.

�������� ���	���


Perform the following steps when you clean the exterior of the instrument:

�������� To avoid injury or death, unplug the power cord from the line voltage

before cleaning the instrument. Avoid getting moisture inside the instrument

during external cleaning. Use only enough liquid to dampen the cleaning cloth.

1. Remove loose dust on the outside of the instrument with a lint-free cloth.

2. Remove remaining dirt with a lint-free cloth dampened with a general pur-

pose detergent-and-water solution. Do not use abrasive cleaners.

3. Clean the monitor screen with a lint-free cloth dampened with a gentle,

general purpose detergent-and-water solution.
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ACTS (Advanced Communications Technologies and Services)

A set of telecommunication research projects financed by the European

Union.

ARIB

Association of Radio Industries and Businesses.

ATSC

Advanced Television Systems Committee.

BAT (Bouquet Association Table)

One of the tables defined by DVB-SI. The BAT provides information

regarding bouquets (collections of services marketed as a single entity).

DVB only.

CAT (Conditional Access Table)

One of the PSI tables described by the MPEG-2 standard. The CAT provides

the association between one or more CA systems, their EMM (Entitlement

Management Message) streams, and any special parameters associated

with them.

CRC (Cyclic Redundancy Check)

One of the fields described in the MPEG-2 standard. CRC is used to verify

the correctness of data in PSI and SI tables.

Defragmentation

The process of rewriting parts of a file to contiguous sectors on a hard disk

to increase the speed of access and retrieval. When files are updated, the

computer tends to save these updates on the largest continuous space on the

hard disk, which is often on a different sector than the other parts of the file.

When files are thus “fragmented,” the computer must search the hard disk

each time the file is accessed to find all of the file’s parts, which slows down

response time.

DVB (Digital Video Broadcast)

A project group of the European Broadcasting Union (EBU).

DVB-MG

Digital Video Broadcasting - Measurement Guidelines.

DVB-SI (Digital Video Broadcast Service Information)

The DVB-SI adds the information that enables DVB IRDs to automatically

tune to particular services and allows services to be grouped into categories

with relevant schedule information. It has several tables, including: NIT,

SDT, BAT, and EIT. (NIT is also required for MPEG-2.)
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DTS (Decoding Time-Stamp)

One of the fields described in the MPEG-2 standard. The DTS may be

present in a PES packet header that indicates the time that an access unit is

decoded in the T-STD.

ECM (Entitlement Control Message)

Private conditional access information that specifies control words and

possibly other, typically stream-specific, scrambling and/or control

parameters.

EISA (Extended Industry Standard Architecture)

The PC bus used to communicate with the CARB and PIA boards.

EIT (Event Information Table)

One of the tables defined by DVB-SI. The EIT contains data concerning

events (a grouping of elementary broadcast data streams with a defined start

and end time belonging to a common service) and programs (a concatenation

of one or more events under the control of a broadcaster, such as event name,

start time, and duration).

EMM (Entitlement Management Message)

Private conditional access information that identifies the authorization levels

or the services of specific decoders.

ETS (European Telecommunication Standard)

One of the types of documents released by ETSI.

ETSI

European Telecommunications Standards Institute.

ETR (ETSI Technical Report)

One of the types of documents released by ETSI.

IRD (Integrated Receiver / Decoder)

A receiving decoder that can automatically configure itself using the

MPEG-2 Program Specific Information (PSI).

ISO (International Standard Organization)

Organization responsible for establishing standards at the world-wide level.

MPEG-2

A standard developed by MPEG (Moving Picture Experts Group) for the

compression of digital video.
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NIT (Network Information Table)

One of the PSI tables described by the MPEG-2 standard and also one of the

tables defined by DVB-SI. The NIT conveys information relating to the

physical organization of the multiplex; that is, transport streams carried via a

given network and the characteristics of the network itself. Transport streams

are identified by the combination of an original network ID and a transport

stream ID in the NIT.

PAT (Program Association Table)

One of the PSI tables described in the MPEG-2 standard. The PAT provides

information about the structure of a transport stream.

PCR (Program Clock Reference)

One of the fields defined in the MPEG-2 standard. A time stamp in the

transport stream from which decoder timing is derived.

PES (Packetized Elementary Stream)

A structure defined in the MPEG-2 standard used to carry elementary

stream data.

PID (Packet IDentifier)

One of the fields described in the MPEG-2 standard. A unique integer value

used to identify elementary streams of a program in a single or multipro-

gram TS.

PMT (Program Map Table)

One of the PSI tables described by the MPEG-2 standard. The PMT

identifies and indicates the locations of the streams that make up each

service and the location of the Program Clock Reference (PCR) fields for a

service. This table is transmitted in sections.

PSI (Program Specific Information)

A set of tables described by the MPEG-2 standard. The PSI contains all of

the tables that define the MPEG-2 transport stream. It consists of the PAT,

PMT, CAT, and NIT tables. (NIT is also used for DVB-SI.)

PSIP

Program and System Information Protocol.

PTS (Presentation Time Stamp)

One of the fields described in the MPEG-2 standard. The PTS may be

present in a PES packet header that indicates the time that a presentation unit

is presented in the T-STD.

RST (Running Status Table)

One of the tables defined by DVB-SI. The RST gives a quick updating

mechanism for the status information carried in the EIT.
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SDT (Service Description Table)

One of the tables defined by DVB-SI. The SDT contains data describing the

services in the system. Examples include: names of services and the

service provider.

SI (Service Information)

Set of tables defined by DVB-SI. The SI provides information on services

and events carried by different Multiplexes, and even other networks. SI is

structured as six tables (PAT, NIT, CAT, SDT, EIT, and BAT). The applica-

tions are only concerned with NIT, BAT, SDT, and EIT.

ST (Stuffing Table)

One of the tables defined by DVB-SI. The ST provides stuffing sections.

TDT (Time & Date Table) 

One of the tables defined by DVB-SI. The TDT carries the current time and

date information.

TOT (Time Offset Table)

One of the tables defined by DVB-SI. The TOT gives information about a

local time offset in a given area.

TS (Transport Stream)

A bit stream that contains 0 or more elementary streams combined in a

manner that conforms to the MPEG-2 standard.

T-STD (Transport Stream System Target Decoder)

Described by the MPEG-2 standard, the T-STD is a hypothetical reference

model of a decoding process used to define the semantics of a TS.
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10 Key Pad, 2-15

100/10 BASE-T connector, 2-5

�

Abbreviations, commands, queries, and parameters, 3-75

AC line voltage requirements, 1-5

Accessories, 1-2

Add TMCC dialog box (ReMux), B-16

Adding jitter to PCRs (MTG300 only), 3-49

Address, Tektronix, xvi

ADFERR icon, 3-47

Arguments, parameters, 3-74

Arrow buttons, 2-4

ASI I/F menu (Option 01 only), 3-18, 3-28

ASI interface option, 2-11

ASI/1394 menu (Option 05 only), 3-19, 3-29

ASI/310M menu (Option 06 only), 3-21, 3-32

ASI/IEEE1394 conversion, 3-123

AUDIO icon, 3-46

AUDIO_AAC icon, 3-46

AUDIO_AC3 icon, 3-46

�

Backus-Naur Form, 3-77

Basic menu operation, 2-14

BAT icon, 3-47

BIT icon, 3-47

Bit rate indicator, 2-9

BNF (Backus-Naur form), 3-77

�

Card slot, 2-5

Case sensitivity, 3-76

CAT icon, 3-44

CD-ROM drive, 2-2

Certifications and compliances, A-14

CETT icon, 3-48

Cleaning the instrument exterior, H-1

CLK/REF IN connector, 2-5

Clock dialog box, 3-7

Clock source indicator, 2-9

COM 2 connector, 2-4

Commands

chaining, 3-75

rules for forming, 3-73

structure of IEEE 488.2 commands, 3-77

syntax, 3-73

Common commands, 3-80

Communication dialog box, 3-22

Contacting Tektronix, xvi

Contents of the preset file, 3-59

Continuous recording, 3-53

Creating commands, 3-73

Crossover Ethernet cable, 3-63

CVCT icon, 3-48

�

DATA icon, 3-46

Data probing, 3-122

DATA_SECT icon, 3-46

DCT icon, 3-47

Defragment the hard disk drive, F-1

DEMUX dialog box (ReMux), B-21

Dialog boxes

Add TMCC (ReMux), B-16

Clock, 3-7

Communication, 3-22

DEMUX (ReMux), B-21

Edit TMCC Information (ReMux), B-12, B-15

Edit TS Information (ReMux), B-10

Open, 3-61

OPTION (ReMux), B-7

Others, 3-14, 3-27

PCR Inaccuracy, 3-45, 3-49

PCR Initial Value, 3-10

Save AS, 3-60

Select File, 1-9, 2-20, 3-4

Select Remux Mode (ReMux), B-5

Set Non–TS Sync, 3-9

Start/Stop Position, 3-12

Status, 3-23

Target, 3-25

Timer Play/Record, 3-11

Display, 2-1

DISPLAY commands, 3-82

Display elements, 2-5, 2-6

DIT icon, 3-47

DLT icon, 3-47

DSM_CC icon, 3-46

www.valuetronics.com



Index

�
����� MTX100 MPEG Recorder & Player User Manual

�

EC declaration of conformity, A-14

ECM icon, 3-47

Edit menu (ReMux), B-6

Edit TMCC Information dialog box (ReMux), B-12,

B-15

Edit TS Information dialog box (ReMux), B-10

EETT icon, 3-48

EIT icon, 3-47, 3-48

Electrical specifications, A-2

EMM icon, 3-47

ENTER button, 2-3

Environmental characteristics, A-13

Environmental operating requirements, 1-5

Error codes, 3-111

Commands, 3-111

Device specific, 3-114

Execution, 3-112

Hardware, 3-114

Query, 3-115

ESC button, 2-3

Exiting the ReMux application, B-1

Exiting the Scheduler application, C-2

Exterior cleaning, H-1

Exterior inspection, H-1

�

File menu (Play screen), 3-3

File menu (Record screen), 3-24

File menu (ReMux), B-5

File menu (Scheduler), C-6

Front panel controls, 2-1

Functional check procedure, 1-8

Functional specifications, A-1

�

GARBAGE icon, 3-47

GHOST icon, 3-47

Glossary, Glossary–1

�

HDD access indicator, 2-4

Help menu (ReMux), B-8

Help menu (Scheduler), C-16

Hierarchy display, 2-7, 3-35

Hierarchy display icons, 3-36, 3-38, 3-39, 3-40, 3-42

Hierarchy Tree, 3-73

�

Icon cursor, 2-7, 3-36

Icons, hierarchic view, 3-36

IEEE 488.2 Common Commands, 3-77

IEEE Std 488.2-1987, 3-77

IEEE1394 interface

ASI/IEEE1394 conversion, 3-123

Data probing, 3-122

Point–to–point connection, 3-120

IEEE1394/ASI interface option, 2-12

Initial product inspection, 1-4

Inspection and cleaning, H-1

Installation, 1-5

ITT icon, 3-47

�

LCD display, 2-1

LDT icon, 3-47

LIT icon, 3-47

Loading a preset file, 3-60

	

MASS MEMORY commands, 3-82

Mechanical characteristics, A-13

Menu bar, 2-6

MENU button, 2-2

Menus

ASI I/F menu (Option 01 only), 3-18, 3-28

ASI/1394 menu (Option 05 only), 3-19, 3-29

ASI/310M menu (Option 06 only), 3-21, 3-32

File (Play screen), 3-3

File (Record screen), 3-24

Play, 3-5

Record, 3-24

Univ I/F menu (Option 02 only), 3-19, 3-29

Utility, 3-21, 3-32

MGT icon, 3-48

M-TMCC icon, 3-43




NBIT icon, 3-47

NIT icon, 3-44

Non TS icon, 3-43

NULL icon, 3-47

Numeric input, 2-15

Numeric input using the 10 Key Pad, 2-15

Numeric input using the arrow buttons, 2-16
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ON/STBY power switch, 2-1

Open dialog box, 3-61

OPTION dialog box (ReMux), B-7

Optional accessory, 1-2

Optional commands, 3-101

Options

Option 01 (Add ASI Interface), 1-3

Option 02 (Add Universal Parallel/Serial Interface),

1-3

Option 05 (Add IEEE1394/ASI Interface), 1-3

Option 06 (Add SMPTE310M/ASI Interface), 1-3

Option D1 (Calibration Test Data Report), 1-3

Option SC (Scheduler Software), 1-3

power cords, 1-3

Others dialog box, 3-14, 3-27

Outputting a transport stream tutorial, 2-20

�

Packet size indicator, 2-9

Parameter Types Used in Syntax Descriptions, 3-74

Partial transport stream, 3-126

PAT icon, 3-44

PCAT icon, 3-47

PCR icon, 3-44

PCR Inaccuracy dialog box, 3-45, 3-49

PCR Initial Value dialog box, 3-10

Performance conditions, A-1

Phone number, Tektronix, xvi

PIT icon, 3-48

PLAY commands, 3-84

Play menu, 3-5

Play status indicator, 2-7

PMT icon, 3-44

Point–to–point connection, 3-120

Power connector, 2-4

Power cord requirements, 1-6

Power on procedure, 1-6

Preset file, 3-59

PRINTER connector, 2-5

Product description, 1-1

Product support, contact information, xvi

�

Queries, 3-74

Quotes, 3-76

�

Rear panel, 2-4

REC button, 2-3

RECORD commands, 3-94

Record menu, 3-24

Record status indicator, 2-7

recording a transport stream tutorial, 2-22

Recovery disc, G-1

Reinstalling the MTX100 application, G-2

Reinstalling Windows 2000, G-1

Related manual, xvi

Remote connection status icons, 2-10

ReMux application, B-1

ReMux menu (ReMux), B-6, B-7

ReMux tutorials, B-8

Repackaging for shipment, 1-8

RRT icon, 3-48

RST icon, 3-47

Rules

command forming, 3-73

for using SCPI commands, 3-76

�

Safety compliances, A-15

Save As dialog box, 3-60

Saving a preset file, 3-59

Schedule menu (Scheduler), C-7

Scheduler application, C-1

Scheduler menus, C-6

Scheduler tutorials, C-19

SCPI

abbreviating, 3-75

chaining commands, 3-75

commands, 3-73

general rules, 3-76

parameter types, 3-74

subsystem hierarchy tree, 3-73

SCPI commands and queries syntax, 3-73–3-77

creating commands, 3-73

creating queries, 3-74

Scroll bar, 2-9

SCSI connector, 2-5

SDT icon, 3-47

SDTT icon, 3-47

SELECT button, 2-3

Select File dialog box, 1-9, 2-20, 3-4

Select Remux Mode dialog box (ReMux), B-5
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Service support, contact information, xvi

Set Non–TS Sync dialog box, 3-9

Setting Ethernet parameters, 3-64

Setting values with the arrow buttons, 2-16

SIT icon, 3-47

SMPTE310M/ASI interface option, 2-13

Software protection key, C-1

SPI IN/OUT connector, 2-5

ST icon, 3-47

Standard accessories, 1-2

Standard indicator, 2-9

Start/Stop Position dialog box, 3-12

Starting the ReMux application, B-1

Starting the Scheduler application, C-2

Status bar, 2-9

Status dialog box, 3-23

S-TMCC icon, 3-43

STOP button, 2-3

Stream menu (Scheduler), C-10

STT icon, 3-48

Syntax, command, 3-73

SYSTEM commands, 3-98

�

TAB button, 2-3

Target dialog box, 3-25

TDT icon, 3-48

Technical support, contact information, xvi

Timer Play/Record dialog box, 3-11

Toolbar, 2-7

Toolbar buttons, 3-32

TOT icon, 3-48

Transport stream icon, 3-43

TRIG IN connector, 2-5

TSDT icon, 3-44

Tutorials

MPEG generator, 2-19

outputting a transport stream, 2-20

recording a transport stream, 2-22

ReMux, B-8

TVCT icon, 3-48

�

Univ I/F menu (Option 02 only), 3-19, 3-29

Universal parallel/serial interface option, 2-11

URL, Tektronix, xvi

USB connector, 2-2

Using the recovery discs, G-1

Utility menu, 3-21, 3-32

�

VGA connector, 2-5

VIDEO icon, 3-46

View menu (ReMux), B-8

View menu (Scheduler), C-6

�

Web site address, Tektronix, xvi

www.valuetronics.com



www.valuetronics.com



www.valuetronics.com


	Title Page
	End User License Agreement for Windows 2000
	WARRANTY
	Table of Contents
	List of Figures
	List of Tables

	Setting Up Windows 2000 Professional
	General Safety Summary
	Preface
	Contacting Tektronix

	Getting Started
	Operating Basics
	Tutorials
	Reference
	Using the Menus
	Hierarchy Display
	Adding Jitter to PCRs
	Continuous Recording Feature
	Preset File
	Connecting to a Network
	Outputting an ISDB-T Transport Stream
	Syntax
	Remote Commands
	Default Settings
	Error Messages and Codes
	Network Interface Specifications
	Using the IEEE1394 Interface (Option 05 Only)
	Appendix A: Specifications
	Appendix B: Using the ReMux Application
	Appendix C: Using the Scheduler Application (Option SC Only)
	Appendix D: Control Signals for Option 02
	Appendix E: Connecting SCSI Hard Disk(s)
	Appendix F: Defragment the Hard Disk Drive
	Appendix G: Using the Recovery Discs
	Appendix H: Inspection and Cleaning
	Glossary
	Index

